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DITCH DASHBOARD
If you unlock Dashboard’s Developer
mode, you can run a widget in the Finder.
From “Create a Dashboard Widget,” p56.

I WANT MY HDTV
How can you watch your HD video if you
can’t yet make an HD DVD? Record HD
movies back to your camera’s tape, attach
the camera to your HD telly, and roll.
From Reviews, p32.

FREEBIE@MAC.COM
If you sign
up for a free
.Mac trial, the
you@mac
.com iChat
handle is
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trial ends.
From “Take Charge of iChat,” p54.
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Widget addiction is afﬂicting Tiger
adopters everywhere, and we’ve
got the cure: 23 nifty little widgets
to crowd your Dashboard bar. You’ll
also ﬁnd four fun games, a gang of
great graphics apps, and a whole lot
more on this month’s Disc.
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Photo to Movie
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Drive Genius
demo
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warfare after World War
III is bloody, tense, and
a whole lot of nailbiting fun.

Sure, iPhoto’s got great
slideshows and iMovie’s
got Ken Burns on
staff—but this app can
do much, much more.

Repair, defragmentation,
duplication, and more—
this burly drive utility
will keep your Mac’s
drives running right.
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Staff Video:

We Fought the
Law, and. . .
We spared no expense to bring you the
gripping tale of Reviews Editor Roman
Loyola’s failed attempt to videotape
San Francisco’s Tiger-release party.

If you don’t receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly
Disc contains cool demos, useful shareware and freeware, and the inimitable MacAddict Staff Video. To get 12
issues of MacAddict that include this value-packed disc with your subscription (prorated if necessary) for just $1
more per issue, call 888-771-6222—the operator will take care of everything.
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EDITORS’ PAGE

A History of Ingenuity
Innovation has been the name of Apple’s game
for nearly 30 years. And although Apple’s
hardware has consistently led the personalcomputing world in quality and style, it’s the
Mac’s operating systems that have brought
the most important advances to the world of
personal computing (see “Taming Tiger,” p12).
That said, while many of the OS breakthroughs
have been of “How did we live without these?”
caliber, some have been deservedly consigned
to the dustbin of history.
Such as…
HOW DID WE LIVE WITHOUT THESE?
• Hierarchical File System (1986) Before HFS was introduced in System
3.0, you couldn’t nest folders inside of other folders. Try to picture
navigating through your ﬁles if that were the case today.
• Progress Bar (1987) Originally, when you copied a ﬁle, folder, or disk,
you simply had to guess how long that process would take. Then the
Progress Bar appeared in System 4.2 to assure you that, yes, it really was
taking that long.
• Multitasking (1987) Today we all keep multiple applications
running simultaneously, thanks to Mac OS X’s ﬁnely tuned preemptive
multitasking. System 4.2’s MultiFinder introduced the less-capable, but
still mighty welcome, cooperative multitasking, and we all became far
more productive.
DUSTBIN OF HISTORY
• A/UX (1988) Mac OS X wasn’t the ﬁrst Unix-based Mac operating
system—that honor goes to A/UX, which petered out in 1995, having
never made much of a splash in the ﬁrst place.
• Interapplication Communication (1993) If you never could get this
method of sharing information among different applications working
consistently and correctly, you weren’t alone.
• OpenDoc (1996) Even though Apple, IBM, Novell, Borland, and Lotus
all supported this “document-centric” technology, it lived a short and
tortured life because application developers needed to completely rethink
the way they wrote and distributed apps—and ﬁgure out a way to make
money while doing so.
The list, of course, goes on. And on. And only time will tell which of
Tiger’s innovations will become indispensable and which will become
mere footnotes in the history of the world’s greatest personal computer.
Enjoy,

comingsoon:august2005

STAFF RANTS
Q. What innovation most changed the way you work with your Mac?
Niko Coucouvanis CAPTAIN JERK
What innovation most changed the way you
work with your Mac?

It was the modem. At ﬁrst I avoided them as toys
for Star Trek geeks and calculator programmers,
but when they hit 14.4 Kbps I ﬁnally got one—and I
haven’t gotten much work done since.

Sean Molloy CLUTTER-MANAGEMENT SPECIALIST
What innovation most changed the way you
work with your Mac?

Thanks to the desktop-clearing capabilities of
Exposé, days will pass before I realize that I’ve got 147
applications open. Now if only they made something
like that for my real desk.

Jake Widman DISKTOP JOCKEY
What innovation most changed the way you
work with your Mac?

That whole folders-and-desktop thing. Remember
before that, when your workspace was called The
Floor, and you’d just throw things anywhere, and every
so often the Media Operating Module (MOM) would come along
to put things away and you wouldn’t know where they were? That
was such a drag.

Roman Loyola FALSE STARTER
What innovation most changed the way you
work with your Mac?

The ﬁrst-generation Power Macs made a terrifying car
crash sound instead of the startup chime if something
was amiss at boot. To this day, when I turn on my
Mac, I’m a bit anxious until I hear that pleasing, familiar startup
chime—only then can I relax.

Peter Marshutz SITTING BY THE DOCK OF THE BAY
What innovation most changed the way you
work with your Mac?

I love the Dock, it really makes navigating around my
Mac easy: switching applications; bouncing between
documents, Web pages, anything—it’s great.

Mark Rosenthal SLO POKE
What innovation most changed the way you
work with your Mac?

Before cooperative multitasking, I couldn’t see the big
deal about having multiple applications running at the
same time. Looking back, I bet I spent two hours of my workday
just opening and closing apps!

Max BACKING UP INTO THE FUTURE
What innovation most changed the way you
work with your Mac?

When System 1.1 was released on May 5, 1984, it
improved the interminable ﬂoppy-copy speed—or
lack thereof—that plagued the original System 1.0.
The ﬁx would have been released sooner, but rumor had it that
Apple’s system-software programmers wasted multiple manyears backing up their work on 400KB ﬂoppies in System 1.0.

Here’s what our editors are preparing for the next issue of MacAddict.

Got bugs? Who doesn’t? In our ﬁfth-annual bug hunt, we’ll identify some of the most threatening species and show you how
to exterminate them from your Mac. Remember that blogging story we promised for this month? Tiger devoured it—but it’ll
be back next month, along with a Field Guide explaining little-known startup codes and key combinations. We’ll also take
the mystery out of iPhoto slideshows, create a backup system with AppleScript and a FireWire hard drive, build a homebrew
Steadicam rig to stabilize shaky video footage, and delve into the powers of Automator. We’ll also have reviews of Adobe’s
InDesign CS2 and Photoshop CS2, Wacom’s Cintiq 21UX, Apple’s new dual 2.7GHz Power Mac, and more.
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tep into one of Apple’s
gleaming stores, and you may
think you’ve died and gone to
heaven—one populated with
seemingly inﬁnite iPods, multitudinous
Mac minis, in-store workshops, and
a crack team of Mac Geniuses that
dispense free advice.
Apple’s retail strategy appears to
be paying off—literally. In a recent
quarterly report, Apple claimed that
its retail stores raked in a $45 million
proﬁt during the ﬁrst quarter of 2005,
up from just $9 million a year ago. But
not everyone is celebrating. Many Apple
resellers are screaming that Apple just
isn’t playing fair.
In the knock-down-drag-out battle
between Apple and independent
resellers, do mom-and-pop shops stand
a ﬁghting chance? And where do you, as
a Mac user, stand to get the best deals
and service?
New Apple gear. Not surprisingly,
Apple retail stores are your best bet
for scoring the latest and greatest
Apple products. Apple stocks its own
stores ﬁrst before sending shipments
(often in short supply) to its resellers.
Apple Stores also play hardball when it
comes to price; ﬁnd any Apple-branded
hardware or software at a reseller for a
lower price, and Apple will match that
price (though only up to 10 percent
below the current Apple Store price).
A few individual resellers claim that
these practices are anticompetitive;
some resellers are taking Apple to court
to level the playing ﬁeld. Former Apple
reseller Tom Santos is among them.
Santos, the owner of the recently shutdown MacAdam store in San Francisco,
ﬁled a lawsuit accusing Apple of a
laundry list of anticompetitive tactics,
06

July 2005

PHOTOGRAPH BY SCOTT OLSON/ GETTY IMAGES

Apple’s chain of
stores continues to
grow, but there are
still reasons to visit
an independent
Mac store.

MOM’n’ POP
AND APPLE
including poor or no allocation of
products, pawning off used computers
as new ones, consistent improper
billing and overbilling for repairs, and
undercutting its resellers in price wars.
“When Apple opened its stores, it
said, ‘We’re going to support you,’” says
Santos. “What a bunch of crap—a bunch
of lies designed to keep us around until
they don’t need us anymore.”
Other resellers agree. Elite Computers
& Software founder Thomas Armes,
who recently had to close all ﬁve of his
stores (which brought in $20 million in
sales in 2002), also has a suit against
Apple citing unfair business practices.
And in mid-February 2005, three
California consumers and two former
Apple resellers joined forces to ﬁle a

class-action suit against Apple. The suit
echoes many of Santos’s and Armes’s
complaints; it also accuses Apple of
directly marketing to the resellers’
private customer lists.
Non-Apple stuff. Apple may hoard its
newest products for its own stores, but
resellers often have a greater supply and

JOIN THE iSCENE
Recently, the New York Post and City Magazine
ran stories about the hipsters and singles scene
at the SoHo Apple Store in New York City. Wired
News (www.wired.com) wrote about Hollywood
celebrities who visit Apple Stores. The vibe’s
different at your locally owned Mac store—it’s
PHOTOGRAPH COURTESY OF APPLE
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NEW STUFF

big deals. They’re just
branding stores with
the basic $8-an-hour
employee.”
Service and help.
If you need a quickie
memory upgrade, don’t
know how to reset your
iPod, or can’t ﬁgure out why your Mac
won’t work, then sidle on up to the
Genius Bar at the Apple Store for a free
face-to-face consultation. Depending
on the store, you may be in for a wait.
The line at the ﬂagship San Francisco
Apple Store is often several hours long.
The impatient can make a same-day
appointment to avoid lines, while the
really impatient can buy into Apple’s $99

Lines like this one
at the Chicago
Apple Store are
common with
big store events,
such as the Tiger
release.

4 PRINTER PAL

Epson PictureMate
Deluxe Viewer Edition

To print on this
portable photo
Keep your photo
printer, just insert lab close at hand.
your camera’s
memory card. You can preview your
images on the 2.4-inch LCD and adjust
brightness, saturation, sharpness,
cropping, and more. A battery is
available for $69.99.

IMAGE COURTESY OF EPSON

$249
www.epson.com
Available: June

4 USE USENET PICS
PHOTOGRAPH BY MICHELLE VICTORIA

Brainchild Picture Patrol 1.5

usually more community oriented, down to
earth, and laid back. Chances are you’ll ﬁnd
members of your local Mac-users’ group
patronizing the store.—Michelle Victoria

Hey, Mac, come
here often?

This app can search through Usenet
newsgroups for downloadable
pictures. You can read newsgroup
articles, decode the attached pictures,
and save the images to your hard disk.

One of San Francisco’s last independent
Mac stores, MacAdam, closed its doors
earlier this year.

ProCare plan, which lets you reserve a
Genius up to seven days in advance.
If you have a serious problem, though,
you’re better off heading directly to your
local Apple reseller instead of an Apple
Store. Why? Most Apple Stores aren’t
full-service centers, which means they
can only make the most minimal repairs
on-site; everything else is sent out for
repair, which could take days, if not
weeks. At the L.A. Computer Company,
technicians do all the work on-site and
can often make repairs while you wait.
Lou Dunham, one of the owners of
Bethesda-based MacUpgrades, says
he has a great relationship with the
Apple mini store that opened up a block
away from his own store last December.
“We’ve referred customers to them for
products that we can’t get, and they refer
customers to us for products that they
no longer service or for on-site service,
which they don’t provide,” says Dunham.
“We’ve exchanged a lot of business with
the Apple Store, and I’m really happy
with them.”—Nikki Echler McDonald

Stop
the JPEG
gibberish.

4 COMFORTABLE GLISSANDO
Edirol PC-80

$495
www.edirol.com
Available: Now

This USB MIDI controller has feltcushioned and spring-loaded keys;
24-bit, 96kHz audio capability; lowlatency driver support for Core Audio,
WDM, ASIO 2.0 and OS standard
drivers; and stereo powered speakers
(2 watts each).
61 ebonies and ivories to tickle.
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variety of third-party products such as
digital cameras, scanners, and printers,
as well as older Mac products you won’t
ﬁnd in an Apple Store. Need a wireless
card for your old G3? An ergonomic
keyboard and mouse? A ﬁve-megapixel
digital camera? There’s a good chance
that you’ll have more luck ﬁnding it at an
independent reseller.
If you’re making a big purchase, an
independent Apple reseller is more likely
to cut you a deal in hopes of getting
you hooked on service. “We make
deals easier,” says Yunus Motiwalla,
operations manager of the Anaheim,
CA–based L.A. Computer Company.
“The Apple Store isn’t geared to help
dedicated buyers looking to make

$19
www.brainchild.nl
Available: Now
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DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On

Pa Rum PumPum PumB
IMAGE COURTESY OF M-AUDIO

The 16 velocity-sensitive pads on MAudio’s Trigger Finger ($249, www
.m-audio.com) are designed for playing
drum sounds, but you can generate any
MIDI triggers you wish. The eight knobs
and four faders can be assigned to MIDI
parameters such as volume, pan, pitch,
and effects. Trigger Finger also has
preprogrammed maps for Reason, Live,
GM Drum, XG Drum, and iDrum.

ATo Serve

and Protect

IMAGE COURTESY OF USTEC

If you’re planning on using your Mac
mini as a server, it should feel nice and
comfy inside UStec’s iLAN (price to be
determined, www.ustecnet.com), a
cabinet that includes cables, ports, and
a 10/100Base-T Ethernet switch and
router. You can customize the cabinet
to include a security-camera system,
satellite-TV multiswitch, and broadband
ampliﬁer to boost your cable-TV quality.
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NOW IT’S
PERSONAL

B

lizzard recently
gave players of
its popular massively
multiplayer online roleplaying game (MMORPG)
World of Warcraft a reason
to engage in player-versus-player
(PvP) combat with Honor Points and
Rewards—next, they plan on taking PvP to the next level
with Battlegrounds, a sort of up-close-and-personal version
of Warcraft III that pits Horde against Alliance in special
areas of the world. The goal: Slay the enemy’s general and
destroy its headquarters. There are several ways to achieve
victory: You can lay siege to guard towers, graveyards, and

Same old World of
Warcraft. Hot new
player-versus-player
action.

minor villages to control
more of the map; you
can also capture mines
to gather resources for your
fellow players. After killing an
enemy player, you can loot the corpse for a
token and give it to your team’s
master magic user. When you’ve
World of Warcraft
handed over enough tribute,
Price $49.99 (plus monthly fee)
Available Now
the spellcaster will summon a
Blizzard Entertainment
huge epic ﬁgure to smash your
www.blizzard.com
opponents.—Matt Osborn

ON THE

CSI: Dark Motives
Price TBD

DISC

Available July
Aspyr Media
www.aspyr.com

Tribal Trouble

Alrighty then,
Dr. Autopsy—
dig in.

Tribal Trouble
Price $24.95
Available Now
Oddlabs
www.oddlabs.com/
tribaltrouble.php

NO REST FOR THE NATIVES

4 In Oddlabs’ new real-time strategy game, Tribal Trouble,
hapless Vikings stumble upon a tropical island and plan to
conquer the noble natives who call it home. And what a home
it is! Randomly generated terrain
means no more repeating the same
old boring maps over and over again
ZAP! Play as
as you traverse the 3D-RTS terrain.
chieftai
the native chieftain,
Gather resources, build buildings,
and you can fry foes
train warriors, and create a powerful
with lightning.
chieftain to eliminate your foes.—MO
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INVESTIGATE THE GORE
Aspyr is putting you back in the shoes of characters
from CSI: Crime Scene Investigation for more zany
forensic fun. CSI: Dark Motives is a ﬁrst-person adventure
that tests your nerves and skills as you examine crime
scenes, question witnesses, and analyze evidence with
high-tech equipment. Expect the same voices and graphic
situations as in the television show, but be forewarned: It
might be a crime to eat dinner while you play.—MO

TIPS & TRICKS: STAR WARS BATTLEFRONT
These tips will keep you from being a nerf herder in Star Wars
Battlefront.—MO
OWN SOLO Play the single-player game to get acquainted
with all of the maps and classes in each faction. Find a class
that ﬁts your playing style—but be ﬂexible. If your team has
too many troopers, be a pilot instead. Pilots can dish out
health and ammo; they can also repair vehicles and turrets.
STAY ON TARGET Starﬁghters are hard to control, so ﬂy
slowly. Jedi Starﬁghters, X-Wings, and TIE Bombers have
rockets with lock-on capabilities that help targeting.

ABUSE THE FORCE It’s easiest to kill a Jedi hero while on the
planet Tatooine. Just hop on a speeder bike and push the Jedi
into the Sarlacc’s maw. (Duh.)
FIGHT THE SMALL FIGHT On
the Profile Select screen,
create a new profile named Jub
Jub. When you enter a game,
Aren’t you a
everyone will be Ewok-sized.
little short for a
Now you can take out all your
Stormtrooper?
Return of the Jedi frustrations.
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the news of the month in bite-size chunks

the news of the month in bite-size chunks

W

hat comes with every copy of Apple’s newest version of Mac OS X, Tiger?
Questions! You’ll want a good Tiger book on hand when you’re digging into OS
10.4’s many new features. Here are a few references to check out.—Michelle Victoria

THE MAC OS X TIGER BOOK
by Andy Ihnatko
(Wiley, $24.99)
www.wiley.com
If it’s written by Andy, it’s
a fun read packed with
useful information.
MAC OS X BIBLE,
TIGER EDITION
by Samuel Litt et al.
(Wiley, $29.99)
www.wiley.com
A longtime favorite
among Mac devotees.

MAC OS X TIGER
POCKET GUIDE
by Chuck Toporek
(O’Reilly, $9.95)
www.oreilly.com
O’Reilly’s pocket guides are
compact, succinct, and invaluable.
MASTERING MAC OS X
V10.4 TIGER
by Todd Stauffer
and Kirk McElhearn
(Sybex, $39.99)
www.sybex.com
Looking for extensive troubleshooting
and maintenance help? Here ’tis.
TEACH YOURSELF
VISUALLY MAC OS X TIGER
by Erick Tejkowski
(Wiley, $24.99)
www.wiley.com
When words are
overwhelming, turn to this visual guide.

Bug of the Month

>>>>>>>>>>>>>>>>>>>>>>>>>>>>
R A M - S L O T FA I L U R E S

A

well-traveled PowerBook or iBook takes a lot of abuse—enough that your RAM
modules may one day work themselves loose. This odd phenomenon can even
affect deskbound Macs. You may not even know you’ve lost useable RAM until you
check About This Mac (in the Finder, Apple Menu > About This Mac) to see how much
RAM you have, or when some of your apps … run … painfully … slowly. Here are some
possible ﬁxes.
OBSERVE PROPER SEATING Chances are that your RAM is simply seated improperly.
Remove the module and reinstall it. Make sure the connection is tight.
ROTATE YOUR RAM Try switching your memory modules around. Move RAM in upper
slots to lower slots and vice versa.
TEST YOUR LOGIC Dig up Apple’s Hardware Test CD (it comes with all Macs, so you
probably have it somewhere) and run its memory-diagnostic test. If you get an error
message that reads “post/0/2048 SODIMM0/J25LOWER,” you may have a faulty logic
board. Apple will give you a new logic board if your ’Book is still under warranty. If
your ’Book is out of warranty, you can ﬁnd replacement boards at PowerBook Medic
(www.powerbookmedic.com) and PBParts.com (www.pbparts.com).
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f you’re in the
market for a new
PDA, palmOne
unleashed the
Tungsten E2 ($249,
www.palmone.com),
which has a 320-by320-pixel color LCD,
32MB of nonvolatile
ﬂash memory, builtin Bluetooth, and
longer battery life
than the Tungsten E.
Econ Technologies’
ChronoSync 3.0 ($30,
www.econtechnologies
.com) lets you sync
ﬁles and folders from
one disk location
to another. The
new version comes
with a revamped
interface, new
synchronization
features, and
much more.
Jumsoft released
Keynote Animations
palmOne’s
3.0 ($45, www
second.jumsoft.com), a
generation E.
collection of 100
animated objects for Apple’s Keynote
and Pages. The collection includes
animated illustrations for business,
science, education, engineering, and
law. Mariner Software shipped Mariner
Write 3.6.5 ($59.95, www
.marinersoftware.com), which has new
AppleScript features, an improved
Find, and several software ﬁxes.
SmileOnMyMac’s pagesender 3.4
($29.95, www.smileonmymac.com) has
some minor bug ﬁxes and several new
features, including the abilities to sort
fax history chronologically and pause
and resume faxing.
Bare Bones Software announced
PunchOut ($149, www.barebones
.com), a backup application for Mac
OS 10.4 (Tiger). PunchOut uses OS
10.4’s Spotlight to analyze stored
data for backup and has a Dashboard
widget that monitors your backup. TLA
Systems announced DragThing 5.6 ($29,
www.dragthing.com), an alternative
to the Dock that supports OS 10.4’s
Smart Folders and has better image
previews.—Michelle Victoria
PRODUCTIVIT Y

THE LITTLE MAC
BOOK, TIGER EDITION
by Robin Williams
(Peachpit, $14.99)
www.peachpit.com
Robin makes even
the most complicated subjects easy to
understand.

I

IMAGE COURTESY OF PALM
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PUMP UP THE
PODCASTS

L

ooking to load up your ’Pod with
podcast fare? Give these Macrelated shows a listen.—Roman Loyola
THE MACCAST
www.maccast.com
For Mac geeks, by Mac geeks.
MACHELP FROM HAWAII
http://radio.weblogs.com/0142820
A lil’ bit of island ﬂavor with your Mac.
MY MAC GUYS
http://mymacguys.blogspot.com
Two buddies talk Mac shop.
ONE MINUTE TIP
http://radio.weblogs.com/0141930
Mac tips—fast and friendly.
YOUR MAC LIFE
www.yourmaclife.com
Internet show hosted by Mac addict
Shawn King.

DURAN DURAN:
MAC SERIOUS

F

IMAGE COURTESY OF SHORE FIRE MEDIA

or 1980s new-wave superband
Duran Duran, only Macs will do.
“We’re so reliant on Macs, it almost
scares me,” says keyboardist Nick
Rhodes. “No PCs.” Duran Duran used
Apple products to produce Astronaut
(their latest CD), the accompanying
bonus DVD, and their videos.
“All ﬁles were done on Pro
Tools,” says Rhodes. “We used
.Mac accounts for sending each
other MP3s.” Rhodes loads
samples into his keyboards
by connecting his iBook to
his vintage Roland Jupiter 8
synthesizer. “You can play a
whole show on a Mac.”
On their recent video shoot
Simon
for the song “What Happens
LeBon (top)
Tomorrow,” the band used a
and Nick
Power Mac G5 and an array of
Rhodes.
Mac software including Adobe
After Effects and Final Cut Pro HD to
transform themselves into animated
constellations. Rhodes even turned his
iBook into a makeshift synth keyboard.
“I put chords on single keys,” he said.
“I wrote notes like, ‘USFRJPQ.’ People
would look at them, knowing that chords
run from A to G, thinking, ‘What the
hell?’”—Joshua Rotter

SHAREWARE PICK OF THE MONTH
HTML-Optimizer X

www.tonbrand.nl

$17

C

runch down your Web site’s code using HTML-Optimizer X. Its Conﬁguration Wizard
makes it easy, and your visitors will be impressed by how fast you site loads.
—Andrew Tokuda

3 After you select your connection speed,
click Finish to continue.
When you ﬁrst launch HTML-Optimizer
X, you’re greeted by the Conﬁguration
Wizard. As you proceed, you’re eventually
asked to locate the local folder that
contains your Web site.
2 Next, you’re asked where you want to
save the optimized ﬁles. Your original ﬁles
remain untouched.

4 That’s all there is to it. HTML-Optimizer
X logs the process and displays your stats.

NEVER USE GRAPHICS FOR TEXT. That just makes your Web pages bigger—and slower.

iPOD CASE OF THE MONTH
Chums gets down with
Funky Betty (left) and
Groupie (right).

T

wo cases from Chums stand out this month: the Groupie ($30, www.chums
.com) for your iPod mini and the Funky Betty ($35) for your standard-size iPod.
The Groupie is made from PVC and comes in metallic colors. The Funky Betty is
made of pack cloth with a ripstop texture and comes in crazy camouﬂage color
combos—the only problem is you can’t access the iPod’s controls through the case.
Both cases have a belt clip, a lanyard, and a carabiner clip.—Michelle Victoria
SUBMIT YOUR CASE Whether your iPod case is a custom-made one-off or mass produced, you can submit it for Case-of-the-Month consideration—
just send it to iPod Case of the Month, MacAddict, 150 North Hill Dr., Ste. 40, Brisbane, CA 94005. Please note that we cannot return cases.
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REQUIREMENTS

PowerPC G3, G4, or G5 processor• 256MB RAM (to which we say, “Ha!” Get yourself at least 512MB) • 3GB disk space (1GB more for developer tools) • Built-in FireWire* • DVD drive for
installation (CDs are available for $9.95 extra; see www.apple.com/macosx/upgrade/requirements.html) • Apple-certiﬁed video card for Core Image enhancements (list of supported cards
available at www.apple.com/macosx/features/coreimage; as of press time, Mac minis and iBooks can’t take full advantage of Core Image)
12
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Our experts show you how to make Apple’s big cat
jump through hoops, purr like a kitty,
and eat out of your hand.
by Niko Coucouvanis, Roman Loyola, and Rik Myslewski

A MING TIGER
L

et’s cut to the chase:
Q. Is it really worth shelling out $129 for Apple’s new
operating system, especially considering that the
previous version squeezed an equal pile of cash out of
you a mere 18 months ago?
A. Yes. Tiger’s potent combo of interface enhancements,
upgraded apps, and under-the-hood muscle will change (for
the better) how you and your Mac work together.
We here at MacAddict have been mucking around inside
successive beta releases of Tiger for months now, getting
to know its innards, its powers, and its quirks. We tried to
choke the new Spotlight search function with humongous
gigaheaps of text, video, and image ﬁles, and we failed—its
performance remains breathtakingly snappy. We tried to
choke iChat AV’s multiparty videoconferencing by denying it

the bandwidth it thirsts for, and we succeeded—at Apple’s
stated minimum iChat AV requirements, videoconferences
look like hell. We tried to ferret out each and every one of
Tiger’s improvements, from the productivity-enhancing
eye candy (iCandy?) of Dashboard to the Romulan Bird of
Prey–level invisibility provided by the new Stealth Mode,
and we failed—every time we thought we’d found the last of
Tiger’s new niceties, another cry of “Damn! Check this out!”
rose from one of our cubicles.
Now it’s time to share what we’ve discovered with you. If
you’ve already brought the big kitty home, we’ll show you a
pile o’ tricks that you don’t yet know your new pet can do. And
if you’re still pondering that $129 price tag, we’re willing to
bet you’ll be reaching for your credit card about the same time
you reach page 26.

ALL GOOD STUFF
Address Book.............. p21
Automator ................... p19
Calculators ................. p23
Dashboard .................. p18
Desktop &
Screen Saver ............... p26

Dictionaries ................ p26
DVD Player .................. p17
Finder.......................... p15
Font Book .................... p22
iChat AV ...................... p16
.Mac Sync ................... p19

Mail............................. p20
Networking ................. p24
Parental
Controls ...................... p25
Preview ....................... p23
Print & Fax .................. p21

QuickTime 7 ................ p17
Safari RSS...................p24
Security ...................... p25
Spotlight .................... p14
TextEdit....................... p20
VoiceOver ................... p15

*An Apple spokesperson told us that Tiger doesn’t actually require built-in FireWire; rather, the advent of FireWire coincided with Macs capable of handling Tiger, and the company ﬁgured
that simply calling FireWire a requirement rather than detailing all the required technical specs would be easier for everyone involved.
July 2005
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SPOTLIGHT
A

pple claims that Tiger changes the way you
use your Mac, and that’s mostly because of
Spotlight. Sure, you’ll try every one of the tasty
Dashboard widgets; you’ll play around with Automator
until you realize you don’t really do anything all that
repetitive with your Mac; you’ll even try some four-way
videoconferencing and wish you had the bucks for a
bandwidth upgrade. But you’ll use Spotlight every
day—you can hardly avoid it, as its little search boxes
invade your menus, toolbars, and iApps—they
even inﬁltrate the Open and Save dialogs of
non-Apple software.
More than any of Tiger’s other 200-plus
new features, Spotlight delivers on its
promise: lightning-fast searching with supercustomizable results. Spotlight starts searching
even before you can bang three letters into the search
box (so searching for the word search might return a
sea of seas), but it trims the results so quickly that you
barely notice. The magic lies in Tiger’s enhanced ﬁle
system, which continually feeds the main Spotlight
index and remembers what you’ve looked at lately.
Technically speaking, Spotlight is a different animal
than the good-ol’ Command-F searching you’re used

T
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Search your entire
hard disk—
and do it smartly.

to, but the former powers the latter. Click on the menu
bar’s magnifying-glass icon for a quick-and-dirty
Spotlight search; for something quicker and dirtier,
highlight a word on the screen and Control-click it to
bring up a Contextual Menu with a Search In Spotlight
option. The traditional Command-F power search now
launches a modiﬁed Finder window with the usual
left-side Sidebar and two search limiters to get you
started—Kind and Last Opened—though you can add
as many more as you’d like.
And what about these Smart Folders that
everyone’s so jazzed about? Simply click the
Save button in the Search window to save
your search results as a Smart Folder; open
up the Smart Folder later, and Spotlight will
automatically rerun that search. (This only
applies to results from Command-F searches—you
can’t save menu-bar searches as Smart Folders.)
Smart Folders add themselves to the Finder Sidebar
by default; a default Saved Searches folder resides in
your Library folder, though you can stash Smart Folders
anywhere. You can’t actually place anything in a Smart
Folder yourself, however—they’re just for storing the
results of the automatic Spotlight search.—NC

WHOA, SPOTLIGHT
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Searching with Spotlight can seem like overkill, especially when it returns a load of ﬁles that have nothing
to do with what you’re looking for. Do yourself a favor and visit System Preferences > Spotlight. In the Search
Results pane, turn off any of the 14 categories that aren’t likely to contain what you’re looking for (Fonts, for
example). Once you’ve checked off the categories you don’t want, click and drag the active categories into
the order in which you want to see the results. To set up a blacklist of off-limits places, select the Privacy tab,
and click the plus-sign icon to add folders or entire volumes to the list—or just drag them into the window
if you’re lazy. Just keep in mind that “privacy” is a relative term—as it turns out, the System Preferences
Privacy settings only apply to Spotlight searches initiated from the menu bar, not those started with
Command-F or File > Find—and that means the settings don’t apply to Smart Folders, either.

Spotlight even shows up in the Character
Palette, digging out more interrobangs
than ever dreamed you had.
Given the mountains of results
Spotlight can ﬁnd, you might want
to tweak what it displays ahead
of time.

Then again, you can always do it
at go time in the results window.

FINDER
T

he big addition to Tiger’s Finder is Smart Folder
technology (more on that in a moment), but the
smarts don’t stop there. Smaller smarties include
new Contextual Menu items and new items in the
Application > Services menu for tying Tiger together.
Select an item on the desktop or highlight a word in
a document, and you can choose from a number of
actions: Look up your word in the Dictionary, create
a font library from selected text, launch a Slideshow,
search with Spotlight, create Automator
Workﬂows, and more.
And when an app “unexpectedly quits,”
the experience is a teeny bit less annoying:
The error dialog now has a Try Again button to
relaunch the app that bailed.
Burnable Folders. Burning discs from the
Finder was one of OS X’s initial marquee features, but
Tiger ﬁnally makes it a feature we’ll actually use. Create
a Burn Folder (File > New Burn Folder) and drop in all the
stuff you want to burn. The folder ﬁlls up with aliases,
and when you’re ready, you just press the Burn button
beneath the toolbar to seal the deal (that is, burn the

While you can burn a Smart Folder to a disc, keep in mind
that it’s technically empty. (Note the little alias arrows.)

VOICEOVER
Hey, Mac, now you’re talkin’!

T

he Mac’s assistive technologies have always been
a step or two ahead of those built into Windows—
and with the addition of the VoiceOver screen
reader, Tiger leaps even further ahead.
VoiceOver provides a remarkably capable,
vastly conﬁgurable, and instantly
responsive screen reader designed to
help vision-impaired users control their
Macs solely by using their keyboards.
Although VoiceOver’s feature set is far too
rich to be described here, you can begin

Better disc burning and Smart
Folders are Finder’s most far-out
features.
disc). With the old way, you had to drag all your ﬁles to
a blank disc at once and click twice to burn the disc;
Burn Folders, by contrast, let you amass ﬁles over time,
assembling a load of aliases so you don’t have to keep
track of the originals or move them into a temporary
holding folder.
Smart Folders. Smart Folders are essentially another
way to use Spotlight (see “Spotlight,” p14). Create one
by selecting File > New Smart Folder from the Finder
menu, or simply use the search box in any open
Finder window—once your results start ﬁling in,
the window sprouts a Save button along with
some searchable locations (Servers, Computer,
Home, or any folder or volume you add via the
Others button) and a plus-sign icon for adding
search criteria. So what happens if you click that
Save button? Your Smart Folder sprouts a groovy little
action icon; the next time you open that folder, it polls
Spotlight’s continually updating index and busts out the
latest results, lickety split. Smart indeed.
The obvious question is, “Can I put a Smart Folder
inside a Burn Folder?” The answer is yes, but it’s not
the automatic backup solution you might be hoping
for. When you burn a disc with a Smart Folder inside, it
saves the Smart Folder’s search criteria and fancy icon,
but not the ﬁles inside—they’re not actually inside the
Smart Folder, you see. What you can do, however, is
use a Smart Folder to ﬁnd the items you want to back
up and then drag them from the search window into
a Burn Folder. Presto, a smart—or at least somewhat
educated—backup folder.—NC
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investigating it by choosing System Preferences >
Universal Access, clicking the Open VoiceOver Utility
button, then selecting Help > VoiceOver Help for a
thorough introduction to this powerful tool. Even if you
have no personal need for VoiceOver, you might enjoy
the utility’s
Pronunciation
tab; just click
the plussign icon
to open the
Pronunciation
Editor and
teach your
Mac how to
VoiceOver is designed for English
pronounce
speakers—but with a bit of prodding,
again,
you can always
do itsimulate
unfamiliar Then its
Pronunciation
Editor can
words.—RM at go passable
time in the
results window.
Polish.
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iCHAT AV
T
I
G

Max sees himself (bottom) as his familiar mirror image,
while his brethren appear as they do in real life.

E

iger’s upgrade to iChat AV promises a lot—but it
only lives up to its potential if you have hefty
hardware and a fast Internet connection.
iChat AV’s most dramatic new capabilities
are multiperson audio and video chatting. In
fact, “chatting” is a bit of an understatement—
full-blown conferencing is a more accurate
description. Both audio and video conferences
are easy to set up. Icons in iChat’s Buddy
List indicate whether a buddy is available for audio
conferencing (a phone icon) or video conferencing
(a camera icon). Single phone or camera icons tell
you that the buddy can participate in a one-to-one
conference; stacked icons indicate that a multipleperson conference is possible. To initiate a conference,
you’ll need a more powerful Mac and a faster Internet
connection than you’ll need if you merely participate
(see “No Wimps Need Apply,” below); under ideal

T
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NO WIMPS NEED APPLY
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If your Mac’s got the muscle, it’s time
for a multibuddy digital party.
conditions, ten people at a time can participate in an
audio conference, and four can in a video conference.
To invite a crowd into an audio conference, ﬁrst select
one buddy, then click the phone icon at the bottom of the
Buddy List window. That buddy is then prompted to join
the conference; after he or she does, click the plus-sign
icon at the bottom of the Audio Chat window, and a list of
buddies available for audio chat appears; invite them to
the conference one by one.
You initiate a video conference in the same way—but
our testing proved that all Macs are most deﬁnitely not
created equal when it comes to video conferencing.
Our test quartet of Macs included 1GHz and 1.33GHz
iBooks, a 1.67GHz PowerBook G4, and—as the initiating
Mac—a dual 2.5GHz Power Mac G5, each equipped
with an Apple iSight video camera. When we ﬁrst
hooked all four Macs to a 10/100Base-T Ethernet
switching hub connected to the Web over
MacAddict’s trio of high-speed T1 lines, not one
of the four Macs displayed any “I can conference!”
stacked-camera icons. To make our quartet
multiconference, we had to limit each Mac’s bandwidth
in iChat > Preferences > Video. As you’d expect, the higher
the bandwidth limit and the more powerful the Mac, the
better the video quality in a four-person conference. At
2Mbps, the 1GHz iBook could display video only slightly
less crisp than the dual 2.5GHz Power Mac G5’s decently
focused images; at 100Kbps, on the other hand, the
1GHz iBook’s video was a splotchy, blurry mess, while
the dual 2.5GHz Power Mac G5 provided a seriously
fuzzy, but acceptable, picture.—RM

Apple’s stated requirements for iChat AV
are absolute minimums: While it’s possible
to join a video conference with a minimumlevel computer, our testing showed that your
video quality will be downright lousy.
TO INITIATE
Your Mac
AUDIO One-to-One

Your Connection

TO PARTICIPATE
Your Mac

Your Connection

Any G3, G4,
or G5

56 Kbps

Any G3, G4,
or G5

56 Kbps

Ten
Participants

1GHz G4, dual
800MHz G4,
or any G5

128 Kbps

Any G3, G4,
or G5

56 Kbps

VIDEO One-to-One

600MHz G3 or
any G4 or G5

100 Kbps

600MHz G3 or
any G4 or G5

100 Kbps

Four
Participants

Dual 1GHz G4
or any G5

384 Kbps

1GHz G4,
dual 800MHz
G4, or any G5

100 Kbps

When four MacAddict editors
held an iChat AV video
conference, boss-man Rik
(front and center in the left
conference), initiating the
conference on a dual 2.5GHz
Power Mac G5 with a 2Mbps
bandwidth limit, had a decent
view of his colleagues; poor
Jake (right conference), stuck
on a 1GHz iBook at 100Kbps,
saw his fellow editors even
blurrier than in real life.

QUICKTIME 7
U

sers of HD (high-deﬁnition) video will get the most
out of QuickTime 7, as it now supports H.264, an
MPEG-4 video-compression standard that can
deliver high-quality video at lower data rates (Apple
says you can get the quality of MPEG-2 video for half the
data rate). This will help you keep all those HD videos
you’ll be making (or Apple hopes you’ll be making) more
manageable for your
hard disk and Internet
connection.
H.264 also makes
video scalable,
so regardless
of where you’re
watching your
video—on a
mobile phone,
on your iMac G5, or on
a 30-inch Apple Cinema
Display—it will look good. Take a gander at QuickTime’s
But there’s more to
new A/V Controls.

QuickTime 7 than just new HD support. You no longer
have to switch out of full-screen mode to access
movie controls; a control panel now appears when
you move your mouse. A new A/V Controls window
lets you quickly adjust audio and video playback.
You can also capture movies directly through the
QT player if you have a FireWire video camera or
Webcam.
Oh, and you’ll ﬁnd one other “feature” of note: a ton
of grayed-out items sprinkled throughout the menus.
These functions are only
available after you upgrade
to QuickTime 7 Pro ($29.99).
What a way to tease you
about what you’re missing,
huh?—RL

DVD PLAYER
T

HD video support is
the new hotness.

T
I
G
E
R

You have to upgrade to
QuickTime Pro to access
Save and many other
grayed-out features.

Looking for an alternative
to your standalone DVD
player? Take a peek at Tiger.

R
E

(Window > Video Color) to adjust Brightness, Contrast,
Color, and Tint using slider bars.
Audio Equalizer. Listening to concert DVDs?
You’ll want to use the Audio Equalizer (Window >
Audio Equalizer) to tweak the sound for the best
quality.
Other new features include Bookmarks
(Window > Bookmarks), which let you index part
of a DVD for later access; Video Clips (Window
> Video Clips), which indexes segments of a
DVD by marking the start and end points; and DVD
Navigator (Window > Navigator), which displays info
about the DVD (such as time elapsed, viewing angle,
chapter, volume,
and more) on a
screen that ﬂoats
above the DVDviewing window.
Try doing all that
Video Color lets you watch your Tweak sound output with Audio with your set-top
Then again, you can always
it
DVDdo
player.—RL
DVDs in a whole new light.
Equalizer.
at go time in the results window.

he new features in Tiger’s DVD Player make your
Mac a compelling alternative to your settop DVD player. What’s new?
Video Zoom. Not a fan of those black bars
on widescreen DVDs? You can use Video Zoom
(Window > Video Zoom) to zoom in and get rid of
the bars without losing image quality—though
you’ll end up cropping out parts of the image on
the sides if you maintain the image proportions.
You can choose to not maintain image proportions,
but then people may end up looking tall and skinny.
Video Color. If you’re watching a DVD in strange
lighting, you can use the new Video Color controls

Don’t like letterboxing? Video
Zoom can crop your image. Just
don’t tell your videophile friends.
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DASHBOARD
L

ong ago, in a Mac OS generation far, far away,
there existed little one-trick apps called Desk
Accessories. They were designed to perform
simple tasks: The Calculator crunched numbers; you
could write notes with Stickies; and Scrapbook let
you instantly access artwork (oh, how we miss the
Scrapbook!). Sadly, Desk Accessories went the way of
Mac OS 9.
But Desk Accessories are back with a vengeance
(hooray!)—only now they’re called widgets.
They reside in Tiger’s Dashboard, they look
marvelous, and they’re even more helpful than
Desk Accessories were thanks to the handy
Dashboard interface and access to the Internet.
What’s a widget? Widgets are small apps
dedicated to small tasks; they’re made up of
HTML, CSS, and JavaScript code. There are three
types of widgets: Accessory widgets, such as Calculator,
are self-contained and don’t need the Internet or data
from another larger app; Application widgets, such as
an iTunes player, rely on a larger app on your Mac; and
Information widgets, such as Weather, pull information
from the Internet. Apple includes 14 widgets with Tiger:
Address Book, Calculator, Calendar, Dictionary, Flight
Tracker, iTunes, Phone Book, Stickies, Stocks, Tile Game,
Translator, Unit Converter, Weather, and World Clock. The
name of the widget pretty much tells you what it does; for
example, Weather tells you if it’s sunny, rainy, cloudy, or
snowing in any part of the world.
Widgets are relatively easy to create, so expect a ton
of widgets from third-party software developers. JiWire
(www.jiwire.com), for example, already has a widget
that lets you look up Wi-Fi hotspots anywhere in the
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Desk Accessories are
reincarnated in the form
of Tiger’s Dashboard.

world, regardless of where you are.
Don the Dashboard. Widgets hang out on a separate
pseudo-desktop called the Dashboard. To open the
Dashboard, click on the Dashboard icon in your Dock,
or press the F12 key on your keyboard (you can reassign
this hot key in System Preferences > Dashboard &
Exposé). The Dashboard opens on top of your Desktop
in an Exposé-like fashion, and all of the widgets you’ve
chosen to display appear in one screen.
To choose which widgets you want to have
open, click on the plus-sign icon on the lower
left of the Dashboard to open the widget bar.
To add a widget, just click on its icon or drag it
to the Dashboard. You can even have multiple
instances of a widget open—ﬁve Weather
widgets, for example, to tell you what mother
nature’s up to in Lovelock, NV; Intercourse, PA;
Climax, GA; Conception, MO; and Baby, France.
Add more widgets. A More Widgets button lies on the
right side of the widget bar; if you click on it, you’ll go to
Apple’s Dashboard Widgets Web site (www.apple
.com/downloads/macosx/dashboard), where you’ll ﬁnd
dozens of non-Apple widgets, such as a FedEx/UPSpackage tracker, the aforementioned JiWire widget,
Stopwatch, DashBlog (which lets you make blog entries),
Hula Girl, and more. Many are free; some are shareware;
and others are demos of larger, full-scaled apps.
To add a new widget to your widget bar, just
download it. If it’s packaged properly, the download
will decompress and then automatically install itself
into the proper location on your hard drive (/Library/
Widgets). Launch Dashboard, and you’ll ﬁnd the new
widget listed alphabetically in your widget bar.—RL

WIDGET-OUT!
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Track the speed of
your sneakernet with
Stopwatch.

The Dashboard gives you instant
access to small, single-purpose apps.

Every
Dashboard
needs a
hula girl.

Find a neighborhood
public Wi-Fi location with
the JiWire Hotspot Finder.

Make blog entries through
DashBlog.

Track your Amazon
purchases with the FedEx/
UPS package tracker.

AUTOMATOR
O

GO WITH
THE FLOW

n the surface, you might think Automator is
just a new handy visual interface for good old
AppleScript—that’s what we thought
at ﬁrst—but Automator is a whole new
method to automate mundane, multistep
tasks, such as turning a document into
a password-protected Encrypted PDF
(see “Go with the Flow,” below). Sure, an
AppleScript guru could bang that out easily;
but Automator makes it so you don’t have
to know squat about AppleScript. Simply drag and
drop prescripted Actions into the order you want
Automator to execute them. Now, instead of opening
your ﬁle, calling up the Print dialog, selecting Encrypt
PDF from the PDF menu, supplying a password, and

saving the document, you can make turn the process
into a one-click affair by creating an Automator
Workﬂow and saving it as an application or
Contextual Menu plug-in. It’s easy to add
more Actions to, say, zip the ﬁle into an
archive, save a backup, and mail the ﬁle to
everyone in your Address Book who has a
birthday in September.
However, because Automator relies heavily
on precoded Actions—which are not trivial to
create—it isn’t as ﬂexible or powerful as AppleScript.
But Automator comes with a stock Run AppleScript
Action, meaning if you’re an AppleScript expert
already, you can make your Workﬂow as complex as
your skills allow.—NC
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Making a Workﬂow couldn’t be easier. Follow along as we create a little Workﬂow app that
creates an encrypted PDF out of any document we drop onto it.

Kick your Workﬂow into
gear with the Get Selected
Finder Items Action.

Next, add the Encrypt PDF Document
Action. A handy pane in the bottomleft of the window explains the
selected action.

.MAC SYNC

T

Let your Mac handle the
tasks you do over and
over and over.

R

At run time, all you have to
do is give the encrypted PDF
a name (and check the handy
status indicator up top).

E
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Lots of good news for .Mac
subscribers—and one big warning.

iger brings a little extra to .Mac subscribers in
the form of a slick new start page that gives quick
access to everything—your Mail, HomePage,
iDisk, and all the .Mac services. But the best news can
be found in the Sync section of your .Mac Preferences
pane: You can now sync your Keychains, Mail
Accounts, Mail Rules, Signatures, and Smart Mailboxes
to your .Mac account (in addition to the Calendars,
Contacts, and Bookmarks you could sync
before). We’ve heard grumblings, however,
that syncing Contacts via .Mac between
Address Book apps that aren’t identically
conﬁgured can make data in mismatched
ﬁelds disappear. (If only one of the
Address Books contains the contact’s

O
R

birthday, for
example, that
information
may vanish
during the
sync process.)
To avoid this
potential
bummer, select
Address Book
> Preferences,
Suddenly, .Mac has become the hub
click the
of our digital life.
Template tab,
Then
again,
you canmenu
always
and use the Add
Field
pull-down
todo
getityour
at go time
entries in matching
order.—NC
in the results window.
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MAIL

Apple’s integrated email app suddenly
becomes a lot more useful.

W

e’ve always liked the idea of using Apple’s
Mail, but its clunky performance and limited
features made it tough to get any work done.
Mail 2.0 looks to change all of that with new features
centered primarily around Tiger’s Spotlight search
technology. Aside from the obvious—industrialstrength mailbox searching—Spotlight also
powers the new Smart Mailboxes, which
remember and instantly execute your
most complicated (or simple) search
queries, just like the Finder’s Smart
Folders (see “Finder,” p15).
Mail taps into other Tiger
technologies, too, such as Parental
Controls, which let you specify whose
email gets through to Junior’s mailbox and whose
gets routed to yours. Slideshow controls let you view
the photos you receive in emails as a full-screen slide
show; there’s even an easy option to send the keepers
directly to iPhoto. The new Connection Doctor springs
into action the ﬁrst time you launch Mail, automatically
checking and testing your online connection as you ﬁll
in your account settings; and NTLM 2 (NT LAN Manager
2) support brings the Microsoft Exchange email-server
compatibility some have been crying for. The interactive
spelling checker is nice—but it’d be nicer still if it could
correct errors automatically.
Mail makes emailing photos much smarter: Attach an
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TEXTEDIT
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Look ma, no more oversized pictures of little Junior!

image ﬁle to a message, and it sprouts a pop-up menu
that lets you specify the image’s outbound size—Large,
Medium, Small, or Actual size.
There’s also some identity foolery for .Mac users:
You can use your .Mac Email Aliases from within Mail.
Sayonara, spam!—NC

Apple’s lil’ word processor
grows up.

T

here’s a lot to like about Tiger’s beefed-up TextEdit, such as support
for tables (Format > Text > Table), Spotlight-searchable document
properties and comments (File > Show Properties), and the option
to save your document as an HTML ﬁle, tables and all (File > Save As > File
Format > HTML). You can also add live HTML links to any text: Select the
text you want to link to a URL, select Format > Text > Link, and then enter the
target URL (be sure to include the http://), or drag it into the box
from your browser’s address bar. If you want to edit the URL
of an HTML link you’ve placed in a ﬁle, Control-click the
linked text, choose Edit Link from the Contextual Menu
that appears, then edit the URL in the Link Destination
sheet that drops down.—RM

T

TextEdit now offers plenty of nifty
options to help you set your tables.
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PRINT & FAX

Tiger makes printing more
efﬁcient by eliminating some
of the clutter.

T

he nicest change to the Print & Fax Preferencepane
(System Preferences > Print & Fax) is more-efﬁcient
printer setup. Instead of switching you to a separate
Printer Setup Utility when you want to view your printer’s
stats, Tiger now displays the stats in the Preference
pane. When you click on Supplies For This Printer,
you’re automatically taken to the online Apple
Store. You still need Printer Setup Utility,
however, to manage the details; when you click
on the Printer Setup button, the utility launches
and gives you a complete lowdown on your
printer, including driver versions, network location, paper
tray options, and more.—RL
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The Print & Fax Preference
pane gets a makeover.

R

ADDRESS BOOK
A

Automator and Spotlight
help turn Address Book
into a super-powered app.

link Address Book to iCal and Mail, and you’ll be
sending timely greetings on autopilot. Sound too
tricky? Try Address Book’s new Action buttons:
Click on the title next to a card’s phone number,
and up pops a menu offering to ﬁre off an SMS
message or dial your Bluetooth cell phone. If
you’d rather use the phone hanging on the
kitchen wall, Large Type displays a phone
number full-screen so you can read it from
across the room. Brilliant!
But our favorite new addition to Address Book is its
printing support. Select a Group or Name and press
Command-P (or go to File > Print) to bring up the new
Print dialog, which sports smart, easily adjustable
presets for envelopes, mailing labels, lists, and pocket
address books.
The presets let you
easily lay out and
print your contacts
however you want.
Still not sold?
Three little words:
Synchronize With
Exchange. For those
of you who know
what that means,
that’s do
probably
’nuff
Thenpocket
again,address
you can always
it
Printing envelopes—not to mention
said.—NC
at go time in the results
window.
books—has never been so simple.

pple’s own little contact manager is now
smarter than ever, thanks mostly to the addition
of Smart Groups. Like the Smart Folders,
Mailboxes, Playlists, and Albums in other
Tiger apps, Address Book’s onboard search
is powered by Spotlight, meaning it can
quickly scan every ﬁeld in your address
cards (not just the obvious ﬁelds). You could,
for example, search for all of your former
coworkers who are now Apple employees.
We can think of lots of ways Address Book
could work hand-in-hand with Automator, especially
if you have numerous contacts to impress by always
remembering birthdays and other pertinent dates
you’ve added to their cards—just use Automator to

Address Book can dial your cell phone for
you—or teleprompt the number if you want
to use the landline or fax machine.
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FONT BOOK
F

ont Book 2 soothes another sore spot that’s been
with OS X from the beginning—font management.
InDesign jockeys and prepress pros have long
cursed OS X’s font management as, to put it mildly,
suboptimal. Tiger’s Font Book changes all that—or at
least makes a noble effort. OS X still keeps its fonts in
at least three separate folder types—one for the system,
one for all users, and one for each user account—but
Font Book 2 puts the whole kit and kaboodle at your
ﬁngertips. It’s about a jillion times better than its
predecessor thanks to sensible font grouping;
user-creatable Collections and Libraries;
easy font validation and resolution of
duplicate fonts; plus à la carte font
enabling, disabling, and removal.
We have to wonder, though: Where
are the smart font folders—the ones that
auto-activate when you launch the document
that uses them? We’ll be looking for that in Font Book
2.0.1. Meanwhile, Font Book seems like the perfect
place to try your hand at developing an Automator
Workﬂow—except that you’d have to write the Actions
yourself. As we write this, Automator only has an Action
for activating fonts in a TextEdit document.
Bust out the Validator. If your Mac is behaving like
it’s possessed by demons, it might have something
to do with font corruption. Font Book 2 helps you ﬁnd
out if your fonts are actually funking things up: Select
a suspect font (or use the shotgun approach and
select your main All Fonts collection) and select File >
Validate Fonts. The Validator checks every aspect of
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a font’s constitution (including its Table Directory and
Character Code Mapping Subtables, whatever those
are). Validator ﬂags minor and serious problems, and a
handy pull-down menu lets you display only warnings
or errors. If you ﬁnd anything serious, check the box
next to the problem font, press Remove Checked,
and the miscreant goes straight into the Trash (with a
proper warning, of course).—NC

Validation is a good thing, but Font Book alerted us to
errors that didn’t seem to be there.

O
R
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Font Book puts key font controls at your Contextual Menu ﬁngertips.
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Tiger’s new font
manager actually does
its job.

CALCULATORS
E

leven years ago, when the ﬁrst Power Mac was
introduced, the “Gee willikers!” demo du jour
was the Graphing Calculator utility, which could
smoothly rotate complex 3D graphs based on equally
complex equations. It was an absolute mind boggler;
but if you put it up next to Tiger’s new Grapher
(/Applications/Utilities/Grapher), it would look
like a ’57 Chevy parked next to a Mercedes
SL600 Roadster. At the risk of stretching the
metaphor too far,
the ’57 Chevy was a
damn ﬁne machine
in its day—but we’ll
take the SL600 in a
head-to-head drag race,
thankyouverymuch.
You may never need
many—or even any—of
Grapher’s capabilities, but
ﬁre it up at least once to
revel in its geeky chic. When
Grapher’s Inspector allows
you to make graphs as ﬂashy you do, you’ll be greeted
with a New Graph dialog;
as you are.

PREVIEW
You can do more than the name
would suggest.

P

review, the built-in app for viewing images and
PDFs, has grown a lot in Tiger. With Preview’s
new tools, you won’t have to spend as much time
using other apps to perform simple modiﬁcations to
your documents and images.
The Image Correction tools in Preview
(Tools > Image Correction), available for image
ﬁles such as JPEGs but not for PDFs, may
remind you of the tools available in iPhoto,
with slider bars for Exposure, Gamma,
Saturation, Contrast, Brightness, and
more. Changes are permanent once you
save a ﬁle, so be careful—Preview doesn’t
archive an Original the way iPhoto does.
When you Get Info on a picture (Command-I), you
can add a list of Keywords to your picture, making the
image searchable by Spotlight.
When you open a PDF, you can add comments using

Got numbers you need to
crunch? Tiger’s got you
covered—in spades.

choose the 3D Graph tab, then select Default in the lefthand list. Click Open, then select any of the 3D graphs in
the Examples menu. You’ll be presented with a rotating
mathematical marvel and the equation upon which it’s
based. Select and change some of the numbers in the
equation, and enjoy the computational ride. Also,
don’t neglect exploring the Inspector dialog (click
the i icon) and Grapher > Preferences > Equations,
Numbers, and Advanced.
If integration using the fourth-order RungeKutta Method isn’t your cup-o’-tea, Tiger offers
you an enhanced version of the Calculator
app that shipped with earlier versions of OS X
(/Applications/Calculator). Pre-Tiger, the View menu
offered you two choices: Basic and Advanced. Now you
have three options: Basic (your standard, bare-bones
four-function calculator); Scientiﬁc (previously known as
Advanced); and our favorite, Programmer, in which you
can crunch away in decimal, octal, or hexadecimal bases
and even see the results of your ANDing, ORing, NORing,
and XORing in the corresponding ASCII or Unicode
characters. Oh, and for you old Forth programmers, don’t
miss View > RPN (Reverse Polish Notation).—RM
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R
the new PDF-annotation tools. In the Tool Mode section
of the tool bar, you’ll ﬁnd a button that lets you choose
Text Annotation or Oval Annotation. Text Annotation
adds Post-it–like squares of text to your PDF, while Oval
Annotations can circle items you want to call attention to.
The Image Correction tools are grayed out for PDFs, but
you can crop the page or the whole document at once.
Preview’s new screen-capture tools are available
in File > Grab. When you take a screen capture via
Preview, the shot opens in a new Preview window. You
can perform three types of screen captures: Selection,
which allows you to take a snapshot of a portion of
your screen by clicking, dragging, and releasing the
area; Window, which lets you select a particular open
window; and Timed Screen, which takes a shot of your
whole screen after a 10-second delay.—RL
Then again, you can always do it
at go time in the results window.

Preview boasts new
Image Correction tools.
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Oval annotation lets you
make comments.

July 2005

23

SAFARI RSS

Faster news updates and
Stealth Mode surﬁng?
We’ll take it!

B

uilding on a solid pedigree of tabbed browsing,
integrated Google searching, and SnapBack
buttons, Safari RSS is leaner, meaner, and
generally cleaner than its predecessor. The big news
(as you could guess by its title) is the integrated RSS
reader. If you haven’t heard of RSS, it stands for Really
Simple Syndication (though we’ve also heard Rich Site
Summary and Rich Site Syndication), and it’s a way for
news-heavy Web sites and busy blogs to deliver
headlines, summaries, and other bits of
information to readers without any of the
traditional Web-site trimmings. We used
to view RSS content in dedicated RSS
readers, such as NetNewsWire ($39.95,
http://ranchero.com/netnewswire), but
Safari RSS displays it right in your Web
browser. Just click on for the little RSS icon in the
address bar (Safari shows the button automatically
when you visit a site offering RSS) to get that site’s RSS
feed, and bookmark it for whenever you need to update
your headlines.
Safari also speeds up your online time-wasting,
rendering full-blown graphical Web pages 1.8 times
faster (or so Apple claims) than the old version and a
full four times faster than Internet Explorer. We’re no
clock-watchers, but Safari RSS seems way fast. And
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History search is way better than reliving
the entire past, page by page.
speaking of speed, remember how much time you used
to waste digging through your History to ﬁnd that one
page about marmots? Now you can simply press the
little open-book icon or select Bookmarks > Show All
Bookmarks to open your Bookmarks manager; select
the History icon in the Collections list and type marmot
in the search box at the bottom to search all the URLs
and page titles in your History list.
In the “clean” department, we’re sure Private
Browsing mode wasn’t developed speciﬁcally for
concealing your addiction to online porn sites, and
we’re sure you have plenty of perfectly respectable
reasons to use a sneaky browsing mode that leaves no
telltale traces in your cache, cookies, or history of the
sites you’ve visited. Heck, even the Downloads window
politely declines to list the ﬁles you download—just
keep in mind that the actual ﬁles you download with
Private Browsing stay where you put them.
If Private Mode sounds like a dirty dream come true
for juvenile delinquents looking to cover their online
trails, there’s a remedy: Safari works hand in hand
with Tiger’s advanced Parental Controls (see “Parental
Controls,” p25).—NC

O

RSS cuts Apple’s Hot News page to the bone.

R

NETWORKING

T

T

rue to OS X’s “easy Unix” roots, Tiger’s
networking advancements are great for ’Nix
jocks and normal folk alike. For Joe Home
Network, new Network Diagnostics (sort of like a
retroactive Setup Assistant) help you isolate a dead
connection and ﬁgure out whether the culprit is your
network settings or your hardware conﬁguration.
Remote workers and other power networkers get
advanced support for secure remote access thanks
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Telecommuters and
system administrators will
dig their new options.

to WebDAV, VPN (Virtual Private Network), and
even NTLM 2 (NT LAN Manager) for Windows SMB
(Server Message Block) servers. In a local-network
environment (such as your ofﬁce), you can now
browse just about any type of network from the
comfort of a Finder window.
And for you System Administrators: Deep, deep
within Tiger’s bowels, you’ll ﬁnd a Korn shell for
husking around with Sun servers.—NC

SECURITY

Keep prying eyes from even seeing
your Mac online by activating
Tiger’s new Stealth Mode.

W

ith Tiger, Apple better protects users from
malicious creeps while making it easier for a
Mac’s rightful users to work and play. Take
the Firewall, for example: Now you can avail yourself of
Advanced functions (cleverly stashed behind
the Advanced button) such as Firewall
Logging, which keeps a record of blocked
trafﬁc and foiled break-in attempts. Our
favorite new Firewall trick, though, is Stealth
Mode—it not only stops hackers from getting
into your system, it also hides your Mac’s
very existence from the rest of the Internet. You’ll
cruise the ’Net like a cloaked Romulan Bird of Prey. Sort of.
The updated Keychain Access utility (/Applications/
Utilities) sports two smart new assistants that make
it easier to use OS X’s righteous under-the-hood
Unix security. The Password Assistant’s icon (a keylooking thing) appears in any dialog box where you’re
prompted to set a password; click the icon, set the type
and length of password you want, and the assistant
automagically generates 10 suitable passwords. The

PARENTAL CONTROLS

K

ids can mess up Macs. The Web can mess up kids.
Tiger can help you prevent both eventualities.
A new Parental Controls tab has been added to
the Accounts pane of System Preferences; click it and
you’re presented with a pane that displays Mail, Finder
& System, iChat, Safari, and Dictionary icons. Clicking
the check box next to any of them changes the status
of the selected account from Standard to Managed
(Admin accounts can’t be parentally controlled) and
displays a sheet into which you can enter the limits you
want to set. To limit Mail, you need to enter the email
addresses that the managed account will be allowed
to exchange emails with—but you can’t add a list of
proscribed addresses. In the Finder & System pane,
you ﬁrst choose either Simple Finder (which functions
as it did in Panther) or Some Limits. Select the latter
option, and you’ll be able to limit the managed user’s
access to certain system functions and applications
(see screenshot, right). Clicking the plus-sign icon in
the iChat sheet brings up iChat’s Buddies dialog, which
lets you select approved chat Buddies.
Safari controls are a bit more complex to set up. First,
log into the managed user’s account and launch Safari.
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You tell Password Assistant what type and length of
password you want; it automatically generates 10 for you
to choose from.

E

cleverly hidden Certiﬁcate Assistant (Keychain Access >
Certiﬁcate Assistant) lets you create your own selfauthorized security certiﬁcate; create a certiﬁcate
authority with which you can create certiﬁcates for
other people; or request, view, and evaluate certiﬁcates
created by other users or certiﬁcate authorities.
Certiﬁably cool.—NC

R

Tiger can now help you protect
both your Mac and your kids.
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Now, when you
try to access a
Web site that’s
not in Safari’s
Bookmarks
bar, you get
an error page
telling you that
“Safari is limited
by parental
controls.” The
page contains
Prevent your kids from mucking
two buttons: Go
about in your Mac’s innards.
Back and Add
Website. Click Add Website, and you’re asked for an
administrator’s name and password; when you supply
them, a sheet appears prompting you to name the
Bookmark, which is then added to the Bookmarks bar or
folder.
Parentally controlling the Dictionary merely sanitizes
its contents—the deﬁnition of crap, for example,
becomes merely
“aagain,
losingyou
throw
2, 3, ordo
12itin
Then
canofalways
craps.”—RM at go time in the results window.
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DICTIONARIES

Orthographers rejoice! The New Oxford
American Dictionary now lives at system level.

A

is that each and every word within is hyperlinked
s Tiger’s new calculator offerings enable you to
to its deﬁnition. When, for example, you look up
work with numbers in a variety of ways, so do
hypochondriacal and ﬁnd the unhelpful “of or affected
the new dictionaries provide you with several
by hypochondria,” just double-click on hypochondria to
different levels of verbal advantage.
bring up its more helpful deﬁnition—instantly.
Launch the new Dictionary app (/Applications/
Dashboard’s Dictionary widget, while useful for quickDictionary), then begin typing the word you seek in
and-dirty lookups, is a pale shadow of the Dictionary
the upper-right search ﬁeld. As you type, Dictionary
app. There’s no hyperlinking, for example.
narrows down its word list to match the letters you’ve
Far more impressive is the integration of the system
typed—if you type an unrecognized word, Dictionary
Dictionary into Apple-supplied apps
makes helpful suggestions. When
such as TextEdit and Mail. Hold down
you see your desired word, click
the Dictionary-invoking key combo
on it and you’ll get both a list of its
(Control-Command-D is the default),
deﬁnitions and, if appropriate, its
drag your mouse over any word, and its
synonyms. You can display results in
deﬁnition pops up in a small window;
10 different text sizes ranging from
see the word’s Thesaurus entry by
minuscule to ginormous (and yes,
selecting Oxford Thesaurus from the
both of those are in the Thesaurus).
Oxford Dictionary drop-down menu, or
You can also cut and paste words
click More to launch the Dictionary app
into other apps.
and go to the selected word’s deﬁnition
The most extraordinary feature
When all you need is a quick
in the blink of an eye.—RM
of the Dictionary app, however,
deﬁnition, this widget will sufﬁce.
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Then again, you can always do it
at go time in the results window.

SCREENSAVER & DESKTOP
R

I

n Tiger’s Desktop pane, the Nature folder has been
expanded into two folders: Nature and Plants, both of
which are bolstered with far richer selections of, well,
images of plants and nature. A new Black & White folder
contains ﬁve new—and more restful—additions to the
stock collection. And as before, the Desktop & Screen
Saver pane ties into iPhoto, allowing you to display
images from any of your iPhoto albums.
More iApp ties are found in the enhanced Screensaver
tab. An iTunes Artwork screensaver lets you display up
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Even the eye candy is
new and improved.

to eight rows of CD covers from your iTunes collection,
and a new RSS Visualizer displays a spinning and
continually updating array of your choice of 80 news
feeds from Safari’s RSS
implementation.—RM
Check out Tiger’s
elegant new selection
of black-and-white
desktop images.

R

TIGER TIDBITS

T

W

The cat’s got some hep tricks up its fur.

e stumbled on a few unheralded kitty tricks
that we thought were pretty cool and decided
to share them:
• If you shoot pictures with different digital cameras,
simply enter one of the cameras’ model names into
Spotlight to ﬁnd photos shot by that camera.
• Type a few letters of a word in Mail, Stickies, or
TextEdit, and press Escape. You’ll be presented
with a scrolling list of all the words that begin with
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that letter; click one of the words to insert it into the
document.
• You don’t even have to open Font Book to make a font
collection: Simply click on a document in the Finder (we
tried Microsoft Word and Adobe InDesign docs) and
select Finder > Services > Font Book > Create Collection
From Text.
MacAddict editors Niko, Roman, and Rik are still debating
whether Mac OS 10.4 is Panthera tigris tigris, altaica,
sumatrae, corbetti, or amoyensis.

Field Guide to SEARCH ENGINES

SEARCH PARTY
By Robert Strohmeyer

S

earch engines are supposed to help you ﬁnd your way through the vast expanse of
the Internet, but these days, ﬁnding your way around all the new search engines can
be almost as bafﬂing. Familiar “crawler” engines such as Google and Yahoo build massive
databases of Web sites by constantly scouring the Web for new sites—but when you’re writing a
paper on American history or trying to ﬁnd ﬂights to Pittsburgh, you don’t need a billion results,
just the right ones. Try some of the following sites next time and get where you want to go faster.
GENERAL

A9

TEOMA

An Amazon.com subsidiary, A9’s goal is to provide a search
experience as personalized as your Amazon shopping
experience. A9 keeps track of your recent searches, lets you keep
a diary of visited sites, and makes site recommendations based
on past searches. The main window provides buttons to add
columns such as Images and Reference to the Google-provided
main results, and you can add new buttons to see Wikipedia
entries, medical literature, or other people’s searches.

If you’ve never tried Teoma, do it now. Its crawler engine uses
subject-speciﬁc search technology to sort sites by relevance
and popularity, rather than simply counting the number of
other sites linked to them. But the real reason Teoma is worth
your while is its Reﬁne feature, which suggests ways to dig
deeper into your subject. And if that’s not enough, it also
includes collections of links from experts in a wide range of
subjects. Teoma only does keyword searches, though—you’ll
still need alternatives for images, news, music, and maps.

GIGABLAST

TRAVEL

www.a9.com A crawler with customizable results

www.gigablast.com A crawler with refinement tools
In an effort to out-innovate Google, Gigablast is building new
features all the time. At press time, the site’s index contained
a mere 1.5 billion sites (compared to 8 billion for Google), but
the results were plenty potent. Most intriguing is the site’s Giga
Bits feature, which shows which sites have the most results for
your keywords. Gigablast can also return pages related to your
search that don’t necessarily have your search terms. Gigablast
doesn’t yet offer specialized searches for images, so Google’s
still got Gigablast beat in that regard.

MSN SEARCH

http://search.msn.com
A crawler plus Encarta encyclopedia database
Microsoft just can’t help itself: Whether there’s a need or
not, the company is determined to wiggle its way into every
nook and cranny of the Net. In an effort to take top seat in the
search world, it now offers MSN Search. The results, compiled
by the company’s own crawler, MSNBot, are impressive,
providing relevant results with little extraneous junk. The
site’s integration of the Encarta encyclopedia makes it a great
resource for quick research.
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www.teoma.com A crawler with refinement tools

KAYAK.COM

www.kayak.com
A queries other travel sites to consolidate results
Kayak.com doesn’t just consolidate travel results from more
than 100 travel sites such as Expedia and Priceline.com; it also
adds extra tools for reﬁning your results to get the best price,
best travel dates, and best lodging. It vastly improves the
travel-search interface by automatically showing you airports
near your destination as you type, eliminating the Expediaesque annoyance of entering a search only to be told the
engine couldn’t ﬁgure out what airport you were looking for.

SIDESTEP

www.sidestep.com
A queries other travel sites to consolidate results
While it’s not quite as simple to navigate as Kayak.com,
Sidestep makes buying easier by taking you directly to the
travel site that provided your result. It also searches more sites
than Kayak, and that means more results. Our search for ﬂights
from SFO to Tokyo saved us more than $100 over Kayak’s
results.

SHOPPING

BECOME

www.become.com
A crawler with proprietary ranking system

This shopping site locates reviews, buying guides,
and other such information. If you already know you
want that 42-inch Sony Plasma HDTV, go right to price sites
like Froogle and PriceGrabber; but if you’re still trying to decide
between LCD and plasma, Become is a good start.

OODLE

www.oodle.com A portal to classified-ad sites

ANSWERS.COM

www.answers.com A encyclopedic database
Most search engines just point you to sites where you might
ﬁnd what you’re looking for. Answers.com goes the extra
mile by consolidating entries from GuruNet, Wikipedia, and
other encyclopedic resources to give you what you’re looking
for without sending you elsewhere. It also features a 1-Click
Answers utility that you can install on your Mac for instant
explanations—just select the word or phrase you want to look
up, and press Command-Option-G for instant answers.

Like a massive interactive classiﬁeds section, Oodle lets you
browse for stuff you want, from cars to jobs. Clicking Cars >
Volkswagen > R32, for example, shows you a sports hatchback
with low mileage in San Francisco for only $29,000. The
results are mostly culled from www.craigslist.com (plus some
newspapers), but Oodle is far easier to search through.

PINPOINT

www.pinpointshopping.com
A crawler focused on shopping sites only

BRAINBOOST

By crawling through listings at thousands of different online
stores, Pinpoint (run by America Online) lets you comparison
shop without being ﬂooded by cluttered listings. Type in
PowerBook 15, for example, and you’ll get several pages of
prices, plus a pop-up window that lets you specify whether
you’re looking for a computer, battery, case, or something else.

www.brainboost.com
A crawler with proprietary ranking system

PEOPLE

With a natural-language engine similar to that of Ask Jeeves,
Brainboost lets you ask plain-English questions and displays
complete answers, as well as pointers to the sites they came
from. Also like Ask Jeeves, however, the answers may or may
not be the ones you’re looking for. For example, when we
asked, “Why do birds sing?” the top result explained, “Because
they trust God.” We were hoping for something a little more
scientiﬁc. But the answer to “What is Independence Day?” was
perfectly adequate.

FACTBITES
www.factbites.com

A crawler with content analysis

Factbites describes itself as “more interested in content
analysis than link popularity,” and it’s true. The results are
heavy on the encyclopedia entries, which makes it great for
facts and history and not much use if you’re looking for the
name of a dentist in Tulsa. It’s also got a sidebar list of Related
Topics that may point you to useful ancillary data at least lead
you on an interesting information trail (Independence Day >
Green Day > Green Bay Packers, for example).

ZABASEARCH
www.zabasearch.com
A queries public databases to consolidate results
Zabasearch take away most of the challenge in ﬁnding people
on the Internet. We searched for our own names and were
horriﬁed by the accurate results. Then we looked up our old
girlfriends (yeah, like you never did that) and got a solid page
of addresses and phone numbers. None of the apparent links
worked in either Firefox or Safari, though.

ZOOMINFO
www.zoominfo.com

A crawler with a focus on people

When you’re more interested in who people are than where,
Zoominfo is a handy little site. It crawls the Web looking for
descriptions of people in a variety of press-release sites, media
outlets, and public databases, then extracts and summarizes
descriptive information. When we looked up our own names, it
gave us a pretty good recap of all our great Mac stories.
July 2005
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You’ll be
blown away.

You’ll be
impressed.

You’ll be
satisfied.

You’ll be
disappointed.

You’ll be
pissed off.
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It’s one thing for a product to help you do what you want to do; it’s another thing for a product to actually make you feel good.
Take Better Energy System’s Solio (pictured), which captures the power of the sun to keep our iPod batteries charged. Or
ThinkMaps’s Visual Thesaurus 3, which helps us see language in a new light. And then there’s Roland’s FR-7 V-Accordion, which
renders us speechless every time we squeeze it. Next month, we’re hoping to achieve inner bliss with such products MacSoft’s
Rise of Nations and Apple’s new Power Macs.
40
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Backdrop Designer Photoshop plug-in
BTMicro Bluetooth mouse
Burning Monkey Mahjong mahjong game
CanoScan LiDE 500F flatbed scanner
Cheetah3D 3D-modeling software
Chessmaster 9000 chess game
Combo 1.8-Inch ION Drive portable hard drive
Command & Conquer Generals: Zero Hour real-time strategy game
Drive Genius disk-utility software
Eye Candy 5: Nature Photoshop plug-in
Final Cut Express HD video-editing software
FR-7 V-Accordion digital accordion
HD300 digital music player
iBoom iPod boom box
iFlicks movie organizer
MetaSynth 4 audio-synthesizer software
MicFlex microphone
mini Skirt: glo Mac mini stand
Photo to Movie 3.2 photo-effects software
ShutterBug Web-authoring software
Solio solar iPod charger
SoundSoap 2 audio-cleaning software
StoreJet 1.8-Inch Portable HDD portable hard drive
Stylus Verve point-and-shoot camera
Visual Thesaurus 3 word-reference app
WireTap Pro sound-recording software

PLUS:

PHOTOGRAPH BY MARK MADEO

TheHotList
50 The best of the best from recent reviews.

Compatible with
Mac OS X or later.
Compatible with
Mac OS 9 or earlier.

We’d spend our
own hard-earned
money on this
product.
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Final Cut Express HD
BARGAIN-PRICED PROFESSIONAL VIDEO EDITOR

cleanly remove actors
from green-screen
backgrounds (for
compositing work); it can
also create noticeable
video artifacts in scenes
with a lot of ﬁne details
or quick camera pans.
Still, HDV works ﬁne
for other jobs: lowbudget indie ﬁlms,
documentaries, news
compilations, and
wacky-but-classy family
videos—and Express
makes capturing and
editing HDV a breeze. To
get an HD project started
in Express, just select
the Easy Setup that
suits your HDV footage’s
resolution. HDV cameras
shoot in one of two
resolution modes: 720p
(1,280 by 720 pixels with
Final Cut Express HD’s core interface is the same as the one in Final Cut Express—but that’s not a bad thing.
progressive-scan frames)
or 1080i (effectively
heavily compress their video, and
pple has gone certiﬁably gaga over
1,920 by 1,080 pixels with interlaced
that extreme compression makes
HD (high-deﬁnition) video these
frames). After Express transcodes the
HDV poorly suited for some jobs. For
days. The lovefest now extends to Final
HDV into a custom video codec, editing
starters, it limits your color-correction
Cut Express HD, which lets you edit
in Express works just like it always has
options, since HDV doesn’t record a
with standard DV video. Recording the
lot of color information to begin with.
At $299, Final Cut Express HD
video back to tape, however, requires
The compression makes it harder to
is a great deal.

A

HD video with a wide assortment of
pro-quality tools at a bargain basement
price of $299. That’s an exciting step,
to be sure—but whether HD support
is genuinely useful to today’s casual
ﬁlmmaker is a totally different matter
(see “To HD or Not to HD?”, right).
There are actually a number of HD
formats in the digital world, and Express
HD works with (and only with) the
relatively new HDV format. Think of HDV
as HD for the common man—a growing
number of prosumer HD cameras use
HDV to store crisp, clear imagery on
MiniDV tapes. That’s a nice convenience,
but it comes at a price—HDV cameras
COMPANY: Apple
CONTACT: 800-795-1000
or 408-996-1010, www.apple.com
PRICE: $299 (full), $99 (upgrade)
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TO HD OR NOT TO HD?
While it’s relatively easy to shoot and edit HD video, it’s not as easy to actually
distribute it. First off, your audience needs an HD television to watch your
video, and most folks still use standard-deﬁnition boob tubes—you may wind
up having to convert your HD imagery to standard deﬁnition, losing many of HD’s
beneﬁts. What’s more, there are no HD-capable DVD players on the market yet, so
you can’t play your HD masterpieces on a DVD player (though Blu-Ray and HD-DVD
players are due later this year, just in time for the holiday shopping season).
Given these gotchas, what can you do? You can record your edited HD movies
back to your camera’s tape, attach the camera to your HDTV, and roll the tape.
You can also save your videos as QuickTime ﬁles and play them directly on your
Mac—QuickTime 7’s new H.264 compression technology keeps HD-ﬁle sizes
relatively small, so you may even be able to email short movies to friends.

REQUIREMENTS: DV: 500MHz G4; HDV: 1GHz
G4; Mac OS 10.3.7 or later; Quartz Extreme graphics;
384MB RAM (512MB for real-time effects and
Soundtrack, 1GB for HDV editing); 15GB disk space

GOOD NEWS: Seamless HDV capture and
editing. Can import iMovie projects.
BAD NEWS: Few filmmakers will find HDV
support useful—at least for today.
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project’s video to
Soundtrack, where
you can compose
the video’s score
by arranging
prerecorded music
loops in time (you
get a library of
some 4,000 quality,
royalty-free loops,
using a wide variety
of instruments and
styles). You can
change a loop’s
musical key and
speed it up or slow
it down without
Use Soundtrack to score your video with prerecorded loops.
affecting pitch.
This ﬂexibility and a simple interface
a render that lasts several times longer
lets pretty much anyone create a rich,
than the length of your movie.
original score; when you’re done,
Soundtrack and LiveType. In addition
Soundtrack automatically transfers the
to HDV support, Express now ships with
audio back to Final Cut’s Timeline as a
two handy stand-alone apps that ﬁrst
stereo AIFF mix.
appeared in Final Cut Pro: LiveType and
LiveType is a second cousin to Apple’s
Soundtrack (not to be confused with
Motion ($299, www.apple.com); it lets
Soundtrack Pro, which is part of Apple’s
you quickly create fancy typographical
new Final Cut Studio).
effects. Unlike Motion, LiveType focuses
Interested in adding music to your
almost exclusively on text animation
edited video? Express can export your

and doesn’t require an industrialstrength Mac in order to run. You can
design your titles using any TrueType
or PostScript font, or you can try one
of the 27 included animated fonts
(though most have a cartoony feel). You
can also customize type with over 150
animated effects (bounces, rotations,
moving glows, color cycles, and a lot
more), each of which can be keyframed.
The only hitch: While LiveType looks
impressive in a demo, you won’t be able
to intuitively ﬁgure out its interface or
easily come back to it after a few months
out of practice. Expect to put in a few
solid hours to get a feel for it before
getting real value from it.
The bottom line. This upgrade is all
about Soundtrack, LiveType, and HDV
support. There are no interface changes,
and Express still doesn’t let you log
individual video clips as you capture
them, nor does it let you consolidate
edited projects so they keep only the
video your edits actually use. But hey, if
Express did that, you might as well call
it Final Cut Pro. At $299 (or $99 for an
upgrade), Final Cut Express HD is still a
great deal.—Helmut Kobler

SLIM PICKINGS
Wanna buy an HDV camera? As of press time, there were only
two models available: JVC’s JY-HD10U ($3,995, www.jvc.com)
and Sony’s HDR-FX1 ($3,699, www.sony.com). Both shoot
in a widescreen 16:9 aspect ratio, but the JVC model records
video at 1,280-by-720-pixel resolution and 29.97 progressive
frames per second (progressive mode gives video

a slightly less ﬂickery look); the Sony model shoots at an
effective 1,920-by-1,080-pixel resolution and produces
interlaced frames that are slightly more ﬂickery (conventional
NTSC TVs also use interlaced frames). Still, we favor the newer
Sony for its higher resolution, a unique 24-frames-per-second
ﬁlm mode, and a bunch of other reﬁnements.

Eeny meeny miney mo,
I want HD video.

JVC JY-HD10U

SONY HDR-FX1
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MetaSynth 4
ONE-OF-A-KIND SYNTHESIZER

The amazingly intuitive MetaSynth interface invites experimentation.

M

from a simple waveform to a multiusicians and sound designers
sampled audio source as the oscillator,
can now ﬁnally breath a sigh of
resulting in pure sonic bliss. The color
relief: A Mac OS X–native version of U&I
of a pixel determines the stereo-ﬁeld
Software’s unique MetaSynth has ﬁnally
position of the resulting rendered note:
arrived. And it really, really rocks. Really.
Red is panned left, green is panned
MetaSynth is a fascinating
right, and yellow is exactly in the middle.
synthesizer like no other. Its central
Audio effects such as tremolo and
concept is that any visual image can
echo are represented by graphically
be represented in sound by assigning
musical notes to individual
pixels, with visual brightness
mapped to volume and pixel
color used to determine
where to place a note in the
stereo ﬁeld. Think of it as a
mutant player-piano roll.
MetaSynth’s interface is
organized into rooms; each
room manages a different
aspect of audio editing and
effects. Image Synth is the
primary room, where visual
The new MultiWave synth module is more powerful than
information is converted into many standalone synths.
sound. A decent selection of
ﬁltering the source image, and you can
image presets guides you through the
even use the built-in painting tools to
intricacies of image-to-audio conversion,
paint custom sounds. If you think this
and the interactive nature of MetaSynth
description is bizarre, rest assured
invites seriously deep exploration. Each
that the aural results are positively
pixel of an image is the equivalent of a
outrageous.
musical note, and you can use anything
COMPANY: U&I Software
CONTACT: www.uisoftware.com
PRICE: $499 (Standard version),
$599 (Pro version)
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REQUIREMENTS: 266MHz
G3, Mac OS 10.1 or later, 128MB
RAM, 300MB disk space

New stuff. Existing MetaSynth fans
will be delighted by the new goodies
(aside from the long-awaited native OS X
implementation). All editing operations
offer a live audio preview, making an
already unusually interactive tool even
more conducive to tinkering—and the
whole process can be captured to disk in
real time. The extensive post-processing
audio effects now have their own room,
with graphic envelope controls for
speciﬁc effect parameters. A squiggly
envelope curve for pitch shifting
results in a perfectly smooth warble;
a harmonizer with a sloped envelope
creates an eerie moaning glissando
unlike anything you’ve ever heard. The
possibilities are simply astounding, and
the quality of the effects is nothing less
than stellar.
The Spectrum Synthesis room delivers
an entirely new synthesis method—it
lets you edit, rearrange, and mangle
sine waves. The new Sequencer room
lets you manually enter musical notes
as a starting point for image-to-sound
processing, but sadly, it lacks support
for MIDI-note input or importing MIDI
ﬁles—our biggest gripe with the app.
The Montage room is where MetaSynth
patches are combined together with a
graphic multitracking interface to make
complete musical compositions. New
core-instrument options (including an
amazing granular-synthesis mode) and
a slick Image Filter room further extend
the already overwhelming possibilities
for making cool sounds. Everything you
create can be exported in AIFF format for
use in your favorite sequencing package
or sampler.
One more gripe: MetaSynth Standard
only works in 16-bit audio mode; if you
want 24-bit audio processing (as well
as integrated external-audio recording),
you’ll need the more-expensive
MetaSynth Pro. We don’t think you
should have to pay extra in order to get
24-bit audio.
The bottom line. This is the closest
thing to a groundbreaking app we’ve
seen in a while. If you are interested
in audio, you need to see (and hear)
MetaSynth.—David Biedny

GOOD NEWS: OS X native (finally). Unique Spectrum Synthesis.
Envelope-controlled effects. Real-time capture to disk.
BAD NEWS: No MIDI support. Separate (and more-expensive)
Pro version needed for 24-bit audio processing.
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and Fireworks.
When you set the
camera to one of
these modes, it
remains in that
mode until you change it.
When you turn off the camera,
the mode defaults back to
Auto. A small but useful icon on
the Verve’s LCD tells you which
mode you’re in.
The Verve’s LCD measures
1.8 inches; images are clear
and easy to look at, though the
screen is hard to see at some
angles in bright sunlight. And like
the Stylus 500, the Verve doesn’t
have a viewﬁnder; if you can’t see the
LCD, you’ll have to resort to a framing
guessing game.
The overall image quality of the
Verve is quite good. Tones look natural
and colors exhibit no obvious shifting,
though the amount of noise in even mild
shadow spots is higher than in other
cameras of this class. We also found that
some of our images lacked sharpness—
just enough to be noticeable, but
not enough to be a deal breaker.
ALLURING AND PETITE POINT-AND-SHOOT CAMERA
Unfortunately, the Verve is limited to a
2x optical zoom.
by-120-pixel resolution). The nifty Quick
t’s easy to like Olympus’s fourSince the Verve is small enough to be
View button on the upper left corner of
megapixel Stylus Verve. It’s small and
carried with you everywhere, Olympus
the back side of the camera lets you look
stylish. It’s easy to use. And its images
offers six different body colors to suit
at the photos you’ve taken—you don’t
look pretty darn good for a point-andyour personality: Black, Crystal Blue,
have to use the mode dial to switch to
shoot camera.
Copper Orange, Pure White, Silver,
Playback mode. After using the Quick
Like its sibling the Stylus 500
and Velvet Red. The metal
View button, you can
(
Jun/05, p40), the Verve can
body is sturdy enough
return to Shooting
easily be held in your right hand. Your
ZOOM SPECS
to withstand constantly
mode by pressing the
index ﬁnger naturally rests across the
Read zoom specs
slipping into and out of
shutter button halfway
top of the camera to access the shutter
carefully. Often opticala pants pocket. The lens
or pushing the Quick
button, while your thumb is within
and digital-zoom
numbers are combined
retracts when you shut the
View button again. It’s
to make one big overall
camera off, and a metallic
an excellent way to
Olympus offers different body
zoom total. Focus
cover slides over the lens
review a shot you’ve just
colors to suit your personality.
on the optical-zoom
to protect it. The lens cover
taken and then quickly
number; digital zoom
makes a loud shutter-like
get back to snapping
easy reaching distance of the zoom
is crap.
sound when it moves in
pictures.
rocker button on the back. Below the
and out of place—a sound
The Verve has 14
zoom button lies a directional pad for
that we found to be very
different shooting
navigating through the Verve’s options
pleasing, oddly enough.
modes: Auto, Portrait, Landscape,
and functions. The mode dial has
The bottom line. The Verve is a nice
Landscape+Portrait, Night Scene,
only three camera modes: Shooting,
combination of portability, style, ease
Cuisine, Beach & Snow, Self
Playback, and Video Record (you can
of use, and good image quality. Good
Portrait+Self Timer, Behind Glass,
capture QuickTime movies at 15 frames
camera; small package.—Roman Loyola
Self Portrait, Indoor, Candle, Sunset,
per second in 320-by-240-pixel or 160May your pictures
have as much
verve as this
camera.

Stylus Verve

COMPANY: Olympus
CONTACT: 888-553-4448,
www.olympusamerica.com
PRICE: $299.99

REQUIREMENTS: USB-equipped
Mac, Mac OS 10.1 or later

GOOD NEWS: Pocket-sized. Easy to use. Stylish. Good
image color quality. Assortment of body-color choices.
BAD NEWS: No viewfinder. Soft images. Only has 2x
optical zoom.
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V-Accordion FR-7

REALISTIC AND FUTURISTIC DIGITAL ACCORDION
he accordion has taken more than
its fair share of ridicule over the
years (What’s the difference between
an onion and an accordion? People cry
when they chop up onions. Ba-dumdum!), but Roland’s new V-Accordion
FR-7 may change all that. The ﬁrst
digital squeezebox affords modern MIDI
conveniences without sacriﬁcing the
form or function of the instrument.
The FR-7 looks, feels, and sounds
like a traditional bellows-driven
accordion, but underneath
the hood lies the power and
ﬂexibility of a modern digital
keyboard. The lifeblood of this
instrument is a physical-behavior
modeling system that gathers
information about key presses and
bellows pressure and then produces
true-to-life accordion sounds from an
impressive 32MB of waveforms. Although
built speciﬁcally for simulating different
styles of accordions from all over the
world (folk accordions, concertinas, and
so on), the FR-7 also does an impressive
job emulating other families of bellowsdriven instruments; it does an especially
haunting imitation of highland bagpipes
(complete with droning bass notes).
The FR-7 also includes a wide variety of
orchestral waveforms; these sounds can
be played solo or easily layered with the
accordion sounds.
Gigging with the V-Accordion is a
snap, especially if you opt for the FR-7
model and its built-in speakers (the
$5,499 FR-5 lacks speakers and a
power amp). Plug in your battery pack,
and you’re free to roam from table to
table in your favorite Italian restaurant.
The built-in speakers can easily meet
(and exceed) the volume level of a
conventional accordion. Thoughtfully
placed speakers—one on the key side
and one on the button side—preserve
a normal accordion’s inherent stereo
spread, and conveniently located reverb,
chorus, and delay knobs let you adjust
the sound to your liking in real time.
COMPANY: Roland
CONTACT: 323-890-3700,
www.rolandus.com
PRICE: $6,499
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The FR-7 is
a barrel of fun
for accordionists
young and old.

For larger venues, the
FR-7 can be plugged into an
ampliﬁer using two standard
0.25-inch instrument cables for
stereo operation.
MIDI control. In a recording
environment, just plug the stereo
outputs directly into your mixer or Mac,
and you’re ready to go. If you want to
record MIDI data in an application such
as GarageBand, you’re amply covered:
Note information from the different
sections (treble notes, bass buttons,
and chord buttons) is simultaneously
broadcast on separate MIDI channels,
giving you great ﬂexibility. Combine this
with the touch- and aftertouch-sensitive
keyboard, and you have a powerful and
expressive MIDI controller. Although
the FR-7 could be used to control just

REQUIREMENTS:
Mac with audio inputs.

about any MIDI
sound source, most
users will probably stick
with the quality array
of on-board sounds. One
downside: The instrument
lacks built-in MIDI ports. Instead,
they’re located on the rear of the
included foot-pedal/battery-charger
assembly, which must be plugged
into the wall and then attached to the
accordion with a bulky, proprietary 18pin cable.
The V-Accordion offers an additional
practical perk that has been thus
far unattainable with a traditional
accordion: Want to practice late at night
without harassing your neighbors or
signiﬁcant other? No problem—just turn
down the volume knob, or plug in a set
of headphones, and perfect that polka
late into the evening.
The bottom line. If you’re serious
about squeezeboxes, you should place
your FR-7 order now, before Weird Al
buys them all up.—Jude Kelley

GOOD NEWS: Solid construction. A huge variety of
accordion sounds.
BAD NEWS: Awkward positioning of MIDI ports. Price
tag means it’s for serious accordionists only.
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SoundSoap 2
EFFORTLESS AUDIO CLEANER

seconds of noise, just click on
the Learn Noise button and begin
playing the audio. The app then
takes a proﬁle of the noise and
automatically removes it from
the rest of the sound ﬁle. If the
noise doesn’t occur at the intro,
you can set in and out markers to
isolate the portion of the audio
that contains the noise, turn on
the Loop function, and have SS2
analyze that portion.
Once SS2 learns the noise,
you can click on the Noise Only
button to hear what SoundSoap
is trying to remove. If you hear
some of the desired audio, you
can turn the Noise Tuner to have
less of that (less desired audio
in Noise Only mode means more
desired audio in the cleansed
output). Once you tune it, you
can turn off Noise Only and use
Everything you need to clean audio is in this single window.
the Noise Reduction knob to
further suppress the noise. We found
audible on your PowerBook speakers,
oundSoap Pro (
Jan/05,
that this method, though not as precise
but you’ll certainly hear it on a quality
p42) does a great job of cleaning
as Pro’s, is more than adequate for most
sound system. All you have to do to get
audio and provides ﬁne-tuning controls
situations.
rid of it is click SS2’s Remove Rumble
for maximum tweakability. SoundSoap
SS2’s Enhance slider is handy when
button. You can probably guess what
2 costs $500 less, doesn’t require a
you’re working with audio ﬁles that
the Remove Click & Crackle slider
hardware key or a host application like
have been digitized from old tapes and
does. If you know how to identify these
records. Raising the slider increases the
problems, the ﬁxes are no-brainer
If you don’t use Apple’s
bass and treble without
simple, and the results are
Soundtrack Pro, you can get a
reintroducing noise that
quite good.
lot of value out of this $99 app.
SOUND AUDIO
has been removed. Used
Tougher stains. It
It’s best to record
sparingly, this yields
takes a bit more work
the Pro version does, and is easier to
audio with as little
pleasing results.
to get rid of broadband
use. Most importantly, it still does a ﬁne
noise as possible.
Apple’s new Soundtrack
noise (unwanted audio
job of cleaning audio.
Invest in a good-quality
Pro (included in the Final
that occurs throughout the
Audio noise comes in four distinct
microphone to get the
best results.
Cut Studio suite) offers
frequency spectrum), but
ﬂavors: hum, rumble, broadband,
similar noise-reduction
SoundSoap 2 still makes it
and the click and crackle caused by
tools, so Final Cut Pro 5
easy. Unlike SoundSoap Pro,
phonograph needles. Hum, rumble,
users may not need SoundSoap 2. If you
which uses a graphic equalizer–like
and click ’n’ crackle are the easiest to
don’t use Soundtrack Pro, however, you
interface for audio experts to ﬁneclean. Hum, which is caused by ground
can get a lot of value out of this $99 app.
tune noise reduction, SS2 uses only
loops in power lines, is easily removed
The bottom line. SoundSoap 2 is a
two knobs—Noise Tuner and Noise
by clicking on SS2’s 50Hz or 60Hz
superb bargain. While you don’t get
Reduction—to simplify the process. The
button (which one you use depends
the advanced tweakability of the Pro
results are surprisingly good.
on the country you live in; the U.S.
version, there’s a lot to like about SS2’s
SS2 starts by isolating the noise; if you
uses 60Hz). Rumble usually occurs in
simpliﬁed controls.—Andrew Tokuda
have an audio clip that begins with two
the 40Hz sound range; it may not be

TIP

S

COMPANY: Bias
CONTACT: 800-775-2427,
www.bias-inc.com
PRICE: $99

REQUIREMENTS: 400MHz G4; Mac OS 10.2 or later;
128MB RAM; 20MB disk space; host application that
supports Audio Units, DirectX, RTAS, or VST plug-ins, or
QuickTime 6.5 for standalone mode

GOOD NEWS: Great results. Easy to use.
No host application required. Great price.
BAD NEWS: Doesn’t have the flexibility of
SoundSoap Pro.
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Cheetah3D’s intuitive interface makes
advanced 3D editing about as painless as it
will ever get.

Cheetah3D
AFFORDABLE AND ABLE 3D-MODELING SOFTWARE

I

f the complexity of the tools and
techniques required to turn a virtual
lump of clay into an actual, recognizable
object has been keeping you from
serious 3D modeling, Cheetah3D might
be for you. This powerful software
will have you spinning out wildly
sophisticated 3D models faster than its
namesake chases down dinner—all for a
grand total of $69.
The most initially striking aspects
of Cheetah3D are its clean interface
and straightforward approach to 3D
modeling. You start by creating a basic
3D shape (such as a sphere, cube, tube,
or cone), and then use the plethora of
selection and reshaping tools to stretch,
squeeze, pull, and push that shape into
something completely different. The
three primary editing modes—selecting
individual control points, edges, or
polygon faces—allow you to precisely
pick the part of a shape you want to
work with. You can also start with 2D
spline-based objects, either drawn
inside Cheetah3D or imported as
Illustrator CS documents, and extrude
them or sweep them into 3D space. Each
action you perform is displayed as a
visual stack of commands in the main
editing window, and you can reorder
COMPANY: Cheetah3D
CONTACT: +49 9070 404,
www.cheetah3d.com
PRICE: $69
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REQUIREMENTS:
G3, Mac OS 10.3 or
later, 256MB RAM,
16MB VRAM

the stack to change what you’ve done.
Powerful stuff.
Advanced tools. The advanced
polygon-editing tools are surprisingly
powerful for a sub-$100 program. We
loved choosing a few polygonal faces
of a sphere and then creating instant
inset windows using the Inner Extrude
and Normal Move editing commands.
Making complicated shapes—from
spaceships to strange life-forms—is
an almost-effortless (and fun) task.
Object modiﬁers such as taper, bulge,
shear, twist, and displace let you for
distort and change an object’s shape
without explicitly changing the object’s
geometry. You can also easily create
hot-key commands for literally anything,

Cheetah3D’s interface is cleanly designed,
and the icons in the pop-up menus are
easy to understand.

a great way to speed up your workﬂow.
While Cheetah3D’s texture-mapping
abilities and procedural textures aren’t
as extensive as they are in comparable

offerings such as Eovia’s Carrera
(
May/05, p40) or Maxon’s
Cinema4D ($695, www.maxon.net),
they’re decent and potentially
extensible via Cheetah3D’s plug-in
architecture. Much of the rest of the
app can also be customized thanks to
great JavaScript support. Unfortunately,
the app offers little documentation on
customizing JavaScript; according to the
developer, that will be addressed in a
future release.
Once you’ve whipped up some 3D
monsters, Cheetah3D offers some
surprisingly potent rendering options,
including a decent ray tracer with
radiosity support (for greater realism
in rendered lighting and shadows),
multithreaded rendering (taking direct
advantage of that dual-processor Mac
you ﬁnally invested in), and HDRI (high
dynamic range image) support for IBL
(image-based lighting), a technique that
illuminates an image using a graphics
ﬁle instead of standard point lights
and spotlights (both of which are also
included in Cheetah3D). You can also
specify the amount of supersampling
and antialiasing for a scene; but you
can only render an image up to 2,048 by
2,048 pixels, which some digital artists
may consider a limitation.
We had good success exporting 3D
objects out of Cheetah3D into other
rendering apps, thanks to the extensive
(and also largely undocumented)
support for other 3D-ﬁle formats,
including DXF, 3DMF, and 3DS (all widely
supported by third-party rendering and
animation software).
The bottom line. While this version of
Cheetah3D lacks animation capabilities
(a version with animation is in the
works), that’s not a big drawback. Given
its power and effortless advanced
modeling (not to mention its low price),
we heartily recommend Cheetah3D to
aspiring 3D artists and anyone who
wants to make 3D with minimum effort
and maximum fun.—David Biedny

GOOD NEWS: Powerful, easy-to-use tools. Extensive modeling options. Decentquality built-in rendering with multithreading support. Bargain-basement price.
BAD NEWS: No animation. Texture handling could be better. Incomplete in-app
documentation.
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The interface makes it easy to apply
effects to your image in Eye Candy 5:
Nature.

speedy preview, but rendering is slow.
Snow Drift has a slow preview but a
reasonable render speed—a worse
scenario because you want to get an
idea of how your effect looks as soon
as possible. Also, the rendering in the
preview window can sometimes look
quite different than the actual end
result—not bad or unacceptable, just
different.
We had mixed feelings when it came
to the quality of the effects. Icicles
produces extremely realistic results
with reﬂections of surrounding color;
Corona is fun and easy to get lost in;
and Ripples nicely reﬂects colors from
your original image. On the other hand,
Smoke is merely average; and although
Fire works well on its own, when applied
HIT-OR-MISS SET OF PHOTOSHOP PLUG-INS
within an image that has no environment
to support the ﬂame (such as glowing
unlimited undo and redo, keyboard
lien Skin’s Eye Candy 5: Nature is
areas on a subject or blown-out areas at
shortcuts, and mouse-over help—all
a set of Photoshop plug-ins that
the heart of the ﬁre), the effect appears
great stuff.
add natural effects to your images—for
illustrated, not natural. Frankly, we were
The render. If you plan to use Nature
example, you can use Nature’s Rust
tempted to get the grill going out back
mostly for Web graphics and are working
ﬁlter to add a corrosive effect to a steel
and shoot our own ﬁre with a multiwith small ﬁles, Nature operates quickly.
sign. Nature delivers the effects that it
megapixel camera.
But for high-resolution graphics,
promises well, but some ﬁlters take a
Casual Photoshop users can have a
Nature’s rendering and previewing may
lot of time to apply—and sometimes the
ball with Nature—as long as your Mac
make you think twice before applying
time it takes just to get a preview will
has the juice to
test your patience.
handle the renders.
Nature has 10 effects: Corona, which
Web designers can
produces solar ﬂares; Drip, which
also beneﬁt, but only
creates a melting effect; Fire, which adds
a few of the ﬁlters
ﬂames to an image; Icicles, which adds
provide the kind of
stalactites and a glossy look; Ripples,
realism that print
like the kind you see when you drop a
professionals need.
pebble in a pond; the aforementioned
Nature needs to be
Rust; Smoke, as from a chimney; Snow
Some effects have
much more, well,
Drift, for adding snow to an image;
a nice impact, while
natural if it wants
Squint, for blurring an image; and Water
others may not give
to keep pace with
Drops, for that just-came-in-from-theyou the realism you
Hollywood-quality
rain look.
were expecting.
effects, and its speed
Nature’s interface is easy to
needs to be improved
understand—we were able to dive right
so that creative pros actually have the
in and play without reading up ﬁrst.
time to effectively put the effects to use.
Nature lets you render to layers so the
the plug-in—some ﬁlters preview
The bottom line. Nature is a clear
original image remains intact, and you
quite slowly and take time to kick in;
step forward in interface design, but
can toggle between the original and the
others run at acceptable speeds, but
it still needs some retooling to be fully
version with the effect in the preview.
then bog down come rendering time.
impressive.—Steven Parke
Nature also has a good gradient editor,
Squint (one of our favorites) has a fairly

Eye Candy 5: Nature

PHOTOGRAPHS BY STEVEN PARKE

A

COMPANY: Alien Skin
CONTACT: 888-921-7546,
www.alienskin.com
PRICE: $99

REQUIREMENTS: 500MHz PowerPC G3; Mac OS
10.2.6 or later; 256MB RAM; Adobe Photoshop 7
or later, or Adobe Photoshop Elements 2 or later, or
Macromedia Fireworks MX 2004 or later

GOOD NEWS: Fun effects. Easy to use.
BAD NEWS: Although some effects look real, some
don’t. Inconsistent preview and render performance.
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Backdrop Designer
PRODUCTIVITY-ENHANCING PHOTOSHOP PLUG-IN

W

ith a little bit of Photoshop
handiwork, you can make a dull
photo pop by adding a new background.
Digital Anarchy’s Backdrop Designer is
a Photoshop plug-in that lets you create
draped backgrounds—you may never
have to worry about shooting space and

manager that lets you create your
background pattern; a shadow manager
to adjust shadow opacity, blur, and
bend to simulate drapery folds; and a
Combine window that lets you combine
your texture and shadow settings, adjust
them with slider bars, and view the

With Backdrop Designer, you can mix and match textures and shadows to make
your own background drapery (above). You can also use the Bend controls (right)
to adjust the folds of your drapery.

overly frugal art directors again.
Backdrop Designer can be used with
Digital Anarchy’s Primatte Chromakey
(
May/05, p44)—a Photoshop
plug-in that performs masking (removing
a portion of an image that isn’t needed)
on any image shot against a solid
backdrop (blue and green, typically)—
but you can also use Backdrop Designer
on images you mask manually.
When you launch Backdrop Designer
from within Photoshop (Filter > Digital
Anarchy > Backdrop Designer), you enter
the easy-to-use Backdrop Designer
interface. The interface has a texture
COMPANY: Digital Anarchy
CONTACT: 415-586-8434,
www.digitalanarchy.com
PRICE: $199
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results. There are tons of possible
combinations—enough that we
could make it look like we rented
actual drapes for our photo shoot.
Also, the backgrounds are resolution
independent, meaning you can apply
your pattern to any foreground image
and it will automatically match the
resolution of the foreground.
Previews. When you tweak your
backdrop settings, the preview works
like a preview should—in real time. That
gives you the ﬂexibility to try different
settings to get just what you want. Plus,
the preview displays colors accurately

REQUIREMENTS: Mac OS X
or later, Adobe Photoshop 5.5 or
later, Adobe Photoshop Elements
2.0 or later

and gives you a true representation of
what the ﬁnal pattern looks like when
you render the background.
When you’re ready to apply a
background to an image, be prepared
for a lengthy rendering time if you’re
using the Best image-quality mode.
We rendered a 2,475-by-3,225pixel backdrop in 50 minutes
on a dual 1.25GHz Power Mac
G4—not too shabby considering
we were working in other apps
while Backdrop Designer did its
thing. Rendering in Normal mode
took about 25 minutes, and Fast
mode rendered in less than 10
minutes. Considering Backdrop
Designer’s great preview ability,
we can accept its render speed.
Leaving your Mac alone to
dedicate its processing power
to rendering will give you faster
results; but in a production
environment, chances are you’ll
need to work on other
things while Backdrop
Designer works in the
background.
Backdrop Designer
provides some unusual,
over-the-top palettes
and shapes that you’ll
probably never use, and
some effects look so
unnatural that they may
actually emphasize the
fact that your background
has been digitally added.
All in all, however, there are enough
backgrounds that closely emulate
natural fabrics, drapes, and light
sources to make this a useful plug-in.
The bottom line. Backdrop Designer
may be a one-trick pony—but it’s a
ﬁnely tuned, well-thought-through,
thoroughbred pony. This plug-in is a ﬁne
investment for serious photographers
and Photoshoppers.
—Steven Parke

GOOD NEWS: Easy to use. Cuts time from manually creating a
backdrop. Backgrounds are resolution independent. Real-time previews.
BAD NEWS: Render times can be lengthy. Some unnatural-looking
palettes.
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Command & Conquer
Generals: Zero Hour

Saves you from
your PowerBook
trackpad.

IMPROVED REAL-TIME STRATEGY GAME

C

COMPANY: Aspyr
CONTACT: 888-212-7797,
www.aspyr.com
PRICE: $29.99

REQUIREMENTS: 1GHz G4, Mac OS 10.2.8 or later, 256MB RAM,
32MB ATI Radeon 7500 or nVidia GeForce 2 MX video card or better,
2.8GB disk space, original Command & Conquer Generals game

GOOD NEWS: Great new units, buildings, and upgrades. More singleplayer variety.
BAD NEWS: Still can’t battle against PC players online. AI could be better.
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BTMicro
PORTABLE BLUETOOTH
MOUSE

S

ure, the updated scrolling
capabilities on the new PowerBooks
(see Reviews, May/05, p38) help make
using a trackpad more bearable, but
it’s hard to beat an actual mouse;
that’s why there are so many mini mice
on the market. Now there’s another
mouse joining the fray: Macally’s
BTMicro, a Bluetooth mouse that runs
on rechargeable batteries. While it may
be too small for big hands, it’s a nice
lil’ mouse that you can stash in your
PowerBook case.
The BTMicro has a range of 33 feet,
which is handy if you’re in a meeting and
need to do a Keynote presentation. It
tracks smoothly, its buttons are solid,
the scroll wheel works well, and its side
grips make it easy to handle.
Unfortunately, the BTMouse is
unusable while it’s snapped into its
recharging cradle. Other mini mice, such
as Iogear’s Bluetooth Mini Mouse
(
Apr/05, p44), charge their
batteries via USB so you’re still able to
use them.
The bottom line. As long as you don’t
mind packing the power adapter (which
is almost as big as the mouse) and
cradle, the BTMicro is a good mouse to
take on the road.—Roman Loyola
COMPANY: Macally
CONTACT:
626-338-8787,
www.macally.com
PRICE: $49.99

REQUIREMENTS:
Bluetooth-equipped Mac,
Mac OS 10.2.8 or later

GOOD NEWS: Good design. On/off switch. Comes
with rechargeable batteries.
BAD NEWS: Can’t use
mouse while it’s charging.

PHOTOGRAPHY BY MARK MADEO

some unique units that you don’t see
during normal play, which keeps things
fresh. For example, U.S. General “Ace”
Granger can’t use the Paladin tank (one
of our favorites), but he can command
a Comanche chopper (complete with
stealth mode), a carpet bomber, and
some other nasty surprises. Seeing
what each general has up his or her
sleeve and ﬁguring out a good strategic
response adds much-appreciated depth.
Zero Hour’s improved enemy AI
comes up with some
crafty surprises. We were
shocked when an American
opponent started building
multiple particle cannons—
a common tactic among
ﬂesh-and-blood players,
but something Generals’
previous AI would have
never attempted. Also,
enemies seem to build
more wealth-generating
buildings so they don’t run
out of money so easily.
Graphic performance has improved a bit, so you can enjoy
The AI is still far from
your Spectre gunship attacking enemy Chinese forces.
perfect. Foes often forget to
rebuild key buildings once you destroy
results. There’s also a new single-player
them. And instead of massing forces
campaign with 15 missions spread
for one giant knockout blow, the AI still
across the American, Chinese, and GLA
only sends only a few units at a time to
factions, but these missions bored us.
attack you. The new AI also seems to tax
They emphasize puzzles over strategy,
your Mac more than before. With three
and cheesy TV-news cut scenes (which
AI players on a big map, Zero Hour would
you can’t interrupt or skip) do more to
occasionally crawl on our dual 2GHz
annoy than help the story.
Power Mac G5; we didn’t have problems
The challenge. Zero Hour features
with the original game.
an interesting new game mode called
The bottom line. Zero Hour succeeds
the Generals Challenge, which lets you
at improving Command & Conquer
choose from nine generals and ﬁght
Generals’ single-player experience,
the others one at a time on a series of
adding extras that give the game a new
predetermined maps; it’s almost like a
lease on life.—Helmut Kobler
second campaign. Each general can use
ommand & Conquer Generals’ ﬁrst
mission pack, Zero Hour, builds on
the shoulders of greatness, adding new
maps and a few dozen units, buildings,
and delectable upgrades to one of our
favorite real-time strategy games.
You can now, for example, equip pricey
American planes with countermeasures,
build fake Global Liberation Army (GLA)
buildings as decoys, and use a slow-toreload but far-reaching Chinese cannon
to lob tactical nukes with devastating
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Restore your LP records, tapes and DVs –

Quickly & Easily!
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• Buffs out scratches from vinyl LPs
• Wipes out hiss, hum, and other
noise from tapes or DVs

• New Enhance leaves a ﬁne polish
• Tough on grime, yet gentle on
your signal

• Record or import audio into your Mac
• Edit and process your audio
• Create custom fade-ins and outs
• Assemble tracks in a playlist and
burn your own audio CD!

Discover for yourself how easy and fun they are to use.
Check out the demo on the MacAddict CD or visit
www.bias-inc.com/downloads/freetrials
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Chessmaster 9000
COMPREHENSIVE CHESS GAME
including 49 grand masters. (Gary
Kasparov is not included, and we’re
sure it has nothing to do with his recent
retirement.) Each personality has a
distinct style, so playing against the AI
never feels repetitive. You can also play
with other Chessmaster players online.
Tutorials. For beginners, there’s a
helpful classroom mode that teaches
you the basics, including what the
pieces are and how they move, plus
introductory strategy. There’s even
a discussion of
openings (the ﬁrst
few moves of a
chess match) and
an excellent library
where you can study
historic matches of
grandmasters—plus
not-so-grand
matches, including
Dr. Frank Poole’s
match against HAL
9000 from 2001: A
No, playing chess won’t make you as loopy as Bobby Fischer.
Space Odyssey.
Well, it probably won’t.
There are lots of
not to mention the chessboard itself.
in-game tools to improve your game, too,
While everything on the screen is
including the aforementioned Mentor
useful, Chessmaster thankfully allows
Lines, a Blunder Alert that tells you when
you to close the features you don’t
the move you just made might be a bad
want, open a different set of windows,
one (and suggests alternatives), a moveor get rid of everything to display only
advice option, an undo-move option,
the board. The default open windows
and a Game Analysis tool that examines
include a shortcuts windows with oneyour match and gives you feedback.
click buttons for game analysis and
The only major qualm we have is
move advice, a game status window
that the help system isn’t very helpful.
that tracks each move and tells you how
When we selected Help, we expected
much time you have left to make your
to ﬁnd instructions within the software
move, a window displaying captured
on how to use its features; instead,
pieces, a Visual Thinking window that
Chessmaster just launched a PDF of the
lets you look at potential moves, and a
game’s manual.
Mentor Lines window that suggests a
The bottom line. Yeah, we know that
series of moves for you.
a free chess game came with your Mac.
Chessmaster has 155 different
But for all you get with Chessmaster, the
personalities you can play against,
$40 is well worth it.—Roman Loyola
f you’re really into chess, stop playing
with Apple’s bundled Chess app.
Shell out the $40 and get Chessmaster
9000—it’s the chess game to get for the
Mac. Chessmaster has tons of features
for both beginners and experienced
chess enthusiasts alike.
When you dive into the actual chessmatch part of Chessmaster, you’ll ﬁnd
yourself faced with an overwhelming
interface full of separate windows,
numbers, buttons, and chess symbols—

COMPANY: Feral Interactive
CONTACT: +44 0 208 875 1375,
www.feralinteractive.com
PRICE: $40

REQUIREMENTS: 700MHz G3, Mac OS 10.2 or later,
256MB RAM, 1.3GB disk space, 16MB graphics card,
QuickTime 6

GOOD NEWS: Great for beginners and experts. Tons of features.
BAD NEWS: Game layout can sometimes feels crowded and
overwhelming. Help takes you to the PDF manual.

Radio Raheem wouldn’t be
caught dead with this boom box.

iBoom
CRAPPY iPOD BOOM BOX

H

ere’s what we like about the iBoom:
It lets you listen to your iPod
through battery-powered speakers, so
it’s portable. From there, it’s a rapid
downward slide—we can’t recommend
the iBoom to anyone.
Scratchy, distorted waves of sonic
mush emanate from the small speakers
encased in the iBoom’s cute—though
poorly assembled—enclosure. The iBoom
can get loud, but if you want bass, forget
about it. Treble response is also weak—in
general, iBoom’s audio lacks clarity.
There are no tone controls, and even with
the volume control turned all the way
down, the iBoom keeps playing audibly.
Foam feet. The iBoom’s ﬂimsy
foam-rubber footie strips hardly inspire
conﬁdence in the device’s durability;
neither does the cheap-looking felt
spacer that holds your iPod stable in the
designated slot. A separate plastic spacer
attachment lets you plug in an iPod mini,
but forget about using an iPod shufﬂe.
The FM radio is ﬁne, but we’ll use
Tivoli’s less-expensive Audio iPal
(
Nov/04, p50)—it tunes in AM,
too. Also, early versions of the iBoom
have electrical problems—if you leave the
batteries in the unit while the power cord
is plugged into the wall, the batteries
may leak acid and perhaps explode
(iBoom, indeed). Later generations of
iBoom have ﬁxed this problem.
The bottom line. We’ll skip the iBoom.
A better battery-powered iPod boom box
is sure to come along.—David Biedny
COMPANY:
Digital Lifestyle Outfitters
CONTACT: 866-800-4763,
www.dlodirect.com

PRICE: $149
REQUIREMENTS:
Third- or fourth-generation
iPod or iPod mini

GOOD NEWS: Charges iPod if plugged into AC outlet.
BAD NEWS: Lousy sound.
Bad volume controls. Batteries
may leak in early versions.
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distinct style, so playing against the AI
never feels repetitive. You can also play
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helpful classroom mode that teaches
you the basics, including what the
pieces are and how they move, plus
introductory strategy. There’s even
a discussion of
openings (the ﬁrst
few moves of a
chess match) and
an excellent library
where you can study
historic matches of
grandmasters—plus
not-so-grand
matches, including
Dr. Frank Poole’s
match against HAL
9000 from 2001: A
No, playing chess won’t make you as loopy as Bobby Fischer.
Space Odyssey.
Well, it probably won’t.
There are lots of
not to mention the chessboard itself.
in-game tools to improve your game, too,
While everything on the screen is
including the aforementioned Mentor
useful, Chessmaster thankfully allows
Lines, a Blunder Alert that tells you when
you to close the features you don’t
the move you just made might be a bad
want, open a different set of windows,
one (and suggests alternatives), a moveor get rid of everything to display only
advice option, an undo-move option,
the board. The default open windows
and a Game Analysis tool that examines
include a shortcuts windows with oneyour match and gives you feedback.
click buttons for game analysis and
The only major qualm we have is
move advice, a game status window
that the help system isn’t very helpful.
that tracks each move and tells you how
When we selected Help, we expected
much time you have left to make your
to ﬁnd instructions within the software
move, a window displaying captured
on how to use its features; instead,
pieces, a Visual Thinking window that
Chessmaster just launched a PDF of the
lets you look at potential moves, and a
game’s manual.
Mentor Lines window that suggests a
The bottom line. Yeah, we know that
series of moves for you.
a free chess game came with your Mac.
Chessmaster has 155 different
But for all you get with Chessmaster, the
personalities you can play against,
$40 is well worth it.—Roman Loyola
f you’re really into chess, stop playing
with Apple’s bundled Chess app.
Shell out the $40 and get Chessmaster
9000—it’s the chess game to get for the
Mac. Chessmaster has tons of features
for both beginners and experienced
chess enthusiasts alike.
When you dive into the actual chessmatch part of Chessmaster, you’ll ﬁnd
yourself faced with an overwhelming
interface full of separate windows,
numbers, buttons, and chess symbols—

COMPANY: Feral Interactive
CONTACT: +44 0 208 875 1375,
www.feralinteractive.com
PRICE: $40

REQUIREMENTS: 700MHz G3, Mac OS 10.2 or later,
256MB RAM, 1.3GB disk space, 16MB graphics card,
QuickTime 6

GOOD NEWS: Great for beginners and experts. Tons of features.
BAD NEWS: Game layout can sometimes feels crowded and
overwhelming. Help takes you to the PDF manual.
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Radio Raheem wouldn’t be
caught dead with this boom box.

iBoom
CRAPPY iPOD BOOM BOX

H

ere’s what we like about the iBoom:
It lets you listen to your iPod
through battery-powered speakers, so
it’s portable. From there, it’s a rapid
downward slide—we can’t recommend
the iBoom to anyone.
Scratchy, distorted waves of sonic
mush emanate from the small speakers
encased in the iBoom’s cute—though
poorly assembled—enclosure. The iBoom
can get loud, but if you want bass, forget
about it. Treble response is also weak—in
general, iBoom’s audio lacks clarity.
There are no tone controls, and even with
the volume control turned all the way
down, the iBoom keeps playing audibly.
Foam feet. The iBoom’s ﬂimsy
foam-rubber footie strips hardly inspire
conﬁdence in the device’s durability;
neither does the cheap-looking felt
spacer that holds your iPod stable in the
designated slot. A separate plastic spacer
attachment lets you plug in an iPod mini,
but forget about using an iPod shufﬂe.
The FM radio is ﬁne, but we’ll use
Tivoli’s less-expensive Audio iPal
(
Nov/04, p50)—it tunes in AM,
too. Also, early versions of the iBoom
have electrical problems—if you leave the
batteries in the unit while the power cord
is plugged into the wall, the batteries
may leak acid and perhaps explode
(iBoom, indeed). Later generations of
iBoom have ﬁxed this problem.
The bottom line. We’ll skip the iBoom.
A better battery-powered iPod boom box
is sure to come along.—David Biedny
COMPANY:
Digital Lifestyle Outfitters
CONTACT: 866-800-4763,
www.dlodirect.com

PRICE: $149
REQUIREMENTS:
Third- or fourth-generation
iPod or iPod mini

GOOD NEWS: Charges iPod if plugged into AC outlet.
BAD NEWS: Lousy sound.
Bad volume controls. Batteries
may leak in early versions.
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Solio
INGENIOUS iPOD CHARGER

O

ur iPods now have a near-endless
supply of power thanks to
Solio, a portable solar-powered iPod
battery charger. Solio itself contains a
replaceable Lithium Ion battery that you
charge with sunlight or through a poweroutlet connection. After Solio’s battery
is charged, you simply attach it to your
iPod and your iPod battery will recharge.
When folded, Solio measures 4.72
by 2.56 by 1.34 inches. When unfolded,
Solio is like a ﬂower in bloom, with solar
panels on each of the three petals. It’s
rather fetching in a geeky way, and
you can use the included suction-cup
mount that ﬁts in Solio’s center hole
to mount the device on a window. Our
only gripe about the design is that when
COMPANY: Better Energy Systems
CONTACT: +44 0 870 607 6546,
www.solio.com
PRICE: $99.95

REQUIREMENTS:
iPod, sunlight

folded, one of the
solar panels remains
exposed—we’d hate to
scratch it up.
Sun power. Better
Energy Systems says it
takes eight to 10 hours
to fully charge Solio;
it took us about eight
hours. When you press
Solio’s nifty indicator light,
it blinks to relay the Solio’s
power capacity by blinking. Each
blink represents a 25-percent increment;
one blink means 25 percent, two blinks
mean 50 percent, and so on.
To charge your iPod, you connect
Solio to the iPod’s Dock connector

Sunny delight
for your ’Pod.

using the included charging cord.
(Unfortunately, the iPod-cable
connector isn’t labeled, so make
sure to check that its slotted self
matches Solio’s input port when you
try to connect.) Our testing showed
that it takes about the same amount
of time to fully charge your iPod with
Solio as it does with a Dock. You can
also leave Solio open and in the sun
while charging your iPod to keep your
Solio fully powered.
The bottom line. Solio is a nearperfect iPod companion. You won’t be
caught with a lifeless iPod again.
—Roman Loyola

GOOD NEWS: Excellent design. Can also charge from outlet power.
BAD NEWS: Folded compact form still leaves a solar panel exposed. iPodcable connector lacks labeling for proper insertion.

Drive Genius
COMPLETE DISK-UTILITY SOFTWARE

P

rosoft’s Drive Genius lives up to its
name by providing comprehensive
disk-repair tools and performanceenhancing defragmentation routines
to keep your Mac’s drive in tip-top
condition.
Drive Genius’s brushed-metal
interface features three separate
panes. Eight tools lie along the bottom
of the interface, ranging from the
straightforward Repair and Defragment
options to the less-useful (but far more
dangerous) Sector Edit, a tool that
performs surgery by directly editing disk
data. If you’re squeamish, stay away
from that particular digital scalpel.
More tools. Other tools include a
useful Duplicate feature that can make
a bootable clone of your hard drive.
Because Duplicate does a bit-forbit copy, it’s a lot faster than using
COMPANY: Prosoft Engineering
CONTACT: 925-426-6100,
www.prosofteng.com
PRICE: $99 (single-user license), $249

Finder operations. The
Shred function overwrites
everything on your hard
drive with gibberish, using
an overwrite standard
more rigorous than what
the Pentagon demands.
Integrity, Benchtest, and
Scan tools provide ancillary
services by testing the
health of your hard drive.
Benchtest tells you how
fast and efﬁcient your drive
is, and Scan marks faulty
physical sectors.
Reliable repair, defragmentation, duplication—and so on,
If you use Drive Genius
and so on, and so on.
to maintain a secondary
drive, you can run Drive Genius from your
Genius CD. Also, there’s no RAID support.
startup disk; but if you want to do any
The bottom line. Drive Genius
repair work or operations on the startup
deserves a space in your Mac toolkit.
disk, you need to boot from the Drive
—Mark Sparrow

(unlimited-user license)
REQUIREMENTS:
Mac OS 10.2 or later

GOOD NEWS: Bootable CD. Includes defrag routines.
Nondestructive repartitioning. Handles all non-RAID drives. Fixes
disk permissions.
BAD NEWS: Must boot from CD to work on startup disk.
July 2005
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Photo to Movie 3.2
HELPFUL PHOTO-EFFECTS SOFTWARE

W

hen we last checked out Photo to
Movie (
Jun/03, p53),
we found a slick app that could pan and
zoom over still photos, primping them
for digital video—a technique called the
Ken Burns effect. The latest PtM remains
true to its origins but adds many new
features. Big deal? Absolutely.
You can now give your photos more
context with PtM’s new title support;
to place a title, simply drag it to your
photo. You can also access QuickTime
transitions such as Crossfade, Zoom, and
Iris. Adding an audio ﬁle is as simple as
dragging and dropping. Need narration?
Record directly into PtM, ﬁne-tune the
sound’s timing within the timeline, and
adjust the volume. PtM also has a media
browser for iPhoto and iTunes.
COMPANY: LQ Graphics
CONTACT: http://lqgraphics.com
PRICE: $49.95

iMovie companion. If you’re
wondering why you’d need Photo
to Movie when both iMovie and
iPhoto slideshows offer Ken
Burns effects, Photo to Movie
does have its advantages,
such as more complex, movielike controls; for example, you
There’s more to Photo to Movie than just pans
can start a pan from the left
and zooms.
side, stop at the right side, zoom
output in iMovie (or Final Cut) to reap
in, pause, zoom out, and then pan back
superior production values.
to the left. In iMovie and iPhoto, each
What’s missing? You can’t layer titles
step is a separate effect, so you’d have to
or sound; so you can’t, for example,
kludge together multiple clips or multiple
record narration over a soundtrack
copies of the same photo in order to get
unless you do so in another app.
the same result. Even though you may
The bottom line. Photo to Movie
not be able to see the difference in the
makes you a master of the Ken Burns
ﬁnal output, you’ll appreciate PtM’s ease
effect.—Tom Lassiter
of use. You can then use Photo to Movie’s

REQUIREMENTS: 400MHz
G4, Mac OS 10.2 or later,
256MB RAM

GOOD NEWS: Easy to use. More flexible than iMovie’s Ken
Burns effect.
BAD NEWS: No support for layers in titles or audio.

WireTap Pro
VERSATILE SOUND RECORDER

W

ireTap Pro records sounds made on
your Mac. Sounds simple, but here
are a few things we did with WireTap Pro:
recorded a Wilco concert streamed via
RealPlayer from the NPR Web site (www
.npr.org), saved it in AIFF format, and
added it to our iTunes library; captured
Andy Kershaw’s show on BBC Radio 3
(via the BBC Radio Player, which is built
on RealPlayer) in MP3 format and burned
it to a CD; and grabbed every evening
broadcast of a local radio show streamed
via the Windows Media Player and put it
on an iPod for drive-time listening.
A slew of settings. WireTap Pro’s
Preferences and Audio Settings let you
pick a sound source (Mac Audio Output
for recording sounds from your Mac, or
Microphone/Line Input for recording via
mic or digitizing your old vinyl), where to
COMPANY: Ambrosia Software
CONTACT: 585-325-1910,
www.ambrosiasw.com
PRICE: $19.99
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save the recording,
and what format to
save it in (MP3, AAC,
AIFF, or QuickTime
Movie). After choosing
your settings, you
simply click the Record Don’t miss your favorite streaming radio—use WireTap Pro to
button in the ﬂoating
record it and listen to it later!
control window. If you
broadcast over your car stereo. Also,
have settings you want to reuse, you can
while changing System Preferences >
save them as Recording Sessions that you
Sound > Output Volume doesn’t change
can start with a single click or schedule
the volume of the recording, changing
with iCal. You can even have a Session
the output volume of the app you’re
open a Web site or run an AppleScript
recording from does—we had to rerecord
before or after recording.
a concert after making that mistake.
The only problem we ran into is that
The bottom line. If you listen to audio
WireTap Pro captures every sound your
streams on your Mac that you wish you
Mac makes. So be careful how you
could hear again, WireTap Pro will save
use your Mac while it’s recording; it’s
them for posterity.—Jake Widman
a bit disorienting to hear an alert beep

REQUIREMENTS: Mac OS 10.2
or later

GOOD NEWS: Unobtrusive and capable. Captures and saves
any sound your Mac can make.
BAD NEWS: Can’t record sounds from only a specified app.
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Visual Thesaurus 3
MERITORIOUS WORD-REFERENCE APP

W

e liked Visual Thesaurus 2.0
(
Oct/03, p59), but now
that we’ve seen VT3, we’re not sure
how we lived without some of its new
features. For example, VT3 now includes
audio pronunciations—click the audio
icon next to a word to hear it pronounced
in either American or right-honourable
British English. You can also display both
American and British spellings.
Our faves. The new spelling checker
saved us from referring to a dictionary,
and the new Back and Forward navigation
buttons quickly returned us to home base
after capricious linguistic adventuring.
Results for versatile words such as run
tended to overrun our screen, but we
were able to automatically narrow our
search of word relationships and even
COMPANY: Thinkmap
CONTACT: 212-285-8600,
www.visualthesaurus.com
PRICE: $29.95 (Desktop), $19.95 per year (Online)

hide the meanings bar
(Command-M) to open
up more space.
Other attributes
that enhanced our
engrossment: 26
preset key commands,
plus four new (albeit
Find the function at conjunction junction.
initially enigmatic)
such as Mumbai, did.
word relationships. Our persnickety
VT3 is not perfect. History, Word
side appreciated proper nouns being
Suggestions, and Settings menus are
properly capitalized (this wasn’t the
awkward and too narrow to easily access
case in version 2) and the addition of
with your cursor; and the Settings panel
more proper nouns. Some words and
expands and retracts without alacrity.
meanings recently added to the Oxford
The bottom line. Visual Thesaurus 3
English Dictionary (such as mongo,
is one of the most stylish, truly useful
meaning “useful items from the trash”)
reference tools we’ve encountered.
didn’t make the 145,000-word cut, but
—Jenifer Morgan
names and terms of greater signiﬁcance,

REQUIREMENTS:
Mac OS X or later, 128MB
RAM, 100MB disk space

GOOD NEWS: New spelling checker includes alternate
spelling suggestions. Audio pronunciation. Keyboard
shortcuts.
BAD NEWS: Some awkward interface elements.

iFlicks 1.1
iTUNES-LIKE MOVIE ORGANIZER

W

hile iFlicks is a capable tool for
viewing your video ﬁles, you won’t
necessarily want to use it as a production
assistant for your iMovie or Final Cut
projects. Think of it more as iTunes for
the video clips on your hard drive.
iFlicks maintains a library of your
video ﬁles. You add videos by dragging
your video ﬁles into iFlicks. iFlicks then
copies or moves your videos to its own
iFlicks video folder; it can also track an
alias if you want to store the video in
another location. You conﬁgure iFlicks’
settings in a very iTunes-like (iTunesian?)
way, making column categories and
managing preferences for you iFlicks
folder and default video players.
Can’t capture. iFlicks is designed with
existing digitized video in mind; there
are no capturing tools. You can watch
COMPANY: Helixent Technologies
CONTACT: www.helixent.com
PRICE: $29.95

a video from within iFlicks
by double-clicking a clip. If
the clip has been digitized
using a codec other than
QuickTime (such as Windows
Media), you need to have a
compatible player installed.
iFlicks will launch that player
whenever it’s needed.
It’s iTunes—but for video.
A video clip’s vital
single dialog.
statistics are presented in an iTunesSince there’s no iFlicks Movie Store,
like (iTunesque?) interface, which can
iFlicks grants you access to NetFlix.
display information about a clip’s play
iFlicks uses your RSS feed from NetFlix
length, year, genre, and more. You can
to display your queue, but you have to
create Collections, which are like iTunes
go to the NetFlix Web site to actually
playlists, as well as Smart Collections
manage your queue.
that automatically add clips based
The bottom line. For basic video
on your criteria. Unfortunately, unlike
management, iFlicks is good enough.
iTunes, you can’t select a set of clips
—Roman Loyola
and edit common information in a

REQUIREMENTS:
Mac OS 10.3 or later

GOOD NEWS: iTunes-like interface is easy to use. NetFlix
organizer is helpful to NetFlix members.
BAD NEWS: Can’t edit common info of multiple files at one time.
No video-capture capability. No interaction with iLife apps.
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HD300

A

fter using MPIO’s HD300, we have
renewed appreciation for the iPod.
While the HD300 has a few features
that the iPod doesn’t, when it comes to
simply listening to music, the iPod wins.
The HD300’s iPod-ian size, 20GB
hard drive, blue backlit 2-inch LCD, and
16-hour rechargeable battery stack up
nicely against the ’Pod. Like many nonApple digital music players, the HD300
ups the ante with an FM tuner and a nifty
recorder capable of capturing MP3 audio
from the tuner, its built-in microphone,
or an external device connected to the
HD300’s headphone jack. The recorder
works well; sound is clear and crisp, and
we like being able to set the recording bit
rate from 96 to 192 Kbps.
Thumb slide. The HD300’s diamondCOMPANY: MPIO
CONTACT: 858-554-1300,
www.mpio.com
PRICE: $279.99

la iTunes (songs are
shaped control pad
drag-copied over to
combines touchthe HD300 via USB).
sensitive controls
Without playlists,
for menu and ﬁle
browsing by genre,
navigation and
artist, album, or
clickable areas (the
title is completely
pad’s four sides)
nonfunctional. Don’t
for play/pause,
have a PC? You’re stuck
forward/back, and
rummaging through
record functions. The
your entire music
center of the pad is a
collection for those
thumb-scroll strip for
tracks you’re dying to
navigation. However,
Clickwheel? Yes. Thumb-scroll
hear. Not good.
both of the HD300s we
strip? Maybe.
The bottom line.
looked at had buttons
The HD300 is a bit lighter on your
that didn’t respond consistently.
pocketbook than a 20GB iPod, but you’ll
There’s also no Mac version of MPIO
be better off spending the extra cash to
Manager, the software utility needed
get Apple’s offering.—Gil Loyola
to create playlists based on ID3 tags, à

REQUIREMENTS: USB-equipped
Mac, Mac OS 9.2 or X or later

GOOD NEWS: FM tuner. Audio recorder.
BAD NEWS: Unresponsive touch controls. Windows-only utility.

ShutterBug
PAGES-LIKE WEB-AUTHORING TOOL

X

traLean’s ShutterBug is a consumerlevel Web-authoring tool for quickly
posting photo albums on the Web. If
you’re HTML-phobic, don’t worry—you
won’t need to write a single line of code.
Shutterbug’s interface is divided
into two sections. The Content section
is where you write your page title and
description, add or delete pages, and
add a copyright watermark. It’s also
where you assemble your images by
dragging them from wherever they are
stored—you can even drag a picture
directly from iPhoto into ShutterBug.
The Browser section lets you format and
preview your Web site. Both sections
are easy to navigate and understand,
but the way it handles text is annoying.
When you’re in the Browser section, you
COMPANY: XtraLean Software
CONTACT: www.xtralean.com
PRICE: $34
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can’t edit your text; you have to
switch back to Content to make
your changes, then switch back to
Browser to preview the site.
Templates. ShutterBug’s
approach to page design is
similar to Apple’s Pages. You
can choose from the 16 bundled
templates or download more from
http://support.xtralean.com and
import them into ShutterBug.
Just don’t trash the downloaded
ﬁle—you can’t add an imported
Basic tools for basic Web photo albums.
template to ShutterBug’s template
library. Annoying.
XtraLean’s forums for tips and tricks.
You can also build templates yourself,
The bottom line. ShutterBug makes
but XtraLean doesn’t supply help
creating a Web photo album easy as
documentation yet (the company says
pie—without putting a big dent in your
it’s coming soon). In the meantime, check
wallet.—Roman Loyola

REQUIREMENTS: Mac OS 10.3.4
or later, Web host for your Web site

GOOD NEWS: Easy to use. Good online support forums.
BAD NEWS: Needs more documentation. Can’t add templates
to library.

PHOTOGRAPH BY MARK MADEO

TOUCHY, FRUSTRATING MP3 PLAYER
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Burning Monkey Mahjong 2
MERRY MAHJONG GAME
ick of solitaire? Try some solitary
mahjong—Burning Monkey Mahjong
2 puts a humorous twist on this simple,
calming, and addictive game.
Mahjong involves pairing and removing
tiles from a pile. The goal is to make the
entire stack of tiles disappear in as few
moves and as little time as possible. To
make tiles disappear, you must click two
identical ones; however, if a tile is sitting
underneath or between two tiles on the
left and right, you can’t remove it until you
remove the obstructing tiles.
One of the coolest features of Burning
Monkey Mahjong 2 is its 3D-ness—you
can activate a 3D mode that causes the
game board to tilt as you move your
mouse, allowing you to see your tile
stack from different perspectives and
COMPANY: Freeverse
CONTACT: 212-929-3549,
www.freeverse.com
PRICE: $24.95

get a sense of depth. Although the
constant movement of the board
can be annoying, we ultimately
found this feature helpful. There
were plenty of times we couldn’t
ﬁnd matching pairs just by
The tilting board lets you look at your tiles in a
looking at the board straight
whole new way.
on; but when we tilted it, we were
able to spot pairs we couldn’t before.
from the traditional pyramid layout.
Variety. Mahjong Solitaire offers
Burning Monkey Mahjong 2 offers some
silly humor as well. Different monkey
different varieties of gameplay and ﬁve
characters hang out in the corners and
difﬁculty levels. Other games include
pipe in with cornball quips such as, “What
Tile Pickup, where the goal is to pick
do you get when you cross a cow and
up all the tiles as fast as possible—no
some ducks? Milk and quackers!” Ha!
matching required—and Memory, which
The bottom line. Burning Monkey
is like Concentration. Although the
Mahjong is a cheerful game that will
extra games are welcome, they’re all a
have you playing longer than you
bit lackluster. There are also more than
expect.—Cathy Lu
70 ways the tiles can be stacked, aside

REQUIREMENTS: Mac OS 10.2.8
or later, 64MB RAM, 60MB disk
space, 16MB VRAM

GOOD NEWS: Simple yet fun. Includes a good dose of humor.
BAD NEWS: Game variations are boring. Tilting game board can
get annoying.

MicFlex

BENDABLE MICROPHONE

M

acMice’s MicFlex is a ﬂexible microphone that
connects to your Mac via USB. It’s great for iChat AV
and acceptable for casual GarageBand recording.
The MicFlex extends 18 inches from its solid, heavy
base—you have lots of freedom to position the
MicFlex just the way you want it. The ﬂexible
tubing is strong and can take lots of twists and
turns without kinking. Plus, it comes with a 5-foot
USB cable.
The MicFlex uses a 16-bit, 48KHz audio-conversion
circuit. We found the sound quality to be quite good;
though if you’re recording GarageBand audio, you’ll need to
keep ambient noise to a minimum to make sure you get the
best sound for your song.
The bottom line. The MicFlex isn’t a studio-quality
piece of recording equipment, but
for forty bucks, you get a pretty darn
A mic you
good microphone.—Roman Loyola
can step up to.
COMPANY: MacMice
CONTACT: 615-822-9270, www.macmice.com
PRICE: $39.99
GOOD NEWS: Solid base. Bendable yet firm
flex arm.
BAD NEWS: Not a replacement for a studioquality microphone.

REQUIREMENTS: USB-equipped Mac,
Mac OS 9.1 to 9.x or 10.1 or later

mini Skirt: glo

SOOTHING MAC MINI STAND

T

he mini Skirt: glo is a stand for the Mac mini that
provides 0.75-inches of lift. It also emits a blue or white
glow (depending on which model you buy) when you plug it
into your USB port—and that’s about it.
Since the Skirt is USB powered, you’re left with a single
USB port on your mini for your peripherals. If you supplement
that with a USB hub, make sure you get
a powered one—the USB ports
on your keyboard don’t
provide enough power for
some hardware, such as
many ﬂash-based thumb
drives.
The bottom line. We can’t
think of any practical use for
the Skirt, but it will give your
Mac mini that special glow.
Your Mac mini wants a glowing
—Roman Loyola
booster seat.
COMPANY: Plasticsmith
CONTACT: 800-394-3774,
www.plasticsmith.com

PRICE: $39.95
REQUIREMENTS: USB-equipped Mac mini

PHOTOGRAPH BY MARK MADEO

S

GOOD NEWS: Gives your Mac mini a
soothing glow.
BAD NEWS: No USB hub to replace
the USB port it occupies.
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theHotList
better living through smarter shopping
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THE BEST OF THE BEST FROM RECENT REVIEWS

SOFTWARE

ONTH
NEW THIS M

AUDIO
Ableton Live 4

$499.00

Jan/05, p43

This top real-time sequencer now has improved MIDI powers.

Bias SoundSoap Pro

$599.00

Jan/05, p42

Got noise in your video? Here’s the app to clean it up.

Native Instruments Reaktor 4

$559.00

Jun/04, p56

If you can imagine a sound, you can create it with this synth.

Aspyr Call of Duty

$49.99

Sep/04, p52

This shooter has tons of action, detailed locales, and fun.

Aspyr Doom 3

$49.99

Jun/05, p48

Hellish, scary fun—but not for the faint of hardware.

Blizzard World of Warcraft

$49.99

Apr/05, p40

This rich online role-playing game is more addictive than nicotine.

MacSoft Halo: Combat Evolved

$49.99

Mar/04, p38

It’s as awesome as your Xbox buddies say it is.

MacSoft Unreal Tournament 2004

$39.95

Jun/04, p48

The best ﬁ rst-person shooter adds new vehicles and weapons.
More features and easier navigation make layout a snap.

GAMES

GRAPHICS & LAYOUT
Adobe InDesign CS

$699.00

Feb/04, p46

Adobe Photoshop CS

$649.00

Feb/04, p44

Just when you thought Photoshop couldn’t get better, it did.

$89.99

Mar/05, p36

Adobe’s affordable image editor gets a signiﬁ cant upgrade.

Corel Painter IX

$429.00

Feb/05, p38

This natural-media champ is now faster and more capable.

Macromedia Dreamweaver MX 2004

$399.00

Jan/04, p48

Our favorite Web-design tool adds improved CSS support.

Strata 3D CX

$695.00

Dec/04, p43

Whether you’re a 3D newbie or expert, this app’s for you.

Bare Bones Software BBEdit 8.0

$199.00

Jan/05, p36

By far the most powerful text editor money can buy.

FileMaker Pro 7

$299.00

Jul/04, p46

Microsoft Ofﬁ ce 2004

$399.00

Aug/04, p42

$699.00

Sep/04, p46

This upgrade is strong enough to be called version 7.

$75.00

Feb/05, p39

Join the VJ ranks with this MIDI-capable video-mixing software.

Apple AirPort Express

$129.00

Oct/04, p48

This portable wireless router will stream your iTunes music.

Canary Wireless HS10

$59.95

Apr/05, p44

This device ﬁ nds hotspots and reports on network status.

Adobe Photoshop Elements 3.0

Aspyr Doom 3

Inveterate gamer Niko Coucouvanis calls
the terrifying and technologically imposing
Doom 3 “hands-down the best-looking game
we’ve ever played.”

PRODUCTIVITY & UTILITIES
A complete rewrite vaults this database into the big leagues.
Enhancements to every app add up to a worthy upgrade.

VIDEO & ANIMATION
Adobe After Effects 6.5
Vidvox Grid2

If you want to effortlessly stream
different tunes to different rooms,
here’s how. Audiophile Alan Graham
calls the Sonos “the most impressive
music device … since the iPod.”

Sony DRX710UL-T

The latest iMacs and Power Macs have
double-layer DVD burners—but if you’re not
upgrading, follow
Reviews Editor
Roman Loyola’s
advice and get “a
signiﬁcant speed
boost” from this one.

HARDWARE

Sonos Digital
Music System

ACCESSORIES

palmOne Treo 650

$999.00

Aug/04, p38

High-end features distinguish this mid-priced camcorder.

Native Instruments Guitar Rig

$499.00

Nov/04, p40

Killer software plus a sturdy stomp box will wow any guitarist.

Sonos Digital Music System

$1,199.00

Jun/05, p36

Pricey, yes—but it’s the best music streamer you can buy.

$129.99

Nov/04, p50

You won’t believe the sound of this compact radio and speaker.

Canon PowerShot A85

$299.99

Mar/05, p40

This 4-megapixel point-and-shoot beauty takes great pictures.

Nikon D70 Digital SLR

$1,299.00

Jul/04, p50

It’s as close to perfect as any digital SLR camera we’ve seen.

Tivoli Audio iPal

DIGITAL CAMERAS

PRINTERS
Canon i560

$89.99

Sep/04, p28

Ninety bucks can buy an exceptionally capable photo printer.

Canon i860

$119.99

Sep/04, p29

This printer’s Photo Black cartridge makes color photos pop.

Canon i900D

$199.99

Sep/04, p31

Gorgeous prints, CD printing, color-LCD editing—all good stuff.

SCANNERS
Epson Perfection 2580

$149.00

Oct/04, p37

This ﬂ atbed handles both reﬂ ective and ﬁ lm scans with ease.

Epson Perfection 4180

$199.99

Oct/04, p39

Superior image quality earns this scanner our recommendation.

Microtek ScanMaker i320

$119.99

Oct/04, p35

Killer photo-rescue software comes with this affordable unit.

STORAGE
ILY SlimDVDup

$699.00

Apr/05, p45

Quickly duplicate CDs and DVDs without tying up your Mac.

LaCie Big Disk Extreme 500GB

$429.00

Aug/04, p55

Cutting-edge technology provides cutting-edge performance.

LaCie d2 DVD±RW Double Layer

$179.00

Feb/05, p48

Cram 8.5GB of data onto DVDs with this speedy burner.

OWC Mercury Pro DVD-/+RW

$159.99

Aug/04, p60

This speedy drive includes everything you need to start burning.

Sony DRX-710UL-T

$229.95

Jun/05, p46

This double-layer burner has scorching single-layer performance.

$1,299.95

Aug/04, p59

This internal 4-drive RAID makes a Power Mac G5 scream.

WiebeTech TrayDock

July 2005

It’s the best PDA-and-cell-phone combination on the market.

Canon Optura Xi

WiebeTech G5Jam 1TB
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$599.00 May/05, p44

AUDIO & VIDEO

$169.95 May/05, p49

This slick hard-drive enclosure provides the ultimate in ﬂ exibility.

The fastest way to learn
a language. Guaranteed.
™

Finally, a different approach that has millions of people talking. Using the
award-winning Dynamic Immersion™ method, our interactive software teaches
without translation, memorization or grammar drills. Combining thousands
of real-life images and the voices of native speakers in a step-by-step immersion
process, our programs successfully replicate the experience of learning your
first language. Guaranteed to teach faster and easier than any other language
product or your money back. No questions asked.

Spanish

(Latin America or Spain)

English
(US or UK)

French
Italian
Portuguese

German
Russian
Chinese

Japanese
Indonesian
Vietnamese

Award-winning software successfully used by
U.S. State Department diplomats, Fortune 500®
executives and millions of people worldwide.

Thai
Arabic
Korean Hebrew
Hindi
Greek

Turkish
Danish
Swahili

Polish
Welsh
Dutch

Swedish
Pashto
Latin

Each fully interactive course includes:
• CD-ROM curriculum with 20 activities in each of 92 lessons
• Previews, comprehensive exercises and testing for each lesson
• Automated tutorials that “learn” where you need extra help
• Curriculum Text and 45-page User's Guide

Step-by-step immersion instruction in all key language skills:
Listening - Rosetta Stone uses native speakers and
everyday language to develop your understanding of
the spoken language naturally and easily.

SAVE

10%

Reading - Text exercises develop your reading
skills by linking written language to real-life objects,
actions and ideas.
Speaking - Speech-recognition feature records,
diagrams and compares your voice to the native
speaker's, grading your pronunciation.
Writing - Dictation exercises evaluate your spelling,
syntax and punctuation.

Level 1 Program
Regularly $195.00

Level 2 Program
Regularly $225.00

Level 1 & 2
Regularly $329.00

BEST VALUE!
Your Price

$175.50

Your Price

$202.50

Your Price

$296.10

Personal Edition. Solutions for organizations also available.

“...your program is the absolute best, bar none. I am
shocked at how quickly I learn.”
- Michael Murphy
Texas, USA
“Stupendous...the juxtaposition of text, sound and picture
was masterful. The quality of both sound and graphics
was first rate.”
- The Boston Globe

Call today or buy online
for a 10% discount.

RosettaStone.com/mas075
1-800-399-6162

Use promotional code mas075 when ordering.
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MACLESS SHUFFLE

GET YOUR OWN
Does an iPod shufﬂe work on multiple
computers like a regular iPod does?
No, the iPod shufﬂe is much more
single-Mac oriented than other iPods.
After ﬁlling a shufﬂe with songs from
one Mac, plugging that shufﬂe into any
other Mac pops up a dialog offering
to wipe out the shufﬂe’s songs and
ﬁll it from the current Mac—you can’t
browse or play the shufﬂe-bound songs
via iTunes as you can with other iPods
that you’ve set up for manual music
management. This also means you can’t
plug your shufﬂe into a buddy’s Mac to
add some of his tunes to your collection,
but if you’ve enabled the shufﬂe’s disk
mode (iTunes > Preferences), it’ll mount
on strange Macs as a USB storage
volume.

iTunes will either assimilate your shufﬂe
or ignore it completely.

I bought an iPod shufﬂe for a friend
who doesn’t own a computer (don’t
ask!). Is there a way that she can keep
it charged without having access to a
Mac’s USB port?
Yes there is, and it comes from our
friends at Apple (www.apple.com). Plug
your shufﬂe into an iPod USB Power
Adapter ($29), and then plug the adapter
into any wall outlet. Sorry, but we have to
ask: You bought her that weird Sexohol
LP-on-ashufﬂe (www
.sexohol.com),
didn’t you ?
Freak.
You’ll never
want to get
these two off
your shufﬂe.

MINI MONITORS
Can I connect a new Mac mini to my old
Performa monitor? How about a TV?
The Mac mini supports more video
options than you might expect. Out of
the box, you can plug any standard DVI
display right into it, or you can use the
supplied adapter with a VGA display.
But wait, there’s more: Get an Apple DVI
to Video Adapter ($19, www.apple
.com) to connect a Mac mini to a TV or
overhead projector. If you have one of
last year’s Cinema Displays with an ADC
connector, you’ll need the Apple DVI to
ADC Display Adapter ($99, www.apple
.com). Lastly, if you wish to use an old
Apple CRT like the ones that came with
most Performa models, you’ll need a

Mac DB-15 male to HD-15 female VGA
adapter, which Grifﬁn Technology sells
under the name Mac Connect ($16,
www.grifﬁntechnology.com).

BEFUDDLED FONTS
When I use Safari to view certain Web
pages, the text becomes garbled,
generating characters that resemble
some long-lost language. What gives,
and what can I do?
This is most often caused when Safari
can’t ﬁnd the appropriate font and
tries to render the text with incorrect
font and character information. This
happens most frequently when you
use a font manager such as Suitcase
($99.95, www.extensis.com) to
keep your fonts in order. Such fontmanaging utilities can automatically
activate fonts that the System and
Safari are already using, which can
lead to font corruption and garbled
text. The easiest remedy is to disable
automatic activation (in Suitcase, go
to Suitcase > Preferences > Activation).
Garbled text can also indicate that
your font cache has become corrupt.
To ﬁx this corruption, download and
install Font Finagler ($10, shareware,
http://homepage.mac.com/mdouma46/
fcache/fcache.html).

We don’t need no steenking autoactivation.

CLICK RIGHT

MAÑANA, BANANA
How do I type an ñ, señor?
You could ﬁre up the Character Palette
(check Show Input Menu In Menu Bar
in System Preferences > International >
Input Menu). Alternately, press Option-N
then N to create an ñ. Option-E then O
makes an ó; Option-E then E makes an é.
52
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What’s this “right-click” mouse
function my peecee pals are always
gloating about?
Your power-mousing friends are
talking about the handy pop-up menu
summoned by clicking a button on the
right side of a PC mouse. Mac OS has
had a similar trick—the Contextual
Menu—since Mac OS 8, though you
access it by holding down the Control
key while clicking. Bonus: Every
multibutton mouse we’ve tried with Mac
OS X brings up the Contextual Menu
when you right-click.

This is a
right, er,
Controlclick.

.MOV MADNESS
I can’t view movies in Safari, though I
used to be able to. What’s up with that?
Among the many reasons that this could
happen, the most common is that you
have your plug-ins disabled in Safari.

DIFFICULTY
RATINGS

No whining—
anyone
can do this!

FEED YOUR PC
I have a Mac and a PC both connected
to the Internet with a cable modem and
router. How do I swap ﬁles between the
two computers?
If you can ﬁgure out how to set up ﬁle
sharing on your PC (consult your PC’s Help
& Support Center via the Start menu),
connecting from a Mac running OS X is
simple. Choose Go > Connect To Server
from the Finder’s menu bar, and then
click the Browse button. If you’ve set
up the PC correctly, you will see an icon
representing it in the resulting Network
window. Double-click the icon and enter
your PC’s login information, and then
help yourself to the ﬁles. The reverse is
also possible; open System Preferences >
Sharing and check the box next to
Windows Sharing. Use your regular Mac
OS X user name and password to log in
from your PC’s Network Neighborhood.

It’ll take some
effort, but you
can do it.

UNIX UNIVERSITY
SU IS AS SUDO DOES
What is the difference between su and sudo?
Mac OS X’s Unix core is all about multiple
users and their individual privileges
and permissions to use ﬁles, services,
applications—pretty much anything
on your Mac. As a user on a Mac, you
have full rights to your documents,
settings, and everything in your user
(Home) directory, but you may not have
permission to change settings or access
ﬁles that are owned by other users or
by the system itself. Su and sudo are
your master keys to accessing those

Don’t let the absolute power of root
corrupt your morals.

PCs can access your Mac’s ﬁles.

ENTRY-LEVEL AUDIO
What’s the best microphone for recording
music and singing with GarageBand?
If you’re serious about your sound, you’ll
want two mics: one for vocals and one
for instruments. Two of our favorites
come from Shure: The SM57 Instrument
Microphone ($158, www.shure.com)
and the SM58 Vocal Microphone ($188).

QuickTime movies require a plug-in in
order to work. Open Safari > Preferences,
select the Security tab, and make sure
the Enable Plug-ins check box is checked.

Safari plug-ins only work if they’re enabled.

53

HOW TO

This stuff’s
for the pros.

Both are solidly built and reasonably
priced. Before you put away your wallet,
however, be prepared to shell out for
another key piece of gear: a pre-amp
to boost your mic up to a suitable level
for your Mac to record. M-Audio’s twochannel Audio Buddy ($119.95, www
.m-audio.com) is a ﬁne choice. If you
haven’t guessed, audio recording can
get very expensive very quickly—the
mics and pre-amp mentioned here are
relatively inexpensive.

THREADED MAIL
I use Apple’s Mail program to access my
email; how can I view the messages in
related groups?
This feature of Mail in Mac OS 10.3
(Panther) and later is called threading,
and it is indeed very useful. To enable
this feature in Mail, choose View >
Organize By Thread. Mail will now show
your messages grouped by threads with
a small disclosure triangle on the left
side to open and close the threads.

pesky user permissions;
su stands for “substitute
user identity,” so if you open a Terminal
window (/Applications/Utilities) and
type su root, then enter the root
password at the prompt, you get carte
blanche to execute any command—no
matter how disrespectful to other users
or detrimental to the system. Sudo is
like a shortcut to su. Typing sudo before
another Unix command invokes the
root user by default, prompts you for an
administrator password, and executes the
command directly. You can also modify
sudo to invoke one of the Mac’s other
users. Type sudo –u rmyslewski, for
example, and you can execute commands
as user rmyslewski—but you’ll also
need his password. In most cases, sudo
is quicker and easier (and, naturally,
more dangerous), but in either case, use
extreme caution.

SLUMMING IT
Is it possible to connect to a PC from my
Mac and actually control the PC like I
control my Mac?
Believe it or not, this capability is built
into Windows, and it even works from
a Mac. To make a PC submit to your
Mac’s will, ﬁrst download a copy of
Microsoft’s Remote Desktop Connection
Client for Mac (free, www.microsoft.
com/mac; just click the Other Products
link on the left). This software will let
you access a networked PC running
Windows XP Pro or Windows 2000
Server and load its desktop on your
Mac’s, giving you full access to the
PC’s applications, documents, images,
movies—everything. Come on, show that
PC who’s boss!
Buz is a graphic designer living in
Florida. He has been a devoted Mac
user for over 10 years and has worked for
both Apple and Power Computing.

Submit

technical questions
or helpful tips directly
via email (askus@macaddict.com) or c/o
MacAddict, 150 North Hill Dr., Ste. 40,
Brisbane, CA 94005.
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take charge of iChat

Take Charge of iChat
by Dan Pourhadi
WHAT YOU NEED
Amuse yourself with
custom backgrounds.

Mac OS 10.3 or later ($129, www.apple.com)
iChat 2.1 or later
iChat account (free, www.mac.com), .Mac account ($99
per year, www.mac.com), or AIM screen name (free,
www.aim.com)
Friends (optional, but recommended)
Annoy your friends
with custom smileys.

S

o you lack the bandwidth (or the beauty) to avail
yourself of the multiparty video chats in Tiger’s iChat
(see “Taming Tiger,” p12). Don’t fret; Apple’s free
instant-messaging app has plenty of tricks for the
iSightless, the bandwidth challenged, and IM purists who like
their chat light, quick, and free of intrusive audio and video
noise. Whether you’re using the brand-spankin’-new iChat 3.0
or good ol’ iChat 2.1, we’ll show you how to make the most of
your chat sessions—customize the heck out of it, send ﬁles
and screenshots, troubleshoot connection problems, and tailor
custom alerts for all your iChat buddies.

1

Set Up and Status, Gladys

If you’re new to iChat, click the iChat Dock icon to
launch the app (or ﬁnd it in your Applications folder),
and follow the setup-dialog prompts, beginning with your
name and AIM (AOL Instant Messenger) or .Mac account
information. No account? No problem. Just press the Get An
iChat Account button to sign up for a 60-day trial of Apple’s
.Mac service, which includes an iChat account that you can
keep using after the trial period ends. We’ll get into the
customization later, but for now, open Preferences (iChat >
Preferences); in the General pane, click the box labeled Show
Status In Menu Bar to grace your Mac’s menu bar with an
always-there iChat status icon, from which you can access
your Buddy list, change your online-status display, initiate
chats with your Buddies, and more—whether you have iChat
running or not.

Adding the iChat Status Icon to your menu bar signiﬁcantly
lubricates your iChat experience.
54
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Fix your ﬁrewall and set
buddy-speciﬁc alerts.
Drag ﬁles
here to share.

Unlock iChat’s advanced features and watch your productivity soar.

2

Clear the Path

If you use OS X’s ﬁrewall, launch System Preferences >
Sharing and click on the Firewall tab; to enable
messaging on your local network, check the box labeled iChat
Bonjour (or iChat Rendezvous in OS 10.3.x) to open ports 5297
and 5298. If you also want to chat with friends outside of your
local network, click the New button, select the Port Name
pull-down menu, choose Other, go to the Port Number box,
and type 5060, 5190. (Note that you can bypass the preset and
enter all four numbers here; just separate each number with a
comma and a space.) In the Description ﬁeld, type something
descriptive, like iChat.
Fixing a hardware router’s ﬁrewall is trickier, but doable; start
with your router’s user manual (unless you already know how to
conﬁgure the ports). All you need to do is open ports numbered
16384 through 16403 for UDP (User Datagram Protocol) and TCP/
IP trafﬁc. And if you plan to take the risk of killing your ﬁrewall
(software- or hardware-based) to get around the ritualistic port
dance, know this: We’ve heard anecdotes about how enabling
the ﬁrewall and opening ports got iChat working when it wouldn’t
with no ﬁrewall enabled.

Poking port
holes in the
ﬁrewall is pretty
painless.
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3

Customize Conversations

To pretty-up your conversations, click on the Messages
tab in iChat’s Preferences. There, you can customize
the background, text color, and font that appear in your word
bubbles. Great, but how’d we get that custom background image
in our iChat window? With a chat window open, select View > Set
Chat Background from the menu bar, then navigate to any image
on your hard drive. You can also change the window background
by simply dragging an image ﬁle into iChat’s main window.
You can further customize iChat with a handful of third-party
add-ons. iChat Smileys 2.5.1 (free, www.lemacenligne.com), for
example, adds an abundance of great-looking smileys, such as
a scary ninja and an inexplicably cute cyclops. iChatStatus 1.2.1
(free, www.ittpoi.com/
ichatstatus), allows you
to quickly automate your
status message; iChat 2.1
users can set their status to
display the title of the song
currently playing in iTunes,
for example (a feature that’s
built into iChat 3).
iChat can accommodate your
fondness for pretty colors,
fancy fonts, and smileys.

5

File Transfer à la iChat

Aside from your own illustrious thoughts, you can send
just about any kind of ﬁle off on the IM highway by
using one of several methods. The ﬁrst: Select a Buddy from
your Buddy List; then select Buddies > Send File from the menu
bar, navigate to the ﬁle you want to send, and your buddy will
receive a message asking if he or she would like to accept the
transfer. Alternately, you can send a ﬁle by simply dragging
it from the Finder to the text-entry box of a chat window or by
dropping it directly over a buddy’s name on the Buddy List.
Bonus: Select iChat > Services > Grab > Screen from the menu bar
while you have a chat
window open to grab a
screenshot and deposit
it in iChat’s text box.
This ﬁle contains
indisputable proof that
Kirk is cooler than Picard.

COMMUNICATIUS INTERRUPTUS

As slick as iChat is, it’s occasionally plagued with problems:
random crashing, missing buddies, and generic AIM errors,
for example. For the most part, simply relaunching iChat can
solve such problems. A quicker ﬁx is to use Command-L to
quickly log out and back into the AIM server. But don’t get
carried away; too many quick login/logout cycles can cause
the AIM servers to lock you out for about 15 minutes.

4

Take Action, Buddy

iChat’s best trick is Buddy Actions; this lets you set up
and customize alerts to notify you when any of your
buddies perform a particular action. For example, you can tell
iChat to play a sound or speak a certain phrase when a Buddy
logs in and shows up on your Buddy List. The advantage of this,
of course, is that you don’t have to constantly watch your Buddy
List if you’re looking for someone special—just set up the Action
to watch for you. To set up Buddy Actions, select a buddy from
the Buddy List and press Command-I, or select Buddies > Get Info
from the menu bar. Select
Actions from the drop-down
menu and conﬁgure the
alerts to your liking. Note
that these are separate from
the global alerts you can
set (via iChat > Preferences >
Alerts) to occur when any
Buddy logs in. Slick!
Why pay attention when you
can borrow some of iChat’s?

6

Log Your Life

Ever have that moment when you wished you could
remember what that person told you about that thing
at the place that what’s-his-face mentioned? Yeah, we all do.
Thanks to the miracle of chat logging, you can recall everything
you—or anyone you’ve ever talked to—have ever said in an
iChat conversation. To start saving this blackmail fodder, select
iChat > Preferences from the menu bar, click the Messages tab,
check the box labeled Automatically Save Chat Transcripts,
and pick a destination folder in the resulting dialog. iChat will
save all your chat sessions as separate iChat-readable ﬁles.
On its own, iChat lacks any way to manage and search through
the logs. For that, we turn to a program called Logorrhea (free,
www.spiny.com/logorrhea). Its straightforward interface makes
it easy to search
through all of your
saved conversations.

logorrhea n.
1. Pathologically
excessive (and often
incoherent) talking.

For help with speciﬁc problems, be sure to check out
Apple’s iChat support page, as well as the iChat discussion
forums. Chances are, your iChat problem isn’t unique and
even has a simple solution.
• iChat Support: www.apple.com/support/ichat
• Apple Discussions (forums): http://discussions.info
.apple.com

Dan Pourhadi spends more time talking to people on iChat than he does
face to face. Way more.
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create a dashboard widget

Create a Dashboard Widget
by Niko Coucouvanis

WHAT YOU NEED
Mac OS 10.4 or later
($129, www.apple.com)

W

hat’s in a widget?
Once you peel
one off Tiger’s
Dashboard and
dig into its .wdgt
bundle, you’ll see that a widget is
actually a mini Web page. Just as
a Web designer uses HTML, CSS,
and JavaScript to jazz up Web
Mac OS 10.4 is here—bring on the widgets!
pages, savvy widget wranglers can
add dynamically updated information
applications, and even system-level
from other servers on the Internet; they
resources.
can build elaborate
If that scares or confuses you, then
ON THE
mini-apps with
you missed the point: Anyone can make a
DISC embedded plug-ins
basic widget with the examples, samples,
Faux Fire widget
that access local files,
and documentation that Apple provides

1

Learn by Example

The best way for aspiring developers to learn the
widget-making basics is by example, and Apple provides
examples aplenty. Since you’ve installed the Xcode Tools,
those examples are waiting for you in /Developer/Examples/
Dashboard in two folders: Sample Widgets and Sample Code,
the latter of which contains the guts of each widget (HTML,
CSS, and JavaScript ﬁles, plists, and images for your ediﬁcation
and repurposing). Some of the samples are just pieces you can
build into your own widgets, but the one called Blank Widget
is the perfect starting point—a blank template onto which you
can glom your own widget. Make a copy of that entire folder for
backup, and dig in.

It’s cleverly hidden, but Apple provides a blank widget to get you
started.
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with Tiger. We’ll show you where to
find them, but before we get ahead of
ourselves, make sure you’ve installed
Mac OS 10.4 (Tiger); then install the
Xcode Tools package that came on your
Tiger installation disc.

Widget Anatomy 101

All of a widget’s basic information lives in an HTML ﬁle.
Most widgets use some JavaScript and CSS (cascading
style sheets) to spice things up—JavaScript for the advanced
functionality, CSS for the pretty dressing. If you know you want
to go that route, Apple suggests you create separate CSS and JS
ﬁles and then reference them within the HTML on the main page
(see screenshot).
Apple provides exhaustive information in the Dashboard
Programming Guide (/Developer/ADC Reference Library/
documentation/AppleApplications/Conceptual/Dashboard_
Tutorial) and the Dashboard Reference (/Developer/ADC
Reference Library/documentation/AppleApplications/
Reference/Dashboard_Ref), but for now, help yourself to the
code in the Blank Widget and other Sample Widget folders.

Welcome to your widget—just add content!
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Build a Background

Not only will a proper background keep your widget from
blending into the Dashboard background, it will also
enable your widget to work at all. Fire up Photoshop Elements
or your image editor of choice, and create a new ﬁle big enough
to ﬁt your content (we’re using Photoshop Elements, but you
can easily adapt our steps for your image-editing app). To follow
along as we create our mongo time-waster, enter a width of 450
and a height of 322 in the New File dialog. Select Transparent
from the Background Contents menu.
To make a nice, soft-edged background like the ones Apple’s
widgets have, activate the Marquee tool, select the Circular
tool from the Tool Options bar, and enter 5 in the Feathering
ﬁeld. Now click in the document window, drag to form an oval,
and use the Paint Can tool to ﬁll it in with whatever background
color you desire. Next, select the Gradient tool, click near the
center of the ﬁll, and drag the tool toward the edge. If you don’t
like the results, choose Undo (Command-Z) and try again until
you’re happy. Choose File > Save or Command-S to save your
background. In the Save dialog, select PNG from the Format
pulldown. Name the ﬁle Default.png and save it in your Blank
Widget directory,
replacing the
Default.png that’s
already there. (You
have a backup of
the original Blank
Widget directory,
remember?)

Select the Radial
Gradient tool (top)
and pick your colors
(bottom left).

5

Put the Gist in Your Plist

The info.plist (property list) ﬁle tells the Dashboard
server important info about your widget, including
the widget’s name, key ﬁles, and sizing information. Since
we’re calling our widget Faux Fire instead of Blank Widget,
we’ll change the plist accordingly. Change any instance of
Blank Widget to Faux Fire (or whatever you want to call your
widget) as shown in the screenshot. Note that widgets appear
in alphabetical order in the Dashboard bar; since you can’t
move them, name your widget accordingly if you want a certain
placement on the bar.
You may also want to add some new property keys to the
widget’s info.plist ﬁle (you’ll ﬁnd them in the Dashboard
Reference document mentioned above); we had to include the
AllowInternetPlugins key in order to make our Flash-based
widget work.

The Plist Editor makes short work of hacking your plist.

4

Mini-Size It

Your widget is also gonna need a sexy little icon to ride
in the Dashboard’s widget bar. The icon should probably
match the widget’s overall look, so we’ll use the background
we just made as a basis. Select Image > Resize > Image Size, and
in the resulting dialog, check the Constrain Proportions box at
the bottom. To make your icon ﬁt perfectly in the Dashboard,
make it an 82-by-82-pixel square; since our background is wider
than it is tall, set the Width to 82 pixels and click OK—Elements
will adjust the height to ﬁt. Next, select Image > Resize > Canvas
Size, change the Width and Height pull-down menus to Pixels,
and then enter 82 in the Height box—this will square up your
icon’s invisible background so it lines up smartly with your other
widget icons in the widget bar. Place the anchor in the middle to
center your icon in its 82-pixel frame, and click OK. Select the
Text tool and add a compelling (and short!) title so it’s not just
a blank blob in the Dashboard dash, then save the ﬁle in your
widget directory as Icon.png.

Set the anchor
to center your
image on
the canvas
so it looks
correct on the
Dashboard.

6

Hack Out the HTML

The main HTML ﬁle is the backbone of your widget, and
that BlankWidget.html ﬁle is ready to serve you—just
drop in a picture of your dog, a Flash ﬁle, a QuickTime movie,
or whatever. Here’s a little secret: Making a real (that is, useful)
widget, such as an iTunes controller, requires some serious
coding in order to link Web-friendly technologies such as
JavaScript to machine-friendly Objective-C.
Rename your HTML ﬁle as you named it in info.plist and keep
it open—we’re about to show you how JavaScript and CSS can
enhance your widget by adding the traditional corner resizer.

Most anything that Safari can handle will play in a widget;
we embedded a Flash ﬁle into ours.
July 2005
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7

Crib the CSS and Jack the JavaScript

Blank Widget already contains starter JavaScript and
CSS ﬁles, plus the hooks to pipe their magic into your
widget’s HTML ﬁle. Adding standard widget elements, such
as the resize corner, is as simple as ﬁnding the appropriate
snippets of JavaScript and CSS in the Dashboard Programming
Guide (DPG) and working them into your widget’s ﬁles. To get
the code, ﬁnd Resizing in the Dashboard Programming Guide’s
contents, click on it, and then click on Live Resizing. Cut and
paste the appropriate snippets into your HTML, CSS, and JS
ﬁles—the DPG’s directions are crystal clear. Save the ﬁles with
names to match your HTML ﬁle (in our example, FauxFire
.css and FauxFire.js), and change the HTML ﬁle’s @import and
JavaScript source tags (see screenshot in step 2) to match.

8

Suss It in Safari

Since widgets are like little Web pages, it stands to
reason that they’ll run in Safari. And they do—for the
most part. Widgets use a unique JavaScript element (the Widget
Object, naturally) for manipulating widgets’ windows in ways
that Safari doesn’t support, but otherwise, Safari is a handy
way to preview your widget during development. With your
widget bundle open (Control-click on a widget and select Show
Package Contents), double-click on the FauxFire.html ﬁle (or
whatever you named your widget) or drag it onto the Safari icon
in the Dock. Now bask in your widget’s glorious design—or note
what needs ﬁxing.

You can load widgets
in Safari, but superadvanced ones such as
the iTunes controller
don’t fully function in
that environment.

Keep your HTML
manageable
by referencing
external scripts
and style sheets.

9

Do the Dashboard Debug

Dashboard’s secret Developer mode lets you liberate
any widget from the Dashboard interface and use it on
your Mac without launching Dashboard—it’s super handy for
debugging widgets or just keeping your favorite widget always
visible. To unlock this magic, open the Terminal (/Applications/
Utilities), type defaults write com.apple.dashboard
devmode YES, press Return, and close the Terminal. Now
relaunch Dashboard by logging out (Apple Menu > Log Out user
name) and logging back in. Double-click your widget to load it
into Dashboard, then click on it and drag the mouse a little while
pressing your Dashboard toggle key (F12 unless you changed
it via System Preferences > Dashboard & Spotlight). This brings
your widget to the foreground, where it ﬂoats above any Finder
or application windows while the rest of the Dashboard and
widgets stay hidden. As you modify your widget’s source ﬁles,
simply click on the widget and press Command-R to reload it and
see the changes. Bonus: Check out the cool screen effect when
it reloads. You can use the same Terminal command to return
Dashboard to regular mode: Just substitute NO for YES.

10

Just Add .wdgt

We know you’re aching to hear what kind of chickenblood voodoo or other ritual it takes to turn a folder
full of Web documents into a bona ﬁde Dashboard Widget. Sorry
to disappoint, but it’s as easy as this: Simply click on the widget
folder’s icon, and press Return to make the title ﬁeld editable.
Now for the magic: Add .wdgt to the end of the folder’s name.
Tiger turns it into a widget for you.

Four little letters
package your
widget into an
application
bundle.

11

Archive For Delivery

Getting your widget out to the Dashboarding masses
is just as simple. Once you’ve packed it up into a
bundle with the .wdgt extension, edit the name ﬁeld again and
delete that .wdgt you just added. Now Control-click your widget
and select Create Archive Of from the Contextual Menu to wrap
it in a Zip archive; put that Zip ﬁle on your Web site and spread
the word. Now when someone downloads yourwidget.zip (and
if they’re using the Safari Web browser), the
ﬁle will automatically unzip itself and deposit
the widget in the user’s (not the system’s)
Widget folder.
Zip it up tight for delivery and automatic
installation.
Our ﬁreplace (ﬁnd the Flash ﬁle in the Faux Fire bundle on the Disc)
ﬂoats on the desktop thanks to Dashboard’s Developer mode.
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Niko Coucouvanis was not harmed during the making of this howto—just severely humbled.
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Ease into Photoshop Elements
by Niko Coucouvanis
WHAT YOU NEED
Photoshop Elements
($89.99 retail, $79.99
download; www.adobe
.com) or Photoshop CS
($599, www.adobe.com)

Quick Fix: Enter
Elements’ easy
mode.

Tool Options: This bar
changes to provide options
for whatever tool is selected.

Tool-palette alternates:
Clicking-and-holding some
icons reveals alter egos.

G

ot Photoshop?
Unless you’re
working in a
professional
Photo Bin: Find all of
printing or publishing
your open images here.
environment, you probably
don’t need the advanced
features in Photoshop
proper. Read on as we show
you the best tricks of its
If you don’t need channel masking or CMYK support to sate your Photoshop jones, Elements does just ﬁne.
little brother, Photoshop
Elements, including quick-and-easy photo ﬁxing, powerful batch
masking like a pro. And just because we like you, we’ll also
processing, and a crop of area-selection tools that’ll have you
throw in some tips for speeding up Elements’ performance.

1

Easy-Cheesy Photo Fixer

Elements’ main ﬂaw is one that it shares with its big,
expensive sibling: an overwhelming array of features and
functions. However, Adobe offers Elements users a user-friendly
alternative with its Quick Fix interface. If you want to improve
your images and you don’t know white balance from white noise,
just open your image in Elements and click the Quick Fix button
at the right side of Elements’ top menu bar. Pow! Elements’
interface dumbs itself down to two simple palettes: The one on
the left contains the Zoom, Hand, Crop, and Red-Eye Removal
tools; the one on the right contains tabs for General Fixes,
Lighting, Color, and Sharpen. Each section provides a slider you
can tweak back and forth to get the exact amount of adjustment
you want, but the Auto button, which applies Elements’ default
correction, provides good-enough results in most cases.

Sometimes
the Smart
Fix Auto
button
is all you
need—the
proof is in
the beforeand-after
preview.

2

Six Ways to Select

You probably know the Lasso tool—it’s been around
forever. What you might not know is that you don’t have
to go through a tedious, wrist-wrecking exercise of precision
edge tracing every time you want to use it. If you click and hold
the Lasso’s icon in the Tools palette, you’ll reveal two smarter
Lasso modes: the Magnetic Lasso and the Polygonal Lasso. To
use the Magnetic Lasso, simply click once to start the selection,
then follow the edge of what you’re selecting with your cursor
until you come full circle. The tool automatically ﬁnds points
of contrast and anchors the selection according to your Edge
Contrast (the degree of contrast that you consider an edge) and
Frequency (how often points are added to the selection path)
settings in the Tool Options bar. You can also add points at
will by clicking the mouse. For selecting more straight-edged
items, select the Polygonal Lasso—it draws a perfectly straight
selection path until you click to indicate a corner, at which point
you can draw straight out at any angle. To ﬁne-tune the selection
area, choose the Selection Brush
from the Tool palette and use
the Tool Options bar to specify a
shape and size for the brush; in the
Mode pop-up, choose Selection or
Mask to increase or decrease the
selection area.
The Magnetic Lasso sniffs out the edge
for you. Apply some feathering before
slapping on the ﬁlters.
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3

Fly Through Filter Effects

Though the Filter Gallery isn’t new, we bet you’re not
using it—and you really should be. Use the selection
tools described in step 2 to isolate part of an image you’d like to
tweak, or choose Select > All (or Command-A) to select the entire
image. Now select Filter > Filter Gallery to load Elements’ (and
Photoshop’s) best-kept secret. Select whatever ﬁlter you desire
from the center column, and the corresponding ﬁlter-speciﬁc
controls load up in the right-side pane. There, you can adjust
all of the ﬁlter’s parameters, such as Detail and Smoothness for
the Chrome ﬁlter. But wait, there’s more! You can also use the
Gallery to layer effect on top of effect: Just click the New Layer
button at the bottom of the layer list before adding new effects.
And don’t forget to feather the edge of the selected area to
smooth the transition around the ﬁltered area; with the selection
tool enabled, enter a value (up to 250 pixels) in the Tool Options
bar’s Feather box.

4

Batch Processing 101

Photoshop’s recordable Actions rock. They let you
reapply an identical process on multiple photos or even
record multiple steps in sequence for use on similar photos,
thus saving mucho time. Elements has a similar trick for basic
ﬁxes: Process Multiple Files. Say you’ve just ﬁlled a 1GB ﬂash
card with RAW-format images. You could preview them via
Elements’ File Browser (File > Browse Folders), but the File
Browser gets bogged down easily. Instead, launch Elements
and select File > Process Multiple Files; in the resulting dialog,
navigate to the folder of images you want to process, specify
where you want to save the processed output, and ﬁll in the
remaining boxes to set up the actions you want to perform. You
can resize, rename, convert ﬁle types, apply the Quick Fix tools
(Auto Levels, Auto Contrast, Auto Color, and Sharpen), and
even label the photos with a watermark or caption. Elements
warns you that it will overwrite your original ﬁles if you click the
box to deposit processed ﬁles in the original source folder.

Elements
makes
batch
processing
much less
painful.

We gave our sky a combo Chrome and Photocopy look. We put each
effect on its own layer, just in case we decide we hate it later.

SPEED IT UP, ALREADY!

Elements has a bad habit of falling into a near coma when you
start pushing around too many pixels, especially when you’re
using large-size ﬁles with loads of layers. Here are a few tricks
to speed things up.

FEED IT MORE MEMORY Open Photoshop Elements >
Preferences > Memory And Image Cache, and adjust Elements’
memory usage—we pegged ours to the maximum available
RAM (because we’re greedy).

LOSE SOME LAYERS Efﬁcient layer hygiene keeps Elements
relatively snappy, so when you’re
through with a layer, merge it with
the background. To do this, turn
off other layers by
clicking their eye
icons, then select
Layer > Merge
Visible.

BEAT THE FILE BROWSER INTO BEHAVING In Elements’
Preferences dialog, select File Browser from the pull-down
menu. If you’re browsing a fat folder full of images, turn on
Allow Background Processing to speed up the Browser—just be
aware you’ll pay the speed price while editing images. If snappy
performance while editing is your goal, leave the background
processing off; also be sure to uncheck High Quality Previews.

Fewer layers leads to less lag.

WRANGLE WAYWARD WINDOWS Don’t you hate it when a
window gets trapped behind the upper toolbars and you can’t
see the control buttons or even grab the title bar to drag the
window back into place? Give it up; you’re not going to free it
that way. Set things right with Window > Reset Palette Locations.

TIP: Easy Makeover
Elements’ slick new Red-Eye Removal and Spot Healing tools are righteously easy to use—just select
the tool, then click ’n’ drag over the eyeball or blemish you want to ﬁx. It’s really that simple.
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Switching from Photoshop
CS to Elements was a
monumental moment for Niko
Coucouvanis.
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Snoop Your Home Network
by Alex Handy
WHAT YOU NEED
Mac OS 10.3 or later
Xcode Tools 1.2 or later
(free with free registration,
http://developer.apple.com/
tools/macosxtools.html)
X11 (free, www.apple.com/
macosx/features/x11)
Fink 0.7.1 (free, www.ﬁnk
.sourceforge.net)

TIME When the
packet came in

SOURCE Where the
packet came from

DESTINATION Packet’s
intended destination

PACKET LIST All the info moving
over your network shows up here.

XTERM Ethereal’s own little
command-line terminal

I

t’s eleven o’clock: Do you know
where your wireless network
is? Hackers, crackers, and
bandwidth-borrowing neighbors
might be browsing your home
wireless network right now! On the
premise that knowledge is power,
we’ll empower you to monitor your
network with
ON THE Ethereal, a serious
DISC tool for network
Fink 0.7.1
security.

1

PACKET DETAILS Incomprehensible
information about the selected packet

PACKET BYTES How the selected
packet looks to your Mac

Gather the Goods

Ethereal is one of those free Unix apps we’re always crowing
about; as such, you’ll need to lay some groundwork before
you can use it. The ﬁrst thing you’ll need is Apple’s developer tool kit,
Xcode Tools. If you bought the retail version of OS 10.3 or 10.4, Xcode
Tools came with it. Otherwise, download it from Apple’s Developer
Connection Web site (http://connect.apple.com). After registering (for
free) as a member, proceed to the download page and get the latest
version of Xcode. To install the package, double-click the Developer
.mkpg ﬁle and follow the onscreen prompts. When you get to the
Installation Type screen, press the Custom button, and check the box
labeled X11 SDK in the resulting dialog.
Grab X11 (free, www.apple.com/macosx/features/x11) and Fink (on
the Disc, or download from http://ﬁnk.sourceforge.net). Follow the
included installation instructions, and restart your Mac.

2

PROTOCOL Packet’s
transmission protocol

You need almost 700MB of software to complete this how-to,
including the easily overlooked X11 SDK.

Fire Up Fink and Get Ethereal

Now there’s just one more installation, but Fink handles
this one for you—you just need to be connected to the
Internet. Launch Terminal (/Applications/Utilities) and type
fink install Ethereal at the prompt. Read or ignore the quick
bit of feedback that appears in the Terminal window. When
the prompt asks if you want to continue, type Y for yes, press
Return, then go grab a cheeseburger—this installation is gonna
take a while.
Ethereal wants to install a bunch of oddly named items. Just nod
politely and walk away.
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OK, time to play Unix geek. X11 is a graphical user
interface (GUI) for running Unix apps—apps that you
usually control via a command-line interface (CLI) such as the
Mac’s Terminal. So in order to get at Ethereal, you need to ﬁre
up X11 ﬁrst—ﬁnd it in /Applications/Utilities and double-click
the X11 application icon. X11 launches with its own little CLI,
the xterm window, in front. Type sudo Ethereal and enter your
password when it asks—you have to use the sudo command
here to invoke root-level access because Ethereal needs access
to the inner workings of your Mac’s networking hardware.

Thanks to X11, this is
the only command-line
know-how you need to
run Ethereal.

5

Start Sniffing

Reality check: Snooping around the ether can get you in
big trouble if you’re doing so around a network that’s not
your own. So limit your use of Ethereal to monitoring your own
network for intruders foraging for your personal information,
freeloaders ﬁlching your Internet access, and forkheads trying
to disrupt your service just for the fun of it.
OK, back to the fun; select Capture > Start from Ethereal’s
menu bar. In the resulting dialog, select en1 (for AirPort) from
the Interface pull-down menu. Proceed to the Capture File(s)
section to choose a ﬁle in which
to dump all the information you
gather. Click the Browse button and
navigate to a suitable directory,
then type bob.txt or a similarly
suitable ﬁle name. Ethereal will
automatically create this ﬁle.
Click OK to return to the Capture
Options, where you can ignore the
remaining choices and click OK to
start snifﬁng.
It ain’t pretty—but it’s pretty
powerful.

7

Pick a Peck of Packets

Now determine your own IP address by launching
Network Utility (/Applications/Utilities); click the Info
tab and select your active network interface from the pull-down
menu (remember, en1 for AirPort). Jot down the IP address that
appears under Interface Information—you’ll use it to see which
of the packets are coming from your own Mac.
In Ethereal’s main window, click the Protocol tab to sort the
results by protocol. Scroll down until you
see the packets designated as TCP. It’s a
safe bet that any activity you see here with
a source IP that’s different from yours (the
one you saw in Network Utility) is evidence
of someone borrowing your bandwidth.
Hmmm, some of those TCP packets look ﬁshy...
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4

Interface Face-Off

Most Macs have multiple network connections—modem,
Ethernet, FireWire, and/or AirPort—so before you send
Ethereal snifﬁng into the ether, you need to tell it which network
connection to sniff. To see your choices, launch Network Utility
(/Applications/Utilities) and click the Info tab. The Network
Interface pull-down menu lists all your available choices. On
most Macs, Ethernet is
labeled en0, AirPort is
labeled en1, and FireWire
is labeled fw0. Since you
want to sniff the Wi-Fi
airwaves, note the AirPort
card’s en1 designation.
What do you want to
sniff today?

6

Monitor the Data Flow

Ethereal’s Capture window reports the percentages
of different types of data ﬂowing on your network.
Typically, you’ll mostly see innocent TCP (Transmission Control
Protocol) packets, which move data around networks and the
Internet, but you might also see a lot of UDP (User Datagram
Protocol)—that’s essentially harmless noise.
Things to look out for include high
percentages of ICMP (10 percent
or more), which could indicate that
someone’s trying to execute a denialof-service attack on you, or ARP
packets (30 percent or more), which
mean that someone’s probably trying
to hijack your network. After a couple
of minutes, press Ethereal’s Stop
button.
If the trafﬁc is
mostly TCP packets,
your network is
probably safe.

8

Squeal Like a Pig

If you see a lot of non-TCP trafﬁc (especially ARP and
ICMP), you may be experiencing a network attack. Jot
down the offending IP address from Ethereal’s Source list,
return to Network Utility, click the Traceroute tab, enter the IP
address, and click Trace. The main window will ﬁll up with a
list of Internet locations as it traces the path from your Mac to
the source of the offending IP address. Study the last line for
any .com or .net address—that’s the ISP you should squeal to,
because one of their subscribers is apparently attacking your
network; that’s a violation of most ISPs’ terms of service.

This traceroute report tells you where your uninvited guest is
coming from.

Be glad that Alex Handy is a white-hat, good-guy hacker.

3

Exit to X11
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Visit our website at: www.broadwayphoto.com
DIGITAL CAMERAS

NEW!

NIKON Coolpix 8800

NIKON Coolpix 8400

NIKON D2HS

• 8.0 MegaPixels
• 10 Opt/4x Dig Zoom
$
99

• 8.0 MegaPixels
• 10x Opt/4x Dig Zoom
$
99

639
539
CP 4500 .$259.99 CP 4600 ..$164.99 NEW! Coolpix 5600 ...........$214.99
CP 4800 .$279.99 CP 5200 ..$219.99
CP 5700 .$479.99 CP 8700 ..$519.99
CP S1.....$319.99

NEW! Coolpix 5900 ...........$239.99
NEW! Coolpix 7600 ...........$279.99
NEW! Coolpix 7900 ...........$309.99

• 6.1 MegaPixels
• 2.0” LCD Screen
$
99

• 10x Opical Zoom
$
99

NEW! OLYMPUS C770
• 4.0 MegaPixels

NIKON D70-S

299

729

C-765 .......$269.99
D100 ......$879.99 D70..........$669.99 D-425 .......$124.99 D-545Z ......$169.99
D70 Kit ...$829.99 D70-S Kit .$949.99 D-595Z.....$199.99 D-630Z ......$249.99
i:robe 300.$279.99 i:robe 500 ..$279.99

OLYMPUS Evolt E-300 NEW! PENTAX *IST-DS
• 5.0 Million Pixels
• 1x Opt./1x Dig Zoom
$
99

599

SONY DSC-F828

• 1.8” LCD Screen
• 4x Dig./7x Opt. Zoom
$
99

649

DSC-S40..........................$179.99
DSC-S60......................... $209.99
DSC-S90..........................$259.99
DSC-F88 ..........................$249.99

SONY DSC-T7

NEW!

• 5.1 MegaPixels
• 2.5” LCD Screen
$
99

389

DSC-L1.....$204.99 DSC-M1 . . $399.99
DSC-T11 ..$289.99 DSC-T33. . $299.99
DSC-T3.$299.99 DSC-T1 . $299.99

CANON PowerShot G6 NEW!
• 7.1 MegaPixels
• 4x Optical Zoom
$
99

469

A95..........$249.99
S1-IS .......$279.99
A510........$164.99

OLYMPUS C-8080
• 8.0 MegaPixels
• 5x Opt/3x Dig Zoom
$
99

CASIO EX-Z55

599

C-5500 ...$259.99
C-60 .......$244.99 C-70Z .....$389.99
C-7000 ...$439.99 C-7070 ...$459.99

PENTAX Optio WP

Optio X...$289.99
S50 ........$219.99
SV ..........$319.99
ist Dig.....$949.99

NEW!

S5N .......$259.99
S5i .........$239.99
750Z ......$429.99
ist DS.....$569.99

SONY DSC-P200

NEW!

324

469

CD-350 ...............................$329.99

DSC-P150$304.99 DSC-H1 ........CALL
DSC-W1...$259.99 DSC-W5 ...$264.99
DSC-W7...$344.99 DSC-V3 ....$449.99

CANON DIGITAL REBEL XT KIT CANON EOS 20D

NEW!

• 6.8.03 Megapixel CCD
• 1.8” LCD Screen
$
99

• 8.2 MegaPixels
• 1.8” LCD Screen
$
99

Rebel Digital .........................$529.99
Rebel Digital Kit .....................$609.99
SD20 ......................................$269.99

EOS 1D II ...........................$3049.99
EOS 1DS II.........................$6399.99
EOS 1DS ............................$5099.99

789
Rebel Digital XT.....................$709.99
CANON PowerShot S500

SD200....$219.99
SD400....$319.99
S410 ......$239.99
S70 ........$389.99

SD300.......$284.99
SD500.......$394.99
S60 ...........$319.99
Pro 1.........$549.99

KODAK DX7590

259

• 8.0 MegaPixels
• 7x Optical Zoom
$
99

• 5.0 MegaPixels
• 12x Optical Zoom
$
99

E50 .......$239.99
X50 .......$219.99

X31.........$149.99
G600 ......$204.99

Z2 .........$249.99 Z3.......... $289.99
Z10 .......$174.99 Z20........ $229.99
NEW! Maxxum 7 Digital .....$1049.99

429

DMC-FX7 ....$304.99
DMC-FZ5.....$359.99
DMC-LC80 ..$189.99
DMC-LZ1.....$219.99

• DLP
• 1600 Max Ansi Lumenss

839

$

99

EPSON Powerlite S1+
• 3x .5” LCD
• Digital Zoom
$
99

849

LP-120 .......................$1399.99
LP-70+ .......................$1299.99

Powerlite 730-C .........$1979.99
Powerlite 61-P............$1159.99
Powerlite 81-P ...........$1529.99

CANON FS4000

NIKON LS50

SCANNERS
• 5888 x 4000 pixels
• 4000 DPI Optical
Resolution
• USB

46999

$

NEW!

• HIgh Quality
CCD Sensor
• 4000 DPI Optical
Resolution
$
99

489

BENQ PB7210

• 2200 Max Ansi Lumenss
• DLP

NEW!

Special! DSR-PDX10.$1649.99
Special! DSR-PD170 .$2479.99
NEW! DCR-TRV280 ....$264.99
NEW! DCR-TRV480 ....$309.99
NEW! HDR-Z1 ...........$3999.99

NEW! DCR-DVD7........$529.99
NEW! DCR-DVD92......$469.99
NEW! DCR-DVD103....$509.99
NEW! DCR-DVD203....$529.99
Special! DCR-DVD301 $629.99

PANASONIC PV-GS250

PANASONIC AG-DVX100A

68999

64999

229999

AG-DV2500 ...............$1409.99
AG-DVC200 ...............$3199.99
NEW! PV-GS16 ...........$339.99
NEW! PV-GS19 ...........$259.99
NEW! PV-GS31 ...........$319.99
NEW! PV-GS35 ...........$369.99
Special! PV-GS55 ........$349.99
NEW! PV-GS65 ...........$449.99
NEW! PV-GS150 .........$509.99
NEW! PV-GS400 .........$949.99

NEW!

PANASONIC TH-42PA20
• 42”
NEW!
• HDTV

PD-42WX84 ...............$3349.99
LT-26WX84 ................$1599.99
HD-52Z575 ................$2399.99

TH-42PX25 ................$3599.99
TC-26LX20 ................$1699.99
TH-50PX25U .............$4699.99

NIKON Super Coolscan LS-5000

EPSON Stylus 2200P

EPSON Stylus 1280

86999

NEW!

AG-DVC7 .....................$869.99
Special! AG-DVC30 ...$1599.99
NEW! AG-DVC60 ......$1799.99
NEW! AG-HVX200...........CALL
NEW! AJ-HDX100 ...........CALL
Special! VD-RM50 .......$499.99
NEW! VDR-M53...........$459.99
NEW! VDR-M54...........$469.99
NEW! VDR-M55...........$519.99
Special! VD-RM70 .......$529.99
NEW! VDR-M75...........$549.99
NEW! VDR-M95...........$669.99

TELEVISIONS
JVC LT-32X585

PB 6100 .......................$849.99
PB 7230 .....................$1699.99
PB 8220 .....................$1549.99

$

• 3-CCD Imaging
• Super VHS
• 12x Optical Zoom
$

$

• 4,000 dpi Optical Res.
• 2x-linear CCD
• Multiple film format

NEW!

$

• 32”
• HDTV
• W-XGA LCD
$
99

150999

DCR-HC21 ........$339.99
DCR-HC32 ........$399.99
DCR-HC42 ........$449.99
DCR-HC90 ........$699.99

$

$

NEW! DCR-PC55 ........$579.99
DCR-PC109 .................$509.99

NEW!
NEW!
NEW!
NEW!

NEW!

• 3.3 MegaPixels
• 10x Optical Zoom
• 2.7” LCD

• 3.1 MegaPixels
• 2.5” LCD Screen

NEW!

• 12x Optical Zoom
• 150x Digital Zoom
• 2.5” LCD

SONY DCR-DVD403

264999

SONY DCR-PC1000

SONY DCR-HC1000

100999

• 12x Optical Zoom
• 3.5” LCD Screen

• 12x Optical Zoom
• 2.5” LCD Screen
$
99

70999

$

GR-D250 ...........$249.99
GR-D270 ...........$259.99
GR-D290 ..........$269.99
GR-D295 ..........$269.99
GR-DF430 ........$309.99
GR-DF450 ........$349.99
GR-X5 ...................CALL

SONY HDR-FX1

SONY DCR-VX2100 NE
W!
• 48x Digital Zoom

VIDEO PROJECTORS
IN FOCUS X2

NEW! Optura 50 .........$549.99
NEW! Optura 60 .........$604.99
NEW! Optura 400 .......$599.99
Optura XI .....................$809.99

35999

NEW!

DMC-FZ4..$329.99
DMC-FZ15$344.99
DMC-LS1..$199.99
DMC-LZ2..$249.99

NEW! Elura 80............$379.99
NEW! Elura 85............$409.99

NEW!
NEW!
NEW!
NEW!
NEW!
NEW!
NEW!

2.3 MegaPixels
10x Optical Zoom
200x Digital Zoom
2.5” LCD Screen

$

$

NEW! GZ-MC100.........$669.99
NEW! GZ-MC500.............CALL
GR-DX77 .....................$354.99
GR-DX97 .....................$379.99
NEW! GY-HD10U.............CALL
JY-HD10U ..................$2149.99
GY-DV300..................$1649.99
GY-DV5000................$3699.99

• 2.8 MegaPixels
• 2.7” LCD Screen

$

• 1.33 MegaPixels
• 2.5” Color LCD

819

CANON OPTURA 500 NEW!
•
•
•
•

JVC GR-DF550

NEW!

NEW!PANASONIC DMC-FZ20 (K/S)

339

519

• 2.12 MegaPixels
• 10x Optical Zoom
• 200x Digital Zoom
• 1.8” Color LCD
$
99

87999

FP 810 ......$339.99 FP 3100..$199.99
FP A345....$159.99 FP A350 .$199.99
FP F10......$289.99

• 5.0 MegaPixels
• 12x Optical Zoom
$
99

JVC GZ-MC200

$

EX-S100 .$199.99 EX-Z50....$229.99 FP E500 ...$164.99 FP E510 ..$189.99
EX-Z55 ...$269.99 EX-Z750..$329.99 FP E550 ...$259.99 FP S20 Pro...$449.99
FP S2............$1149.99 FP Z1.......$299.99
QVR-62 ..$209.99

MINOLTA Dimage A200 NEW! MINOLTA Dimage Z5

XL-2.................$3009.99
ZR-100 ..............$269.99
ZR-200 ............. $299.99
ZR-300 ..............$349.99
ZR-400 ..............$389.99

329

DX-7630. $249.99 EZShare 1..$469.99
EZS C340 $209.99 EZS Z700 .$249.99
EZS Z730 $269.99
EZS- Z7590 ......................................$309.99
DCS - Pro SLR C / N......................$3049.99

• 4.0 MegaPixels
• 10x Optical Zoom
$
99

1549
289
EX-P505 .$364.99 EX-P700..$389.99

NEW!
NEW!
NEW!
NEW!
NEW!

NEW!

48999

NEW!

FUJI Finepix S5100

• 12.3 Mega Pixels
• 2.0” LCD
NEW!
$
99

159999

1999

1099
EOS 20D Kit .......................$1179.99
• 5.4 MegaPixels
• 10x Opt./3x Dig. Zoom
$
99

• 5.0 MegaPixels
• 3x Optical Zoom
$
99

NEW! FUJI FinePix S3

• 5.0 MegaPixels
• 2.7” LCD Screen
$
99

NEW!

• 7.2 MegaPixels
• 3x Optical Zoom
$
99

• 4.0 MegaPixels
• 2.5” LCD Screen
$
99

• 1.33 MegaPixels
• 20x Optical Zoom
• 2.5” LCD Screen

$

244

SONY Mavica CD-500

279

A400 ...$129.99.
S2-IS ......CALL
A520 ...$229.99

99

D2X ......$3649.99 D50..............CALL
D50 Kit 1 ....CALL D50 Kit 2 .....CALL

599

CANON ELURA 90

• 20x Optical Zoom
• 100x Digital Zoom
• 2.5” LCD Screen

2799

$

• 5.0 MegaPixel
• 2.0” LCD Screen
$
99

*IST-D ...................................$849.99
OPT X ...................................$269.99

CANON GL-2

• 4.1 MegaPixels
• 2.5” LCD Screen

• 6.1 MegaPixels CCD
• 2.0” LCD Screen
$
99

E-1 ........................................$829.99
NEW! Stylus 500...................$269.99
NEW! Sty Verve Dig (R/S/W). ..$204.99
NEW! Sty Verve Dig S. ...........$279.99

DIGITAL VIDEO

NEW!

2099

$

2499

99

SHARP LC-37HV4U
• 37”
• Aquos Liquid
• TFT Active Matrix
$
99

3199

LC-30HV4U ...............$1949.99
LC-20E1U ....................$649.99
LC-20B4U ....................$699.99

PRINTERS

• USB/Serial Port
• PC or Mac
• 6 Color Small
Archival Links
$
99

539

NEW!

• Smudge Free Inks
• PC or Mac

39999

$

NEW!

NEW!

OLYMPUS
P440

NEW!

• Dye-Sublimation
• 1.8” LCD
• USB

379

LS-8000 .....................$1909.99
$
99
LS-4000 .......................$899.99
Stylus 3000 ................$1179.99
Policy: Visa, Mastercard, Discover, American Express, Diners Club, Money Orders, Certified Check, (Personal Checks up to 14,000.00 with name and address imprinted on check). C.O.D. orders are also accepted. Orders by mail please
print name address and phone number clearly. Shipping methods - in the Continental U.S.A. will be via Fedex, U.P.S. or Air Mail. Over size items via truck. Shipping and Handling are additional. 21 days for return or exchange (video & digital 7 days) with prior authorization only. (Call customer service for authorization number). Shipping and Handling are not refundable. All returns are subject to a minimum restocking fee of 5%. Prices may reflect mail-rebate. All returned
merchandise must be in new condition and must include all packaging and printed material in original, unaltered condition. Broadway Photo is not responsible for typographical errors. All items are covered by USA, International or Broadway
Photo and Video Warranty. Prices subject to change. Please check our website for current prices. All our merchandise is brand new and factory fresh. Quantities are limited. Thank you and enjoy your order.
MA 7/05
LS-40 ...........................$409.99
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Adobe®
Photoshop CS2

Macromedia®
Studio MX 2004

Quark®
QuarkXpress 6.5

Wacom ®
Intuos3 6x8

Order Today!

Now! $199.95

Now! $189.95

Now! $279.95

Save! 53%

Get the Best for Less!

Save! $700

Save! $756

4 Programs - 1 Price!

The Industry-Standard!

Save! $40

Great Graphics Tool!

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

A d o be ®
Acrobat Pro 7............Save 69%
Creative Suite 2.........Save 69%
Video Collection........Save 55%

Macromedia®
Flash MX 2004 .....................$99
Dreamweaver MX 2004 .......$99
Contribute 3 .........................$89

Alias®
Maya Complete Student.....$289

MakeMusic®
Finale 2005.............................$209

Canopus®
ADVC-300 A/D Converter ...$399

Microsoft®
Office 2004 Student/Teacher ..$149

This Month’s Featured Titles:
Canon CanoScan LiDE 500 ............$119
Iogear Combo ION Drive 20GB......$165
Prosoft Engineering Drive Genius ....$89
DLO iBoom - Boom Box for iPod ...$119
Bias SoundSoap 2 ............................$69
Transcend StoreJet Drive 20GB......$129
Stylus Verve 4 MegaPixel Camera...$219
Thinkmap Visual Thesaurus 3 ...........$29

Give us a call anytime! 1-800-294-4035
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Hey Parents!
“You are eligible
to buy for your
students at home
or away at school.”

�����������
���������
� �������������������
� ���������������������������
��������������
���������������������������
��������������
��������������������
����������
�������������������������������
� ����������������������
� ���������������������
��������
����������
���������

�����������

� ��������������
� ���������������
� �������
� ����������������������
� ������������������
����������������
� �������������

����������������
�����������������
���������������������
���������������
�������������������

�
����������������������

������������������������
������������������������������������������������������������

�������������������������������������

Mac Shop JULY/05

73

MEMORY for PC and Apple, Laptops,
Digital Cameras, MP3 Players and more ...

WE CAN BEAT
Crucial, Kingston,
Comp-USA, ANYONE!
AND, WE GIVE YOU

FREE SHIPPING!

 We Manufacture Our Memory Using the
Highest Quality Components
 Lifetime Warranty
 Compatibility Guaranteed
 Free Technical Support
 Experienced Sales Staff Since 1994

TM

.com

1-800-4-MEMORY
1-800-463-6679
http://www.18004memory.com
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MacAddictv8-1/8pgVert8/28/02 11/1

FAMILY HISTORY - GENEALOGY

REUNION 8
®

Reunion 8 is the perfect tool to
organize your family history. Plenty of
room for names, dates, places, stories,
notes, tidbits, and
sources. Include
all your favorite
pictures, sounds,
and home movies.
Automatically
build multimedia
web pages to
share your family
history on the
Internet! Print large, colorful tree
charts, timeline charts, and fan charts
for family reunions. Fun
and educational for the
whole family. Reunion 8
takes advantage of OS X
and includes over
100 new features
and enhancements!

Soothing heat for cold, stiff hands!
www.ThermalRest.com
800.818.3946
MacAddict 3.5˝ X 2.3˝

MA/DS '03 12/31/03 1:36 PM Page 1

DATA RECOVERY: 800-440-1904

7 great reasons to choose DriveSavers:
Fast, advanced, proprietary techniques.
All operating systems; Mac, Windows, OS/2,
Netware and UNIX.
� All storage devices including SAN, RAID and
NAS systems.
� Instantly retrieve recovered data
with DataExpress™.
� Recommended and certified by all
hard drive manufacturers.
� Government Contracts
� Featured on MacAddict,MacWorld,
Since 1985
CNN, BBC and others.
�
�

DATA RECOVERY: 800-44

Leister Productions

web site/demo: www.LeisterPro.com
e-mail: info@LeisterPro.com

To order, call...

MacConnection 800-800-2222

“We Can Save It!”

Visit DriveSavers at www.drivesavers.com

©2003 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949 INTL: 415-382-2000

All New iPod Accessories
Stereo Speaker / Charger

Portable Stereo Speakers

Bluetooth Stereo And Tune Streaming Headset
Call us for dealers near you 1.800.644.1132 or visit us at: www.macally.com
Mac Shop JULY/05
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Simply Talk…

…and leave the typing to us.
Still only

$149.00
with USB
headset!

MacSpeech is the only company currently developing
dictation software for Macintosh. iListen users enjoy the
ability to dictate into virtually any application, hands-free
correction, and the largest set of voice commands available
on any platform.
Available at the ﬁnest Mac resellers.
To ﬁnd where you can buy iListen, visit
www.macspeech.com/promo/macaddict.html
�����������������������������������������������������������������������
�����������������
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A
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New!

Versatile
Notebook Soft-Case
With Internal
Protective
Poly-Armor

Convenient
Use-In-Case Design!

www.radtech.us/ma
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tell us how you really feel

LETTERS
ANOTHER TWIST
I enjoyed your comparative
review of ergonomic
keyboards (“Untwist Your
Wrist,” May/05, p26), but
you left out one that I’ve
enjoyed greatly for the past
year: the Logitech Cordless
Desktop Comfort ($99.95,
www.logitech.com). It offers
a divided, tented keyboard
with quiet keys, and it’s
marked with dual logos for
Windows and Macintosh
users (no remapping
required!). Plus, it’s wireless,
thanks to an RF receiver
connected to a USB port;
you can be both healthy and
geeky at the same time!
—Joseph Lockett

MEMORY LANE
I’ve set up a Mac Museum in my basement, complete with
informational placards and spiffy table skirts. Among my cache are
two versions of the Apple Cable TV Set-Top box, a Newton MessagePad
120, the Mac TV, a Lisa II/Mac XL, an eMate, the 20th Anniversary Mac
(aka Spartacus) and of course, the original Mac 128K.—Gil Poulsen

CARRECTION

This Logitech keyboard
untwisted a few MacAddict
readers’ wrists.

You’re not the only reader
to suggest that Logitech
keyboard. Others found that
using a trackball helps a lot,
too—especially if you’re an
iBook or PowerBook user
strapped for the flat space
you need for a mouse.
—Max

Survey
Says

Here are the results
of our March 2005
survey. Check out
www.macaddict.com
each month for a new
online poll.

In your review of Carrara 4
Pro (
May/05, p40),
you complain that it takes
over your desktop, but there
are easy ways around that.
Command-Tab still brings
up the Finder’s application
switcher. Also, there is
an eye icon in the upper
right-hand corner of the
Carrara window that returns
you to an unobstructed
desktop with one click. You
can also change Carrara
preferences to open Carrara
in a Finder window. Under the
Preferences menu, choose

July 2005

SHAMELESS
SYCOPHANCY
Just had to write to say great
job on the MacAddict.com
forums. I’ve been having
trouble printing to a HP
LaserJet through a Windows
network (oh, the things we
endure). Bafﬂed beyond
belief and highly frustrated,
I tried Apple’s Service &

What should Apple do to combat
overzealous rumorbloggers?
39% Get over it!
All of us suckers
will buy Apple
stuff anyway.

21% Leave ’em
alone, ya big bully!
13% Prosecute
them to the full
extent of the law.

5% Drop the
“No comment
on unreleased
products” mandate.

22% Smother them with
ﬂoods of false information.
701 respondents
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General, and uncheck Full
Screen Mode. Exit Carrara,
and next time you go in,
Carrara will be in its own,
adjustable Finder window.
—Mark Martino

They just don’t make ’em
like they used to.

Support site (www.apple
.com/support) and had no
luck there. Then I tried the
MacAddict.com forums,
and there it was—the exact
solution to the problem
I was having. (Thanks to
Ninja David, who posted the
solution.)—Peter Macfarlane
If our forums rock, that’s
only because of all the
dedicated, smart, well-read,
well-traveled, well-liked,
technically savvy, beautiful
(on the outside and inside)
readers who bring them to
life. Oh, is that a subscription
card that just fell onto the
floor?—Max

FEELING GRAY
Your “iPods for Everyone!”
article (Get Info, May/05,
p10) proclaims that the
wonderful color gray is
“passé”! The horror! A good
gray reﬂects the colors near
it—most prominently pink
and sometimes green. Gray
may be passé in Colorfornia,
but it’s as cool as the other
side of the pillow here on
the Right Coast! It’s the color

of urban camouﬂage; it’s
almost the color of the haze
that drapes around the Blue
Ridge Mountains; it’s nearly
the color of our silvery
mountain lakes. Long live
gray!—William Burke
So I guess what you’re
saying is that this is, indeed,
a black-and-white issue.
—Max

THE TWO ERRORS
I noticed a couple mistakes
in your May ’05 issue.
In “Rebel Swell” (Get
Info, p13), you called the
Canon EOS Digital Rebel
XT “Nikon’s latest digital
SLR camera.” Also, in
“Put Linux on Your iPod,”
p60, you have a picture
of a clickwheel iPod
running Linux, which isn’t
possible—you even say
so in the article. Some
Photoshopping, perhaps?
—Sam
You caught us on both
counts. No, Canon and
Nikon have not joined
forces, and yes, we abused
the power of Photoshop with
no regard for such matters
as “consistency.” Such a
keen, scrutinous eye! Guess
you have plenty of time on
your hands now that you’ve
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LOG OUT

FOR SUBSCRIPTION QUERIES:
call (toll-free) 888-771-6222

WIN!

saved Middle-earth from
Sauron.—Max

IS THIS THING ON?
In the Staff Video on your
Apr/05 Disc, what was the
make and model of the
microphone that host Hugh
Costa used? It seemed to
work exceptionally well.
—Don R. Hill
The microphone in question
is an AKG Acoustics C 1000 S
($338, www.akg.com)

Win an Olympus Evolt E-300!

This month, your innate creativity and cleverness can win you
an Olympus Evolt E-300 (
May/05, p41; $999, www
.olympusamerica.com). This streamlined, eight-megapixel
digital SLR features a removable Zuiko Digital 14–45mm
f/3.5–5.6 lens, easy-to-use controls, a plethora of shootingmode presets, and a unique dust-cleaning system that makes
switching lenses a worry-free affair. Want it? Just send us the
best caption you can think of for the image below.
Only one entry per contestant.

Entry Form

Secrets of the
mystery mic revealed!
condenser mic; the crew fed
it through a Beachtek DXA-4P
XLR Adapter ($199, www
.beachtek.com), which is
specifically designed for the
Canon GL1 camera they used.
If that sounds like a bit much,
we’ve always liked the SM57
from Shure ($158, www
.shure.com)—Max

BUILDING A BETTER MOUSETRAP
Last year, my science teacher assigned us to make a car
that travels with only the power of a single mousetrap.
Classmates were making their cars out of milk cartons and
foam, but I thought, “I’m into Macs, why not make mine out
of clear plastic?” So I went to the local plastic store, ordered
Lucite plastic wheels and a body, and put them together with
the mousetrap and axels. I put the ﬁnishing touch on it with
a genuine Apple logo sticker. It didn’t win any races, but it
sure looks cool!—Drew Varkonyi

Just be sure to keep this away from your Mac’s mouse.

PHOTOGRAPH BY MARK MADEO

MacAddict, 150 North Hill Dr., Ste. 40,
Brisbane, CA 94005
or letters@macaddict.com

FOR CD PROBLEMS:
go to www.futurenetworkusa.com

IMAGE COURTESY OF AKG ACOUSTICS

WRITE TO US!

Write a caption
for this picture.

CONTESTANT INFORMATION
Full Name:
Address:
City:

State:

Zip:
Email or telephone:
Send email entries to: contest@macaddict.com with the subject: Olympus Contest
(Don’t forget to include your address information!)
Send snail-mail entries to: Olympus Contest, MacAddict magazine,
150 North Hill Dr., Ste. 40, Brisbane, CA 94005.
Deadline for entry: July 31, 2005.
Contest results will appear in our Nov/05 issue.
Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent
originality, and 33 percent creativity. All entries must be received no later than July 31, 2005, with the winner
announced around November 2005. By entering this contest, you agree that Future Network USA may use your name,
likeness, and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum
number of entries is required. If two or more people enter identical winning captions, the entry received ﬁrst will be
awarded the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future Network
USA is not responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a
prize, and winners are responsible for income taxes based on the value of the prize received. A list of winners may also
be obtained by sending a stamped, self-addressed envelope to Future Network USA c/o MacAddict Contest, 150 North
Hill Dr., Ste. 40, Brisbane, CA 94005. This contest is limited to residents of the United States. No purchase necessary,
void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Winner!
Congratulations to
Tim Lynch, whose
ornithological musings
won him a Formac
Studio TVR media
converter ($299, www
.formac.com).

Lives in a northern clime, yet ﬂies south
every winter in search of a reliable food
supply (milk and cookies). Biologists
theorize: Could Santa actually be a
migratory waterfowl?
July 2005
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SHUT DOWN

don’t let the back page hit you on the way out
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The perfect combination of creativity and technology.
(Don’t you love it when everything comes together?)

Adobe® Creative Suite 2 Premium
• Full new versions of Adobe® Photoshop® CS2,
Illustrator® CS2, InDesign® CS2, GoLive® CS2,
and Acrobat® 7.0 Professional
• Version Cue® file-version management and
collaboration—featuring robust file tracking,
enhanced searching and support for initiating
browser-based Adobe® PDF reviews
• New integration features—Adobe® Bridge for
centralized file browsing, Adobe® Stock Photos,
centralized color settings, unified Adobe® PDF
file creation, and workflow scripts

Kingston Memory Modules for
Apple® Power Mac® G5

Epson PictureMate Deluxe
Viewer Edition

• 100% compatibility guaranteed
• Free manufacturer’s lifetime warranty and
technical support
• Legendary reliability and superior quality
• Visit CDW.com/kingston to find your
memory solution

• Easily view, edit and print photos from
memory cards without a PC
• One-touch printing of 4 x 6 photos
• Cost of approximately 29 cents per print
• Water, smudge and fade-proof prints for
up to 200 years in an album

512MB

106

$

43

CDW 511654

1GB

188

$

CDW 511657

1169

$

CDW 768334

The Technology You Need When You Need It.
When you’re bringing ideas to life, your technology should work with
you, not against you. CDW has all the top-name technology you need
to improve workflow. Our account managers provide fast answers
to your product questions. And with access to the industry’s largest
in-stock inventories, you’ll get what you need when you need it.
So why wait? Get new systems today and start creating tomorrow.

Offer subject to CDW’s standard terms and conditions of sale, available at CDW.com. © 2005 CDW Corporation.

2GB

39803

64 $

CDW 551929

24999

$

CDW 770942
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